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Chapter 1. Getting Started

About this Tutorial
This tutorial for the Sterling Gentran:Server® Forms Integration subsystem
references the ANSI X12, EDIFACT, and TRADACOMS standards. Any sections in
this tutorial that do not apply to all three standards are marked with the applicable
standard name. If a section heading does not include a standard name, then the
section applies to all three standards. In some tasks, the steps and information
apply to all three standards but a specific detail may be different, such as a field
name. For example:

In the "What is the name of the form" box, enter one of the following:
v Print 850 Pet Zone (for ANSI X12)
v Print ORDERS Pet Zone (for EDIFACT)
v Print TRADACOMS ORDERS Pet Zone (for TRADACOMS)

This tutorial includes a print example (purchase order) and a screen entry example
(invoice). This tutorial defines the tasks necessary to create forms and describes
how to customize and format a form before it is compiled into a translation object.
A print form enables you to print customized EDI data that has been processed
through the translation object. A screen entry form is a predesigned layout that,
when compiled into a translation object, enables users in your company to enter
the data necessary to create a business document.

The form that you create is a source form. When that source form is compiled, the
result is a compiled translation object. You must register the translation object with
Sterling Gentran:Server to be able to use the translation object to enter EDI data in
messages of that type.

To access reference information, refer to the IBM® Sterling Gentran:Server for
Microsoft Windows Forms Integration User Guide. For additional information on the
various tasks described in this guide, refer to the IBM Sterling Gentran:Server for
Microsoft Windows User Guide.

This guide assumes that you are familiar with using a PC and with Microsoft
Windows functions, including:
v The terminology used to describe mouse and cursor actions.
v The terminology used to describe Windows-specific attributes, including dialog

boxes, icons, windows, and buttons.
v Using the Windows Program Manager.

The Forms Integration Subsystem
A form is a set of instructions you define in the Forms Integration subsystem that
indicates how the system should format data. When you compile the form, Sterling
Gentran:Server generates a translation object. After you register the translation
object with Sterling Gentran:Server and associate the translation object with a
partner relationship, the system uses the translation object to format EDI
documents. The Forms Integration subsystem enables you to create print and
screen entry translation objects.

© Copyright IBM Corp. 1996, 2012 1



Regardless of whether the translation object is print or screen entry, Sterling
Gentran:Server generates the actual format of the translation object based on the
EDI file format (in the EDI File Format Pane) and displays it in the Layout Pane.

A print translation object organizes and formats the printout of EDI documents
that are received from or sent to the trading partners for which you have
established a trading relationship that uses that print translation objects. The print
translation object enables you to view the EDI document in an easy-to-read format.

A screen entry translation object provides a standardized format for entering an
EDI document into the Document Editor for translation and transmission to your
trading partners. The screen entry translation object ensures that your users enter
all the data necessary to create the required EDI document.

Sterling Gentran:Server generates the translation object format based on the EDI
file format in the EDI File Format Pane and displays that format in the Layout
Pane.

Forms Integration Window
The following diagram illustrates the Forms Integration Window. (This is an ANSI
X12 example.)

This table describes the Forms Integration window components.

Part Function

Main Menu Bar Contains drop-down menus. Unavailable items are dimmed.
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Part Function

Main Toolbar Enables you access to some of the most common operations in the
Application Integration subsystem. Unavailable items are dimmed. The
Main Toolbar is a dockable toolbar, so you can affix it to any edge of
the client window.

EDI File Format
Pane

Cntains the EDI file format. When you click a segment or group in the
EDI file format, the corresponding frame is displayed in the Layout
Pane. When you click an element in the EDI file format, the
corresponding layout component is highlighted in the Layout Pane.

Layout Pane Contains the format of the translation object. Each group (with a
maximum usage greater than one) and repeating segment has a
corresponding frame in the Layout Pane. When you click a segment or
group in the EDI file format, the corresponding frame is displayed in
the Layout Pane. When you click an element in the EDI file format, the
corresponding layout component is highlighted in the Layout Pane.

Status Bar Displays status information about a selection, command, or process,
defines menu items as you highlight each item in the menu, and
indicates any current keyboard-initiated modes for typing (e.g., CAP
for the "Caps Lock" key, NUM for the "Num Lock" key, etc.).

The Main Toolbar gives you access to some of the most common operations in
Sterling Gentran:Server. Unavailable items are dimmed. The Main Toolbar is a
dockable toolbar, so you can affix it to any edge of the client window. This
diagram illustrates the Main Toolbar.

EDI File Format Pane
The EDI File Format Pane (left side of the Forms Integration subsystem main
window) contains the EDI file format. The EDI file must contain all the
information that you need to include to either create a document using the
Document Editor (screen entry translation object) or print documents (print
translation object), so that your system can accurately process the data.

Generating EDI files

Sterling Gentran:Server generates an EDI file for you, based on the standard
(agency), version, transaction set, and release (for the TRADACOMS standard
only) you selected. The system includes all the groups, segments, composites, and
elements that are defined by the standards agency for the version of the document
you selected.

You typically need to customize the system-generated EDI file by modifying the
properties of the form components, and using specialized Sterling Gentran:Server
functions to manipulate the EDI file structure.
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Generating specialized EDI standard versions

If you want to use a specialized version of an EDI standard that is not available in
the IBM Sterling Gentran® Standards Database for EDI, it may be appropriate for
you to define the EDI file yourself.

Regardless of whether the system generates the EDI file or you define it, the
specific EDI form components that you use depend on the type of form you are
creating. This includes the standard, version, and transaction set (document)
selected, and which groups, segments, composites, and elements your company
requires.

We recommend that you determine which form components you are using before
generating or defining an EDI file.

Form components

This table describes form components that Sterling Gentran:Server uses to define
the EDI file format.

Icon Description

Group A group is a looping structure that contains related segments and/or groups
that repeat in sequence until either the group data ends or the maximum
number of times that the loop is allowed to repeat is exhausted. Groups are
defined by the EDI standards. A group that is subordinate to another group
is a subgroup (this corresponds to a nested looping structure – a loop within
a loop). The EDI file is a group and therefore, it is visually represented the
same way as other groups and subgroups in Sterling Gentran:Server.

Segment A segment contains a group of related elements or composite data elements
that combine to communicate useful data. Segments are defined by the EDI
standards. A segment can occur once or can repeat multiple times.

Maximum use: Refers to the number of times that a segment can be used
within the structure in which the segment is defined. For example, if a
segment can be used only once within a group, but the group can be used
multiple times, the segment still has a maximum use of one within each
occurrence of the group. The standard defines the maximum number of
times a segment can be used, but you must determine how many times a
segment is used, based on what you are sending your trading partner.

Composite A composite is a data element that contains two or more component data
elements or subelements. Composites are defined by the EDI standards that
use them (EDIFACT, TRADACOMS, and certain ANSI X12 standards).

Element An element is the smallest piece of information defined by the EDI
standards.

v When an element has an operation performed against it, a red checkmark
is displayed over the element icon.

v When an element contains a standard or extended rule, a black asterisk
appears to the right of the element icon.
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Layout Pane
The Layout Pane (right side of the Forms Integration subsystem main window)
contains the actual format of the translation object. Sterling Gentran:Server uses
frames to format the EDI file for the translation object. Each frame contains the
groups, repeating segments, and elements at that level (single segments are not
represented on the frame).

For screen entry translation objects, groups (with a maximum usage greater than
one) and repeating segments are formatted as lists. Elements are formatted as edit
boxes (fields) or drop-down lists on the frame. Elements are typically formatted as
fields, but are formatted as a drop-down list if you apply a standard rule that
allows a selection of multiple items. Each group and repeating segment also has a
corresponding frame that contains all the groups (with a maximum usage greater
than one), repeating segments, and elements at that level.

For print translation objects, groups, repeating segments, and elements are always
formatted as fields.

Each group and repeating segment also has a corresponding frame that contains all
the groups (with a maximum usage greater than one), repeating segments, and
elements at that level.

When you click a segment or group in the EDI File Format Pane, the
corresponding frame is displayed in the Layout Pane. When you click an element
in the EDI File Format Pane, the corresponding layout component is highlighted in
the Layout Pane.

About Forms
Sterling Gentran:Server generates a basic form based on the following information:
v Type of form (such as print or screen entry)
v Standard agency (such as ANSI X12, EDIFACT)
v Standard version (such as 003040, 90.1)
v Document/message type (such as 810 INVOICE, INVOIC)
v Release or message version (such as 9 for TRADACOMS)

All mandatory groups, segments, composites, and elements for the standard,
version, and transaction set/message you specify are available for use (activated)
when Sterling Gentran:Server creates a form. Only these mandatory form
components (groups, segments, composites, and elements) are activated
automatically. You must activate additional form components that you want to be
displayed in the screen entry form, and then customize and format the form so
that it is appropriate and useful for your company’s needs.

Before you begin to customize a form, you should be familiar with the following
elements of form design:
v EDI standards (how EDI standards work and how the information that your

users need is translated to and from the standards)
v Your users (the individuals who are using the forms to either create printouts of

processed EDI data or enter EDI data on a screen)
v Your trading partners (the organizations exchanging the EDI documents with

your company)
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You can create a different form for each combination of transaction set/message,
trading partner, and standard version. The number of screen entry forms that you
create is not limited and does not affect the number of print forms you can create,
and vice versa.

We recommend that you mock up a layout of the form the way you ultimately
want it to look. As you design the layout, make sure that the form will makes
sense to the people who will use it. By analyzing your company’s needs before
you actually create the form, you reduce the amount of time spent later on
redesigning or reformatting the form.

You should include the following design considerations in your form planning:
v Which fields should be printed, and which are necessary for the EDI data but do

not need to be displayed on the printout
v Where fields should be located on the form
v What labels you are using to identify the fields on the form

Building a Form with Forms Integration
This table describes the steps required to build a form using Forms Integration.

Stage Description

1 Prepare and Analyze. Obtain a layout of how you want the form to be
displayed and determine how it corresponds to the EDI standard you are
using. Determine what operations need to be performed to generate the
required layout.

2 Set Global Defaults (first time only). The first time you use the Sterling
Gentran:Server Forms Integration subsystem, you should verify the default
date format that the system uses.

3 Create, Save, and Name a New Form.

4 Activate the Appropriate EDI Groups, Segments, and Elements.

5 Promote, Split, and Change Segments and Groups.

6 Customize the EDI Data.

7 Define the Layout of the Form.

8 Compile the Form.

9 Print the Report. Validate and review the form, and make modifications as
needed.

10 Test the Translation Object. For a screen entry translation object, create a
new document in Document Editor, using that translation object. For a print
translation object, print a document. Verify that the output is correct.

Getting Started
This tutorial is meant to be completed in its entirety. We recommend that you
complete each task sequentially. When you create your own forms, the phases may
overlap and you may have to return to one or more of the phases several times
before the form is completed. The purpose of completing each task in this tutorial
in sequential order is not only to teach you how to perform the individual tasks,
but also to teach you a logical approach and methods that should be used when
you create your own form.
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In these tutorials, you create a screen entry form for an invoice and a print form
for purchase order. In both of these tutorials, you will be using one of the
following standards:
v ANSI X12 003040
v EDIFACT 92.1
v TRADACOMS ANA001 release 9

The default folder is GENSRVNT\Forms. The tutorial data is in the
C:\GENSRVNT\TUTORIALS subfolder.

The steps involved in creating forms are broken down into manageable pieces so
that you can learn the tasks and procedures involved in creating a form. Then, you
can apply the knowledge gained from using this tutorial to create your own forms.

In this scenario, your company is MWT Manufacturing Co., which manufactures a
wide variety of pet supplies for pet stores. One of your trading partners, Pet Zone
(a large pet supply retailer), orders products from your company. Your company
then invoices Pet Zone for those products.

You will create a form that formats and arranges the EDI data you receive from Pet
Zone to produce a printout of a purchase order.. You do not want to alter the
integrity of the EDI data. However, you want to interpret some of the codes
included in the EDI message into more meaningful text.

Then, you will create a form that your data entry users will use to enter EDI data
for the invoice that you will send to Pet Zone. From discussions with Pet Zone,
you know the requirements for the invoices that they receive from you.

Analyze the EDI File
You and your partner must agree on which standard, version, and
message/transaction set you are using. It is helpful to review the EDI standard
that you are using before analyzing the EDI file. We recommend that you obtain an
EDI standard manual for the standard and version that you are using. Standard
manuals are available from EDI standard agencies.

For purchase orders, you must first determine what data your trading partner will
be sending you and what data is contained in each element. Discuss with your
partner what they will send and which segments and elements your company
requires. You can then make a list of the items that you will need to use. You will
then make the form components you need available for use

For invoices, you must determine what data you need to send your trading partner
and what data your trading partner expects to receive and what data is contained
in each element. It is important to analyze the data in this way so that the invoice
contains all the necessary information, and so that your company can bill your
partner correctly for the order you shipped to them. Discuss with your partner
what you are sending and which segments and elements your partner requires.
You can then make a list of the items that you will need to use.

Sterling Gentran:Server generates a form based on the groups, segments,
composites, and elements that are defined by the standard agency for the version
of the document you selected. The system activates all the groups, segments,
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composites, and elements that are defined as mandatory by the standard. The
system does not enable you to deactivate mandatory groups, segments, composites,
and elements.

Note: The TRADACOMS standard uses a header with each interchange (ORDHDR
for the ORDERS message). The header message contains information that pertains
to each message in the interchange. Sterling Gentran:Server copies the header
segments to the beginning of each document, to ensure that all the relevant
information is contained in the document. Therefore, you will need to load the
header message (ORDHDR) into the ORDERS EDI file, so that all the segments
and elements are available for use.

When translating data, the system does not process groups, segments, and
elements that are not activated. Therefore, you must activate the groups, segments,
and elements that are not defined as mandatory by the standard but that you have
determined you need to use in the form.

Note: When you activate a conditional group or segment, the mandatory
subordinate segments and elements are activated automatically. A conditional
group or segment is used only if there is EDI data available for that element.

The first step in creating a form is to analyze the form requirements. If the analysis
you perform is complete, you have all the information you need to create the form
in an efficient and logical manner. If you omit this critical step and proceed
directly to creating the form, it is likely that creating the form will be a longer and
more arduous task, and the form may not work the way you need it to, due to
oversights and omissions.

Creating a screen entry or print form for an invoice or purchase order requires
several steps. Some steps are performed at the document/message level (such as
activating form components), and others are iterative steps that are performed for
each group, segment, or element in the form. In the analysis phase, you must
determine what EDI data is being sent, as well as what information is required to
process the data. The fields on the form must account for all information.

For each segment activated (either mandatory or optional), you must ask the
following questions:
v Is the segment a group?
v Does the segment have a maximum use greater than one?
v What elements need to be activated for the segment?

EDI Delimiters
If you are using an EDI standard that contains composite elements or subelements,
you must verify that Sterling Gentran:Server is specifying the correct delimiters.
Delimiters are flags that you define to the system as separating specific EDI
components. Delimiters are necessary for all variable field-length standards,
because the data is compressed (and the leading zeroes and trailing blanks are
removed). The fields vary in length, so the system needs a flag to determine where
one element ends and another begins. For example, an element delimiter marks the
beginning of a new element.

Note: Although setting EDI delimiters in Sterling Gentran:Server is mandatory
only if you are using a standard with composite elements or subelements, we
recommend that you perform this task regardless of which standard you use.
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This table lists the default EDI delimiters.

Field

ANSI X12 EDIFACT TRADACOMS

Default Char Default Hex Default Char Default Hex Default Char Default Hex

Tag Delimiter + (plus sign) = (equal sign) Ox3D

Segment Delimiter ~ (tilde) 0x7E ‘ (apostrophe) 0x27 ’ (apostrophe) Ox27

Element Delimiter * (asterisk) 0x2A + (plus sign) 0x2B + (plus sign) Ox2B

Sub Element
Delimiter

: (colon) 0x3A : (colon) 0x3A : (colon) Ox3A

Decimal Separator . (period) 0x2E . (full stop) Ox2E

Release Character ? (question
mark)

0x3F ? (question
mark)

Ox3F

Verifying the Global EDI Date Formats
The Forms Integration subsystem enables you to customize the global EDI date
formats for all forms. You can specify the default EDI format of dates for both six-
and eight-character dates. When you customize the global EDI date formats, the
settings are valid for all forms created in the current session of Sterling
Gentran:Server. However, you can override the default date formats for an
individual element on the Element Properties dialog for that element.

About this task

You must verify that you are using the correct global date formats the first time
you use Sterling Gentran:Server. Typically, you verify the global EDI date formats
one time only. You can change the default date formats if they do not match the
formats you intend to use.

Use this procedure to verify the global EDI date formats.

Procedure
1. Launch the Forms Integration subsystem.
2. Select Options > Preferences. The Preferences dialog is a property sheet that

enables you to set global defaults for Sterling Gentran:Server.
3. Select the Standard Formats tab and verify the default date formats that are

used when elements are read from the standards database.
4. Verify that the Six-character dates list contains YYMMDD to define the format

of the six-character EDI dates in your forms.
5. Verify that the Eight character dates list contains YYYYMMDD to define the

format of the eight-character EDI dates in your forms.
6. Click OK to accept the default date formats for 6- and 8-character date fields

and exit the Preferences dialog.

Note: To change the order in which the date formats appear in the
Six-character dates and Eight character dates lists or to add a new date format
to the lists, select Options > Date Formats.
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Tips and Recommendations
File naming conventions

You allocate a file name to a form when you save the form for the first time or use
the Save As function to save a copy of the form under a different name. The name
of the form should define the form in a meaningful way.

The default file extension for forms is .STP. Using this extension distinguishes
source form files from other types of files, such as compiled translation objects. The
naming conventions in Sterling Gentran:Server are as follows:
v The source form (form created in Sterling Gentran:Server) should be named

using the file extension .STP.
v The compiled translation object (translation object that is the result of compiling

the source form) should be named using the same file name that was allocated
to the source form, but with the file extension .TPL.

We recommend that you use these naming conventions to distinguish source forms
and compiled translation objects from other types of files. We also recommend that
you use the same file name (with different file extensions) for a source form and
the translation object that was compiled from it.

When you make a major change to the form, increase the version to the next
higher sequential number (for example, 2.0, 3.0). If you make a minor change to
the form, increase the release to the next higher sequential number (for example,
2.1, 2.2).

We recommend that you save the form as often as possible, to mitigate the possible
loss of additions or modifications in the event of a hardware or system error.

If you have performed any function that invalidates the current format of the
translation object, the Save function is unavailable until you regenerate the layout.

Document names

We recommend that you set up a Document Name for each form to make the
identification of a document created by this form easier in Sterling Gentran:Server.
This allows you to differentiate between documents in the document browsers in
Sterling Gentran:Server. Document names can be up to 255 characters in length.

To set up a Document Name, you must select an element or field in the form that
contains data that distinguishes this document. (If you choose a non-string element
or field, you need to convert it to a string first.) Then, the Name field of the
document browsers that contain this document contain the data from the selected
element or field. You can choose any element or field as the Document Name, but
we strongly recommend that you select an element or field that occurs only once
in the document and has a data type of String.

Generating

You should regenerate the form periodically as you customize it to ensure that the
most recent changes to the frame are reflected in the Layout Window.

When you first generate the form, each field in the Layout Window is labeled with
the same name as its corresponding element in the EDI File Format Window. As
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you customize the form, however, you change some of the labels and remove
others, so all the fields are not labeled the same as their corresponding elements.
Even though you change or remove some field labels, each field still corresponds
to one element.

Activating

If you click a group, segment, composite, or element that you did not mean to
activate, right-click the component and select Deactivate.

When you activate an element in a print form, the tag Printed is displayed before
that element’s description to indicate that this field will be printed. If you later
prevent a field from being displayed on the printout, then the tag Not Printed is
displayed before that element’s description.

When you activate an element in a screen entry form, either the tag Edit Box or the
tag Drop Down is displayed before that element’s description. Edit Box indicates
that the element is formatted as a field. Drop Down indicates that the element is
formatted as a list because you applied a standard rule that allows a selection of
multiple items.

To hide the groups, segments, and elements that you are not using, select View >
Show Active Only.

When you activate a conditional group or segment, the mandatory subordinate
segments and elements are activated automatically. A conditional group or segment
is used only if there is EDI data available for an element contained in it.

When you activate a conditional group, segment, or composite, the mandatory
subordinate segments, composites, and elements are activated automatically. A
conditional group, segment, or composite is used only if there is EDI data available
for an element contained in it.

Promoting and Changing Segments and Groups

The Promote function extracts one iteration (instance) of a group or repeating
segment. Promote is a specialized function that preserves the integrity of the EDI
structure. By default, the fields corresponding to each group and repeating
segment are displayed on a separate frame from the rest of the fields in the
document. When you promote a group to the parent frame, the fields
corresponding to the group are displayed on the frame to which the group is
subordinate. If you do not promote a group to the parent frame, the fields
corresponding to the group are displayed on their own frame.

When you promote a segment, the new segment is defined as mandatory (with a
minimum use of one). If you want to make the segment conditional, you must
change the minimum use to zero.

Changing the minimum use of a segment or group from zero to one changes the
status of the segment or group from conditional to mandatory. If EDI data is not
present for a segment or group that has a minimum use of one or greater, a
compliance error occurs during translation for that segment or group.

Changing the maximum use of a segment or group changes the maximum number
of times the segment or group can be used. A segment or group with a maximum
use greater than one repeats (loops), and is placed on a separate frame than the
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segment or group to which it is subordinate. A segment or group with a maximum
use of one does not repeat, and its fields are displayed on the same frame as the
group or segment to which they are subordinate.

If a segment or element occurs more than once in a form, it is identified by its
name <ID>. The second and subsequent occurrences are identified by <ID>:n,
where n is the number of the occurrence in the form.

Accumulators

There is only one set of accumulators for each form. This means that accumulator
0, whether it is used in the Primary Accumulator or Alternate Accum box, is the
same accumulator with the same content. If you assign calculations to accumulator
0 at the beginning of the form and then use accumulator 0 again later in the form,
the content of that accumulator will be the result of the earlier calculation. Any
additional calculations you assign to that accumulator will be performed on the
content resulting from an earlier calculation.

Formatting

When the form is generated, the upper left corner of each frame in the form is
placed in the upper left corner of the Layout Window.

Use the horizontal ruler at the top of the frame to help you resize the frame. The
instructions in this tutorial are given in centimeters. You can toggle from inches to
centimeters by double-clicking the yellow square where the vertical and horizontal
rulers meet. Use the horizontal ruler to help you find specific locations on the
ruler, or to help you measure width. Use the vertical ruler to the left of the frame
to help you measure length.

You should be able to view the entire width of the frame. If the right side of the
header frame and the vertical scroll bar for the frame are not visible in the Layout
Window, move the center bar between the EDI File Format Window and the
Layout Window farther to the left so the entire frame is displayed. Alternatively,
you can use the horizontal scroll bar at the bottom of the Forms main window to
bring the right side of the header frame into view.

Drag the bottom of the frame to the bottom of the Forms window, so that as many
of the fields on the frame are displayed as possible.

If a field is not in the part of the frame that currently is displayed, use the scroll
bar to scroll down the frame until you locate the hidden fields.

To select more than one field or field label, click and drag the mouse diagonally
across all the fields and field labels you want to select. All the fields and field
labels completely included within the dragged-across area are selected.

If the template is larger than the frame (there is a scroll bar on the right side of the
frame), the static text is displayed in the upper left corner of the part of the
template that is displayed, not at the top of the template.

If you format a form component in a way you did not intend, select Display >
Undo.
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If you forget which unlabeled field contains what data, you can click the field. Its
associated element is highlighted in the EDI File Format Window, providing you
with a description of the field.

If a field and its corresponding field label move together, the Lock Labels to Fields
option is turned on. Click Lock Labels on the Main Toolbar to turn off the Lock
Labels option.

Screen Entry Forms

In general, the column width should be wider than the actual content of the
column. The extra space that is not used for the content of the column will provide
white space separating the columns. If the width for each column is the exact
width of the data, then there will not be space separating the columns of data.
However, the last column on the screen does not need to be made wider than the
content.

The reference is the item (field, field label, list box, or static text) relative to which
all other selected items are formatted. The reference is indicated by an outline of
diagonal lines, whereas all other selected items are outlined by a solid line. The
last item selected in a group of selected items is the reference.
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Chapter 2. About Print Forms

Purchase Order Components for ANSI X12
Mandatory components

For an ANSI X12 purchase order (850), the following groups, segments, and
elements have been defined as mandatory by the standards committee. These
components are activated automatically when you create a new form:

Group Segment Element Description Data Type Length

BEG Beginning Segment for
Purchase Order

BEG01 Transaction Set Purpose Code String 2

BEG02 Purchase Order Type Code String 2

BEG03 Purchase Order Number String 22

BEG05 Purchase Order Date Dt/Tm 6

PO1 Item Detail

CTT Transaction Totals

CTT01 Number of Line Items Integer 6

Required components

This table lists the form components that are required (need to be activated) and
are not mandatory for the standard.

Element Description Data Type Length
Code Value/Format to
Be Assigned

Note/Special Instruction (NTE Segment)

NTE02 Free Form Message String 60

Reference Numbers (REF Segment)

REF01 Reference Number Qualifier String 2

REF02 Reference Number String 30

Terms of Sale/Deferred Terms of Sale (ITD Segment)

ITD01 Terms Type Code String 2

ITD12 Description String 80

Name and Address (N1 Group)

Name (N1 Segment in N1 Group)

N101 Entity Identifier Code String 2 BT (Bill to)

ST (Ship to)

BY (Buying party)

N102 Name String 35

Address Information (N3 Segment in N1 Group)

N301 Address Information String 35
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Element Description Data Type Length
Code Value/Format to
Be Assigned

N302 Address Information String 35

Geographic Location (N4 Segment in N1 Group)

N401 City Name String 30

N402 State or Province Code String 2

N403 Postal Code String 9

Item Detail (PO1 Group)

Baseline Item Data (PO1 Segment in PO1 Group) (Already Activated)

PO101 Assigned Identification String 11

PO102 Quantity Ordered Real 9 Format = R6

PO103 Unit or Basis for
Measurement Code

String 2

PO104 Unit Price Real 14 Format = R2

PO106 Product/Service ID Qualifier String 2 VN (Vendor)

UP (UPC Code)

PO107 Product/Service ID String 30

Product/Item Description (PID Group in PO1 Group)

Product/Item Description (PID:2 Segment in PID Group)

PID:201 Item Description Type String 1

PID:202 Description String 80

Date/Time Reference (DTM:2 Segment in PO1 Group)

DTM:201 Date/Time Qualifier String 3 010 (Requested Ship)

038 (Ship No Later)

DTM:202 Date Dt/Tm 6 Screen Format =
�MM/DD/YY

Customization tasks

This table lists the customizing tasks for ANSI X12 described in this tutorial.

Form Component Description Customizing Needed

BEG01 element Transaction Set
Purpose Code

This element is required in the purchase order, but is not meaningful
for your purposes. You prevent this field from being displayed on the
printout.

BEG02 element Purchase Order Type
Code

The code from this element is used to look up the description in a
code list table, and the description is printed in another field that you
create. You prevent the Purchase Order Type Code field from being
displayed on the printout, because the more meaningful description
is printed instead.

BEG05 element Purchase Order Date The date in the EDI data is in the format "YYMMDD," but you want
the date to be printed in the format "MM/DD/YY," so you set the
format accordingly.
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Form Component Description Customizing Needed

REF segment Reference Numbers The standard allows this segment to be used up to twelve times in
one purchase order, but you and your trading partner have decided
to use this segment only once. Therefore, you change the maximum
use of this segment from twelve to one.

REF01 element Reference Number
Qualifier

The code from this element is used to look up its description in a
code list table, and the description is printed in another field that you
create. You prevent the Reference Number Qualifier field from being
displayed on the printout, because the more meaningful description
is printed instead.

ITD01 element Terms Type Code The code from this element is used to look up its description in a
code list table, and the description is printed in another field that you
create. You prevent the Terms Type Code field from being displayed
on the printout, because the more meaningful description is printed
instead.

N101 element Entity Identifier Code The code from this element is used to look up its description in a
code list table, and the description is printed in another field that you
create. You prevent the Entity Identifier Code field from being
displayed on the printout, because the more meaningful description
is printed instead.

N4 segment Geographic Location The fields (city, state, postal code) for the N4 segment currently are
set up to be printed before the street address from the N3 segment.
(The segments are set up this way to allow the N3 segment to repeat,
causing the N3 fields to be displayed on a different frame than the
one that contains the N1 and N4 fields.) However, this format is not
the standard format for an address. You insert a new group and place
the N4 segment under the new group so that the address is printed
properly.

PO1 group Baseline Item Data After you customize and format the fields in the PO1 group, you
copy and paste the PO1 group at the same level in the EDI file. The
original PO1 group contains column headings for the line item detail,
but you prevent the column headings from being printed on the
printout for all line items after the first. You change the maximum
use of the first PO1 group to one so that the column headings are
printed only once (for the first line item). The second PO1 group
retains its maximum use of one hundred thousand, allowing up to
one hundred thousand line items to be printed on the printout
(without printing the column headings for each line item).

PO104 element Unit Price Both the EDI data and the printed price are formatted with two
explicit decimal places.

PO106 element Product/Service ID
Qualifier

The code from this element is used to look up its description in a
code list table, and the description is printed in another field that you
create. You prevent the Product/Service ID Qualifier field from being
displayed on the printout, because the more meaningful description
is printed instead.

PID group Product/Item
Description

The standard allows this group to be used up to one thousand times
for each line item. You need this group to be used only once for each
line item, so you change the maximum use of this group to one.

DTM segment Date/Time Reference The standard allows the date to be used up to ten times for each line
item. You need two separate DTM segments: one for the requested
ship date, and one for the ship no later date (in that order). You
promote this segment to cause another iteration of this segment to
occur for each line item. Also, because you know what types of dates
you receive (and in what order), you instruct the system to use the
key fields function to print the requested ship date in one DTM
segment and the ship no later date in the other DTM segment.
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Form Component Description Customizing Needed

DTM01 element Date/Time Qualifier You know that your partner sends you only two types of dates:
requested ship and ship no later (in that order), so you use the key
fields function in both DTM segments to place the appropriate date
in the appropriate DTM02 element. You do not need to load the code
list table for the DTM01 element, because you receive only one valid
code for this field. You hide this qualifier field.

DTM02 element Date The date in the EDI data is in the format "YYMMDD," but you want
the date to be printed in the format "MM/DD/YY," so you set the
format accordingly.

CTT segment Transaction Totals You want this segment to print the total number of line items at the
end of the printout. However, if the form were generated now, the
total would be printed at the beginning of the printout (because the
fields in the CTT segment are displayed on the same frame as the
fields in the BEG segment). You change the arrangement of the form,
while maintaining the integrity of the EDI data, so the total is printed
at the end of the purchase order.

Purchase Order Components for EDIFACT
Mandatory components

For an EDIFACT purchase order (ORDERS), the following groups, segments,
composites, and elements have been defined as mandatory by the standards
committee.

This table describes the components that are activated automatically when you
create a new form.

Segment Composite Element Description

BGM Beginning of Message

DTM Date/Time/Period

C507

DTM01 Date/Time/Period Qualifier

UNS Section Control

UNS01 Section Identification

Required components

This table lists the form components that are required (need to be activated) and
are not mandatory for the standard.

Element Description Data Type Length
Code Value/Format to
Be Assigned

Beginning of Message (BGM Segment) (Already Activated)

BGM05 Document/Message Number String 35

BGM06 Message Function, Coded String 3

Date/Time/Period (DTM Segment)

DTM01 Date/Time/Period Qualifier String 3
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Element Description Data Type Length
Code Value/Format to
Be Assigned

DTM02 Date/Time/Period String 35 v 4 (Change)

v 13 (Request)

Free Text (FTX Segment)

FTX01 Text Subject Qualifier String 3

FTX06 Free Text String 70

Reference (RFF Group)

Reference (RFF Segment)

RFF01 Reference Qualifier String 3

RFF02 Reference Number String 35

Name and Address (NAD Group)

Name and Address (NAD Segment)

NAD01 Party Qualifier String 3 v AA (Party billed)

v BY (Buyer)

v ST (Ship to)

NAD10 Party Name String 35

NAD16 Street and Number/P.O. Box String 35

NAD17 Street and Number/P.O. Box String 35

NAD19 City Name String 35

NAD20 Country Sub-Entity
Identification

String 9

NAD21 Postcode Identification String 9

Payment Terms Basis (PAT Group)

Payment Terms Basis (PAT Segment)

PAT01 Payment Terms Type
Qualifier

String 3 v 10 (Instant)

v 18 (Previously
Agreed Upon)

PAT02 Terms of Payment
Identification

String 17

PAT05 Terms of Payment String 35

Line Item (LIN Group)

Line Item (LIN Segment)

LIN01 Line Item Number Number 6

Additional Product ID (PIA Segment in LIN Group)

PIA01 Product ID Function
Qualifier

String 3

PIA02 Item Number String 35

Item Description (IMD:2 Segment in LIN Group)

IMD:206 Item Description String 35

Measurements (MEA:3 Segment in LIN Group)
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Element Description Data Type Length
Code Value/Format to
Be Assigned

MEA:301 Measurement Application
Qualifier

String 3

MEA:305 Measure Unit Qualifier String 3

MEA:306 Measurement Value String 18 Format = R0

Quantity (QTY:3 Segment in LIN Group)

QTY:301 Quantity Qualifier String 3

QTY:302 Quantity Number 15 Format = N0

Date/Time/Period (DTM:13 Segment in LIN Group)

DTM:1301 Date/Time/Period Qualifier String 3

DTM:1302 Date/Time/Period String 35

Monetary Amount (MOA:5 Segment in LIN Group)

MOA:501 Monetary Amount Type
Qualifier

String 3

MOA:502 Monetary Amount Number 18 Format = R2

Section Control (UNS Segment)

UNS01 Section Identification String 1

Control Total (CNT Segment)

CNT01 Control Qualifier String 3

CNT02 Control Value Number 18 Format = N0

Customization tasks

This table lists the customization tasks for EDIFACT described in this tutorial.

Form Component Description Customization Task

BGM05 element Document/Message
Number

You will set up the document name (which enables you to
differentiate between messages in the document browsers in Sterling
Gentran:Server) in this element. In addition, the standard allows this
element to have a maximum length of thirty-five characters, but you
expect a string no longer than ten characters from your trading
partner. You will change both the maximum length of the element
and the display length of the field to ten. Also, you will change the
field name to Order Number, which better describes the data in this
field for your company.

BGM06 element Message Function,
Coded

The code from this element will be used to look up the description in
a code list table, and the description will be printed in another field
that you create. You will prevent the Message Function, Coded field
from being displayed on the printout, because the more meaningful
description will be printed instead.

DTM segment Date/Time/Period The standard allows this segment to be used up to thirty-five times
in one purchase order, but you and your trading partner have
decided to use this segment only once. Therefore, you will change the
maximum use of this segment to one.

DTM01 element Date/Time/Period
Qualifier

This element is required in the purchase order, but is not meaningful
for your purposes. You will prevent this field from being displayed
on the printout.
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Form Component Description Customization Task

DTM02 element Date/Time/Period The standard allows a maximum length of thirty-five characters, but
you expect a string no longer than eight characters from your partner.
You will change the maximum length of the element and the display
length of the field to eight. Also, you will change the field name to
Order Date, which better describes the data in this field for your
company.

FTX segment Free Text The standard allows this segment to be used up to five times in one
purchase order, but you and your trading partner have decided to
use this segment only once. Therefore, you will change the maximum
use of this segment to one.

FTX01 element Text Subject Qualifier This element is required in the purchase order, but is not meaningful
for your purposes. Therefore, you will prevent this field from being
displayed on the printout.

FTX06 element Free Text The standard allows a maximum length of seventy characters, but
you expect a string no longer than sixty characters from your partner.
You will change the maximum length of the element and the display
length of the field to sixty. Also, the data in this element will be
self-explanatory, so you will remove the label from this field.

RFF group Reference The standard allows this group to be used up to ten times in one
purchase order, but you and your trading partner have decided to
use this group only once. Therefore, you will change the maximum
use of this group. Also, you will promote this group so that the fields
in this group are placed on the same frame as the related header
fields.

RFF01 element Reference Qualifier This element is required in the purchase order, but is not meaningful
for your purposes. You will prevent this field from being displayed
on the printout.

RFF02 element Reference Number The standard allows a maximum length of thirty-five characters, but
you expect a string no longer than twelve characters from your
partner. You will change the maximum length of the element and the
display length of the field to twelve. Also, you will change the field
name to Contract No., which better describes the data in this field for
your company.

NAD01 element Party Qualifier The qualifier from this element will be used to look up the
description in a code list table, and the description will be printed in
another field that you create. You will prevent the Party Qualifier
field from being displayed on the printout, because the more
meaningful description will be printed instead.

NAD10 element Party Name The data in this element will be explained by the qualifier in the
Party Qualifier element, so you will remove the label from this field.

NAD16 element Street and
Number/P.O. Box

The data in this element will be self-explanatory, so you will remove
the label from this field.

NAD17 element Street and
Number/P.O. Box

The data in this element will be self-explanatory, so you will remove
the label from this field.

NAD19 element City Name The standard allows a maximum length of thirty-five characters, but
you expect a string no longer than thirty characters from your
partner. You will change the maximum length of the element and the
display length of the field to thirty. Also, the data in this element will
be self-explanatory, so you will remove the field label.
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Form Component Description Customization Task

NAD20 element Country Sub-Entity
Identification

The standard allows a maximum length of nine characters, but you
expect a string no longer than two characters from your partner. You
will change the maximum length of the element and the display
length of the field to two. Also, the data in this element will be
self-explanatory, so you will remove the field label.

NAD21 element Postcode
Identification

The data in this element will be self-explanatory, so you will remove
the field label.

PAT group Payment Terms Basis The standard allows this group to be used up to ten times in one
purchase order, but you and your trading partner have decided to
use this group only once. Therefore, you will change the maximum
use of this group. Also, you will promote this group so that the fields
in this group are placed on the same frame as the related header
fields.

PAT01 element Payment Terms Type
Qualifier

The qualifier from this element will be used to look up the
description in a code list table, and the description will be printed in
another field that you create. You will prevent the Payment Terms
Type Qualifier field from being displayed on the printout, because
the more meaningful description will be printed instead.

PAT02 element Terms of Payment
Identification

This element is required in the purchase order, but is not meaningful
for your purposes. You will prevent this field from being displayed
on the printout.

PAT05 element Terms of Payment The data in this element will be explained by the qualifier in the
Terms of Payment Identification element, so you will remove the
label from this field.

LIN group Line Item After you customize and format the fields in the LIN group, you will
copy and paste the LIN group at the same level in the EDI file. The
original LIN group will contain column headings for the line item
detail, but you will prevent the column headings from being printed
for all line items after the first. You will change the maximum use of
the first LIN group to one so that the column headings are printed
only once (for the first line item). You will change the maximum use
of the second LIN group to 199,999. Up to two hundred thousand
line items (one from the first LIN group and 199,999 from the second
LIN group) can be printed on the printout (without printing the
column headings for each line item).

LIN01 element Line Item Number The standard allows a maximum length of six characters, but you
expect a string no longer than five characters from your partner. You
will change the maximum length of the element and the display
length of the field to five. Also, you will change the field name to
Line, which briefly describes the data in this field.

PIA segment (in LIN
group)

Additional Product
ID

The standard allows this segment to be used up to twenty-five times
for each line item, but you and your trading partner have decided to
use this segment only once. Therefore, you will change the maximum
use of this segment to one.

PIA01 element Product ID Function
Qualifier

You will change the field name to Code, which more briefly describes
the data in this field for your company.

PIA02 element Item Number The standard allows a maximum length of thirty-five characters, but
you expect a string no longer than six characters from your partner.
You will change the maximum length of the element and the display
length of the field to six. Also, you will change the field name to
Prod ID, which briefly describes the data in this field.
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IMD segment (in LIN
group)

Item Description The standard allows this segment to be used up to ten times for each
line item, but you and your trading partner have decided to use this
segment only once. Therefore, you will change the maximum use of
this segment to one.

IMD06 element Item Description The data in this element will be self-explanatory, so you will remove
the label from this field.

MEA segment (in
LIN group)

Measurements The standard allows this conditional segment to be used up to five
times for each line item, but you and your trading partner want to
use this segment only once. You will change the maximum use of this
segment to one. Also, to make this segment mandatory, you will
change the minimum use of this segment to one.

MEA01 element Measurement
Application Qualifier

This element is required in the purchase order, but is not meaningful
for your purposes. You will prevent this field from being displayed
on the printout.

MEA05 element Measure Unit
Qualifier

This element is required in the purchase order, but is not meaningful
for your purposes. You will prevent this field from being displayed
on the printout.

MEA06 element Measurement Value The standard allows a maximum length of eighteen digits, but you
expect a number no longer than two digits from your partner. You
will change the maximum length of the element and the display
length of the field to two. You will change the field name to Unit,
which better describes the data in this field for your company. Also,
the standard defines the data in this element as being formatted with
an explicit decimal point and up to nine decimal places. You will not
use decimal places for the data in this field, so you will format both
the EDI data and the printed data without decimal places.

QTY segment (in LIN
group)

Quantity The standard allows this segment to be used up to ten times for each
line item, but you and your trading partner want to use this segment
only once. You will change the maximum use of this segment to one.
Also, to make this segment mandatory, you will change the minimum
use of this segment to one.

QTY01 element Quantity Qualifier This element is required in the purchase order, but is not meaningful
for your purposes. You will prevent this field from being displayed
on the printout.

QTY02 element Quantity The standard allows a maximum length of fifteen digits, but you
expect a number no longer than six digits from your partner. You will
change the maximum length of the element and the display length of
the field to six. You will change the field name to Qty, which briefly
describes the data in this field. Also, the standard defines the data in
this element as being formatted with an explicit decimal point and
up to nine decimal places. You will not use decimal places for the
data in this field, so you will format both the EDI data and the
printed data with an implicit decimal point and no decimal places.

DTM segment (in
LIN group)

Date/Time/Period The standard allows the date/time/period to be used up to
thirty-five times for each line item. You need two separate DTM
segments: the required shipment date, and the last delivery date (in
that order). You will promote this segment to cause another iteration
of this segment to occur for each line item, and then change the
maximum use to one because you need to use this segment only once
per line item. Also, you know what types of dates you will receive
(and in what order), so you will use the key field function to print
the required shipment date in one DTM segment and the last
delivery date in the other DTM segment.
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DTM01 element Date/Time/Period
Qualifier

This element is required in the purchase order, but is not meaningful
for your purposes. You will prevent this field from being displayed
on the printout.

DTM02 element Date/Time/Period The standard allows a maximum length of thirty-five characters, but
you expect a string no longer than eight characters from your partner.
You will change the maximum length of the element and the display
length of the field to eight. Also, you will change the field name to
Requested (or Ship No for the DTM02 element in the second iteration
of the DTM segment), which briefly describes the data in this field.

MOA segment (in
LIN group)

Monetary Amount The standard allows this segment to be used up to five times for each
line item, but you and your trading partner have decided to use this
segment only once. You will change the maximum use of this
segment to one.

MOA01 element Monetary Amount
Type Qualifier

This element is required in the purchase order, but is not meaningful
for your purposes. You will prevent this field from being displayed
on the printout.

MOA02 element Monetary Amount The standard allows a maximum length of eighteen digits, but you
expect a number no longer than eight digits from your partner. You
will change the maximum length of the element and the display
length of the field to eight. You will change the field name to Price,
which better describes the data in this field for your company. Also,
the standard defines the data in this element as being formatted with
an explicit decimal point and up to nine decimal places. You need
only two decimal places for the data in this field, so you will format
the EDI data and the printed data with two decimal places.

UNS01 element Section Identification This element is required in the purchase order, but is not meaningful
for your purposes. You will prevent this field from being displayed
on the printout.

CNT segment Control Total
Segment

You want this segment to print the total number of line items at the
end of the printout. However, if the form were generated now, the
total would be printed at the beginning of the printout (because the
fields in the CNT segment would be displayed on the same frame as
the fields in the BGM segment). You will change the arrangement of
the form, while maintaining the integrity of the EDI data, so the total
is printed at the end of the purchase order.

CNT01 element Control Qualifier This element is required in the purchase order, but is not meaningful
for your purposes. You will prevent this field from being displayed
on the printout.

CNT02 element Control Value The standard allows a maximum length of eighteen digits, but you
expect a number no longer than six digits from your partner. You will
change the maximum length of the element and the display length of
the field to six. You will change the field name to Number of Line
Items, which better describes the data in this field for your company.
Also, the standard defines the data in this element as being formatted
with an explicit decimal point and up to nine decimal places. You
will not use decimal places for the data in this field, so you will
format both the EDI data and the printed data with an implicit
decimal point and no decimal places.
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Purchase Order Components for TRADACOMS
Mandatory components

For a TRADACOMS ANA001 ORDERS release 9 purchase order, the following
groups, segments, composites, and elements have been defined as mandatory by
the standards committee.

This table describes the components that are activated automatically when you
create a new form.

Group Segment Composite Element Description

ORDHDR Order File Header

TYP Transaction Type Details

CD02 Transaction Code

SDT Supplier Details

SIDN

CDT Customer Details

CIDN

FIL File Details

FLGN File Generation Number

FLVN File Version Number

FLDT File Creation Date

CLO Customer’s Location

CLOC

ORD Order References

ORNO

OLD

OTR Order Trailer

LORD Lines Ordered

Required components

This table lists the form components that are required (need to be activated) and
are not mandatory for the standard.

Element Description Data Type Length

Code
Value/Format to
Be Assigned

Order File Header (ORDHDR Group) (Already Activated)

Supplier Details (SDT Segment) (Already Activated)

SDT SIDN SID0 Supplier’s ANA Location
Code

String 13

SDT SNAM Supplier’s Name String 40

Customer Details (CDT Segment) (Already Activated)

CDT CIDN CID0 Customer’s ANA
Identity/Loc

String 13
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Element Description Data Type Length

Code
Value/Format to
Be Assigned

CDT CNAM Customer’s Name String 40

CDT CADD CAD0 Customer’s Address Line 1 String 35

CDT CADD CAD1 Customer’s Address Line 2 String 35

CDT CADD CAD2 Customer’s Address Line 3 String 35

CDT CADD CAD3 Customer’s Address Line 4 String 35

CDT CADD CAD4 Customer’s Post Code String 8

Customer’s Location (CLO Segment) (Already Activated)

CLO CLOC CLO0 Customer’s ANA Location
Code

String 13

CLO CNAM Customer’s Name String 40

CLO CADD CAD0 Customer’s Address Line 1 String 35

CLO CADD CAD1 Customer’s Address Line 2 String 35

CLO CADD CAD2 Customer’s Address Line 3 String 35

CLO CADD CAD3 Customer’s Address Line 4 String 35

CLO CADD CAD4 Customer’s Post Code String 8

Order References (ORD Segment) (Already Activated)

ORD ORNO ORN0 Customer’s Order Number String 17

ORD ORNO ORN2 Date Order Placed by
Customer

Dt/Tm 6 Screen Format =
�DD/MM/YY

ORD CD07 Order Code String 1 Any valid code

Delivery Instructions (DIN Segment)

DIN LDAT Latest Delivery Date Dt/Tm 6 Screen Format =
�DD/MM/YY

Order Line Details (OLD Group) (Already Activated)

Order Line Details (OLD:2 Segment)

OLD:2 SPRO SPR1 Supplier’s Code for the
Traded Unit

String 30

OLD:2 CPRO CPR1 Customer’s Item Code String 30

OLD:2 UNOR
UNO0

Consumer Units in Traded
Unit

String 15 Format = N0

OLD:2 UNOR CD04 Measure Indicator String 6

OLD:2 OQTY OQT0 Number of Traded Units
Ordered

String 15 Format = N0

OLD:2 OUCT OUC0 Cost Price Real 14 Screen Format =
R4

OLD:2 TDES TDE0 Traded Unit Descr. Line 1 String 40

OLD:2 TDES TDE1 Traded Unit Descr. Line 2 String 40
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Customization tasks

This table lists the customization tasks described in this tutorial.

Form Component Description Customisation Task

ORDHDR group Order File Header You will promote this group so that the fields in this group are
placed on the parent frame.

TYP CD02 element Transaction Code This element is required in the purchase order, but is not meaningful
for your purposes. Therefore, you will prevent this field from being
printed on the printout.

SDT SIDN SID0
element

Supplier’s ANA
Location Code

This element is required in the purchase order, but is not meaningful
for your purposes. Therefore, you will prevent this field from being
printed on the printout.

SDT SNAM element Supplier’s Name This element is required in the purchase order, but is not meaningful
for your purposes. Therefore, you will prevent this field from being
printed on the printout.

CDT CIDN CID0
element

Customer’s ANA
Identity/Loc

This element is required in the purchase order, but is not meaningful
for your purposes. Therefore, you will prevent this field from being
printed on the printout.

CDT CNAM element Customer’s Name You will change the field name to "Customer", which better describes
the data in this field for your company.

CDT CADD CAD0
element

Customer’s Address
Line 1

The data in this element will be self-explanatory, so you will remove
the label from this field.

CDT CADD CAD1
element

Customer’s Address
Line 2

The data in this element will be self-explanatory, so you will remove
the label from this field.

CDT CADD CAD2
element

Customer’s Address
Line 3

The data in this element will be self-explanatory, so you will remove
the label from this field.

CDT CADD CAD3
element

Customer’s Address
Line 4

The data in this element will be self-explanatory, so you will remove
the label from this field.

CDT CADD CAD4
element

Customer’s Post
Code

The data in this element will be self-explanatory, so you will remove
the label from this field.

FIL FILGN element File Generation
Number

This element is required in the purchase order, but is not meaningful
for your purposes. Therefore, you will prevent this field from being
printed on the printout.

FIL FILVN element File Version Number This element is required in the purchase order, but is not meaningful
for your purposes. Therefore, you will prevent this field from being
printed on the printout.

FIL FILDT element File Creation Date This element is required in the purchase order, but is not meaningful
for your purposes. Therefore, you will prevent this field from being
printed on the printout.

CLO CLOC CLO0
element

Customer’s ANA
Location Code

This element is required in the purchase order, but is not meaningful
for your purposes. Therefore, you will prevent this field from being
printed on the printout.

CLO CNAM element Customer’s Name You will change the field name to "Location", which better describes
the data in this field for your company.

CLO CADD CAD0
element

Customer’s Address
Line 1

The data in this element will be self-explanatory, so you will remove
the label from this field.

CLO CADD CAD1
element

Customer’s Address
Line 2

The data in this element will be self-explanatory, so you will remove
the label from this field.

CLO CADD CAD2
element

Customer’s Address
Line 3

The data in this element will be self-explanatory, so you will remove
the label from this field.
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CLO CADD CAD3
element

Customer’s Address
Line 4

The data in this element will be self-explanatory, so you will remove
the label from this field.

CLO CADD CAD4
element

Customer’s Post
Code

The data in this element will be self-explanatory, so you will remove
the label from this field.

ORD ORNO ORN0
element

Customer’s Order
Number

You will set up the document name (which enables you to
differentiate between messages in the document browsers in Sterling
Gentran:Server) in this element. Also, you will change the field name
to "Order Number", which better describes the data in this field for
your company.

ORD ORNO ORN2
element

Date Order Placed by
Customer

You will change the field name to "Order Date", which better
describes the data in this field for your company. Also, the date in
the EDI data will be in the format "YYMMDD", but you want the
date to be printed in the format "DD/MM/YY", so you will set the
screen format accordingly. In addition, you will change the field and
element lengths to reflect the longer date format.

ORD CD07 element Order Code The code from this element will be used to look up the description in
a code values list, and the description will be printed in another field
that you create. You will prevent the Order Code field from being
displayed on the printout, because the more meaningful description
will be printed instead.

DIN LDAT element Latest Delivery Date The date in the EDI data will be in the format "YYMMDD", but you
want the date to be printed in the format "DD/MM/YY", so you will
set the screen format accordingly. Also, you will change the field and
element lengths to reflect the longer date format.

OLD group Order Line Details After you customize and format the fields in the OLD group, you
will copy and paste the OLD group at the same level in the EDI file.
The original OLD group will contain column headings for the line
item detail, but you will prevent the column headings from being
printed for all line items after the first. You will change the maximum
use of the first OLD group to one so that the column headings are
printed only once (for the first line item). You will change the
maximum use of the second OLD group to 999,998. Up to 999,999
line items (one from the first OLD group and �999,998 from the
second OLD group) can be printed on the printout (without printing
the column headings for each line item).

OLD:2 SEQA element First Level Sequence
Number

The standard allows a maximum length of ten digits, but you expect
a number no longer than five digits from your partner. You will
change the maximum length of the element and the display length of
the field to five. You will change the field name to "Line", which
better describes the data in this field for your company.

OLD:2 SPRO SPR1
element

Supplier’s Code for
the Traded Unit

The standard allows a maximum length of thirty characters, but you
expect a string no longer than ten characters from your partner. You
will change the maximum length of the element and the display
length of the field to ten. You will change the field name to "Prod
ID", which better describes the data in this field for your company.

OLD:2 CPRO CPR1
element

Customer’s Item
Code

This element is required in the purchase order, but is not meaningful
for your purposes. Therefore, you will prevent this field from being
printed on the printout.
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OLD:2 UNOR UNO0
element

Consumer Units in
Traded Unit

The standard allows a maximum length of fifteen characters, but you
expect a number no longer than ten digits from your partner. You
will change the maximum length of the element and the display
length of the field to ten. Also, you will change the data type from
string to number, and assign EDI and screen formats of N0
(indicating a number with an implicit decimal point and no decimal
places). In addition, you will change the field name to "Cons. Units",
which better describes the data in this field for your company.

OLD:2 UNOR CD04
element

Measure Indicator You will change the field name to "Unit", which better describes the
data in this field for your company.

OLD:2 OQTY OQT0
element

Number of Traded
Units Ordered

The standard allows a maximum length of fifteen characters, but you
expect a number no longer than six digits from your partner. You will
change the maximum length of the element and the display length of
the field to six. Also, you will change the data type from string to
number, and assign EDI and screen formats of N0 (indicating a
number with an implicit decimal point and no decimal places). In
addition, you will change the field name to "Qty Ord", which better
describes the data in this field for your company.

OLD:2 OUCT OUC0
element

Cost Price The standard allows a maximum length of fourteen digits, but you
expect a number no longer than ten digits from your partner. You
will change the maximum length of the element and the display
length of the field to ten. Also, you will change the screen format of
the data to R4 (indicating a number with an explicit decimal point
and four decimal places). In addition, you will change the field name
to "Price Each", which better describes the data in this field for your
company.

OLD:2 TDES TDE0
element

Traded Unit Descr.
Line 1

The data in this element will be self-explanatory, so you will remove
the label from this field.

OLD:2 TDES TDE1
element

Traded Unit Descr.
Line 2

The data in this element will be self-explanatory, so you will remove
the label from this field.

OTR segment Order Trailer You want this segment to print the total number of line items at the
end of the printout. However, if the form were generated now, the
total would be printed at the beginning of the printout (because the
fields in the OTR segment would be displayed on the same frame as
the fields in the ORDHDR group). You will change the arrangement
of the form, while maintaining the integrity of the EDI data, so the
total is printed at the end of the purchase order.

OTR LORD element Lines Ordered You will change the field name to "Number of Line Items", which
better describes the data in this field for your company.

Defining the Type of Form
The first task in creating a new form is to define the type of form and EDI
standard, version, and message/transaction set (document). In this tutorial, you are
creating a print form so that you can print the purchase orders that your partner
sends you. Instead of defining the purchase order yourself, you want Sterling
Gentran:Server to use the standards database on your system to build the purchase
order according to the standard.

Before you begin

Before you begin this procedure, verify that you have installed the Sterling
Standards Database for EDI.
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About this task

Use this procedure to create the new print form.

Procedure
1. Select File > New to display the New Form Wizard.
2. From the "What kind of form" list, select Print.
3. In the "What is the name of the form" box, enter one of the following:

v Print 850 Pet Zone (for ANSI X12)
v Print ORDERS Pet Zone (for EDIFACT)
v Print TRADACOMS ORDERS Pet Zone (for TRADACOMS)
This description provides a brief explanation of the compiled translation object
that enables you to differentiate it from similar translation objects in Sterling
Gentran:Server.

4. Verify that your name appears correctly in the "What is your name" box.
5. Click Next.
6. Select Delimited EDI as the data format syntax that you want to use.
7. Click Customize.

The system displays the New Delimited EDI Wizard.
8. Click Next.
9. From the Data Source list, select Gentran Standards ODBC data source.

10. Click Next.
11. From the Agency list in the Standards section, select one of the following

v [X] X12

v [E] Edifact

v [A] Tradacoms

12. From the Version list, select one of the following:
v [003040] ANSI X 12 VERSION 3 RELEASE 4

v [092001] EDIFACT 1992 RELEASE 1

v [ORDERS] ORDER DETAILS (for TRADACOMS)
13. From the Transaction list, select one of the following:

v [850] PURCHASE ORDER (for ANSI X12 and TRADACOMS)
v [ORDERS] PURCHASE ORDER MESSAGE (for EDIFACT)

14. For TRADACOMS only: From the Release drop-down list, select 9, which is
the message version you will use for this translation object.

15. Click Next to continue.
16. Click Finish. This may take a few seconds.

The system displays the New Form Wizard dialog box.
17. Click Next to continue.
18. Click Finish to create the EDI file (it may take a few seconds to create the

file).
The form displayed should look similar to the following. (This is an ANSI X12
example; some details may be different for EDIFACT and TRADACOMS.)
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19. Select Edit > Details.
The Translation Object Details box is displayed.

20. Verify that Print is selected from the Translation Object Function list.
21. In the Major version box, enter 1 to designate the version number for this

translation object.
22. In the Minor version box, accept the default value 0 that designates the release

number for this translation object.
23. The Input and Output boxes (Agency, Version, Transaction, Release, and F

Group) contain information only if the Input and/or Output sides of the form
are of EDI format. For this tutorial, do not change the information in these
boxes.

Note: The system allows you to change the information in the Input and
Output boxes, but modifying this information does not alter the content of the
form. An example of when you might want to alter these boxes is when you
want the form to reflect a standard version that is not loaded on your system.
You can change the version on this dialog, and then physically alter the form
to be compliant with that version.

24. Click OK to save the translation object details.
25. Select File > Save.
26. If necessary, navigate to the folder where Sterling Gentran:Server is installed

(GENSRVNT\Forms).
27. In the File name box, enter one of the following to replace the default file

name:
v pet_850p.stp (for ANSI X12)
v peteordp.stp (for EDIFACT)
v pettordp.stp (for TRADACOMS)

28. Click Save to save the form.
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Loading the ORDHDR Message - TRADACOMS
The TRADACOMS standard uses a header with each interchange (ORDHDR for
the ORDERS message). The header message contains information that pertains to
each message in the interchange. Sterling Gentran:Server copies the header
segments to the beginning of each document, to ensure that all the relevant
information is contained in the document. Therefore, you need to load the header
message (ORDHDR) into the ORDERS EDI file, so that all the segments and
elements are available for use.

About this task

Use this procedure to load the ORDHDR message into the ORDERS EDI file.

Procedure
1. Click the ORDERS EDI file icon.
2. Select Edit > Create Sub > Transaction Set. You will be prompted to select an

ODBC data source name.
3. Select the appropriate DSN and click OK to display the Insert Transaction Set

From Standards dialog.
4. From the Agency drop-down list box, select [A] Tradacoms.
5. From the Version drop-down list box, select [ANA001].
6. From the Transaction drop-down list box, select [ORDHDR] ORDER FILE

HEADER.
7. From the Release drop-down list box, select 9.
8. Click OK to load the ORDHDR message into the ORDERS EDI file as a

subordinate group.

About Activating PO Groups, Segments, and Elements
When Sterling Gentran:Server generates the form, the system includes all the
groups, segments, composites, and elements that are defined by the standard
agency for the version of the message/transaction set you selected. The system
activates all the groups, segments, composites, and elements that are defined as
mandatory by the standard. The system does not enable you to deactivate the
mandatory groups, segments, and elements.

To view the segments, composites, and elements in a group, segment, or composite
on your form, double-click the form component in the EDI File Format Window
(left side of the Forms main window). To activate an inactive form component,
click Activate on the Main Toolbar, then click the form component. The component
is no longer dimmed.

Example for ANSI X12

In the example below, the 850 PURCHASE ORDER file icon and BEG segment are
mandatory for the purchase order. You do not need to activate these components.
The NTE, CUR, and REF segments are not mandatory, so they are dimmed on the
form. To view the segments and elements in a group or segment on your form,
double-click the form component in the EDI File Format Window (left side of the
Forms main window). To activate an inactive form component, click Activate on
the Main Toolbar, then click the form component. The component is no longer
dimmed.

32 IBM Sterling Gentran:Server for Windows: Forms Integration Tutorial for Print Forms



Example for EDIFACT

In the example below, the BGM and DTM segments, C507 composite, and DTM01
element are mandatory for the purchase order. You do not need to activate these
components. The DTM02 and DTM03 elements are not mandatory, so they are
dimmed on the form.

Example for TRADACOMS

In the example below, the CLO segment and CLO CLOC composite are mandatory
for the purchase order. You do not need to activate these components. The CLO
CLOC CLO0, CLO CLOC CLO1, CLO CLOC CLO2, and CLO CNAM elements
and the CLO CADD composite are not mandatory, so they are dimmed on the
form. To view the segments, composites, and elements in a group, segment, or
composite on your form, double-click the form component in the EDI File Format
Window (left side of the Forms main window). To activate an inactive form
component, click Activate on the Main Toolbar, then click the form component. The
component is no longer dimmed.

Activating PO Groups, Segments, and Elements
You must activate ALL required groups, segments, composites, and elements.
Failure to do so will hinder your ability to perform steps later in this tutorial.

About this task

See the following sections for lists of required components:
v Purchase Order Components for ANSI X12
v Purchase Order Components for EDIFACT
v Purchase Order Components for TRADACOMS

These tables list all the groups, segments, and elements that you need to activate.
Opening all the necessary groups and segments before you start to activate enables
you to scroll down the form and activate the groups, segments, and elements
sequentially.
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When you activate a conditional group, segment, or composite, the mandatory
subordinate segments and elements are activated automatically.

Use this procedure to activate the required groups, segments, composites, and
elements.

Procedure
1. Click Activate on the Main Toolbar.
2. Click each inactive group that you need to use.
3. Click each inactive segment that you need to use.
4. Click each inactive composite that you need to use.
5. Click each inactive element that you need to use.
6. Click Activate on the Main Toolbar to turn activation mode off.
7. Select File > Save.

Verifying EDI Delimiters
About this task

Use this procedure to verify EDI delimiters.

Procedure
1. Right-click the purchase order file icon and select Properties to display the File

Format Properties dialog.
2. Select the Delimiters tag.
3. Verify that the correct delimiters are being used for the standard. If the

delimiters differ from the default values listed in EDI Delimiters , you can enter
either the character or the hexadecimal value in the correct box.

Note: If you use the default hex value, the value must begin with 0x .
4. Click OK to save the delimiters and exit the dialog.

Note: The Stream segments check box on the Delimiters dialog currently is not
selected. For this tutorial, leave it cleared so that the translator will continue to
insert a carriage return after every segment.

Form Generation
Generating a form is different from compiling a form. When you compile a form,
the source form is translated into a compiled translation object. When you generate
a form, the fields of the form are displayed on a frame in the Layout Window
(right side of Forms main window), based on the groups, segments, and elements
that are activated.

After you generate the form, there is one field on the right side of your screen
(Layout Window) for every activated element on the left side of your screen (EDI
File Format Window). You can click either the field or its corresponding element to
select it. To access the Element Properties dialogue for a field/element, either
double-click the element or right-click on the field or element and select Properties.

When the print form is generated, each group and repeating segment has a
corresponding frame in the Layout Window that contains all the groups, segments,
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and elements at that level. Fields in groups or segments that have a maximum use
of only one are displayed on the frame corresponding to the group to which the
groups or segments are subordinate.

In print forms, the frames are not titled in the Layout Window. To identify the
frame that currently is displayed, click one of the fields on the frame, then check
the EDI File Format Window to determine in which segment or group the field is
contained.

Generating the Print Form
About this task

Use this procedure to generate the print form based on the groups, segments, and
elements you activated.

Procedure
1. Select the purchase order file icon.

Note: Selecting the file icon before you generate the layout enables you to view
the beginning of the purchase order layout in the Layout Window after the
layout is generated. However, selecting the file icon is not a required
prerequisite to generating the layout.

2. Click Generate Layout on the Main Toolbar.
The layout of the print form is displayed in the Layout Window.

About Customizing EDI Data
You can customize the form, including the properties of each group, segment, and
element.

Customizing the form is an iterative process. This tutorial guides you through all
the steps involved in customizing the form, component by component. When you
create print forms, you usually activate the form components you need to use, then
compile the form, test it, and print the EDI data using the compiled translation
object. As you substantially customize the form, you may need to compile and
print the form several times to view your changes before the form truly is
finalized.

Finalize the Print Form

Compiling the PO Form
The Compile function compiles the form. The form that you create using Sterling
Gentran:Server is a source form. When that source form is compiled, the result is a
compiled translation object.

About this task

This translation object must be registered with the Sterling Gentran:Server system
before you can use it. Use the Compile function after the form is completed and
saved.

Use this procedure to compile the form.

Chapter 2. About Print Forms 35



Procedure
1. Select File > Compile to display the Run-Time Translation Object Name dialog.

Important: Do not to overlay the source form with the compiled translation
object. Use the .TPL file extension to distinguish the compiled translation object.

2. Click Save to accept the translation object name in the File name box.
The system compiles the form and generates an error report. The error report is
displayed in the Compile Errors dialog.

3. Click OK to exit the Compile Errors dialog.

Note: If the Compile Errors dialog contains errors, you must fix the problems
by redoing the appropriate section of the tutorial. Recompile the form after you
correct the errors and save the form.

4. Select Save from the File menu to save the form.

Printing the Report
The Sterling Gentran:Server report enables you to validate and review the
translation object, and make modifications as needed. If you review the report and
determine that the translation object is incorrect, you should reiterate the form
creation process as many times as necessary (make the modifications, save the
form, recompile the form, and print the report again).

About this task

Use this procedure to print the Sterling Gentran:Server report.

Procedure
1. Select Print from the File menu to access the Print Options dialog.
2. Click OK to accept the defaults on this dialog (all options checked), so the

report includes all sections and only the activated form components.
3. To change setup options (to select a specific printer, paper orientation, or size

and source of paper), click Properties and set the appropriate options.
4. Click OK to begin the print process.

Testing the PO Translation Object
Before you can use the print translation object, you must test the translation object
to verify that there are no errors in it. To test the translation object, you must have
a file containing test data.

About this task

The default path for the data file is C:\GENSRVNT\TUTORIAL. Refer to the IBM
Sterling Gentran:Server for Microsoft Windows User Guide for more information.

Use this procedure to test the print translation object you just created.

Procedure
1. Register the translation object with Sterling Gentran:Server.
2. Import the partner relationship into Sterling Gentran:Server.
3. Verify (in Partner Editor) that the correct print translation object is selected for

the Inbound Relationship.

36 IBM Sterling Gentran:Server for Windows: Forms Integration Tutorial for Print Forms



4. Use the Process File option in Sterling Gentran:Server to process the data file
through the translation object. The data file is located in the TUTORIAL subfolder
under the folder where Sterling Gentran:Server is installed.

5. After the document is translated, it is located in the In Documents in Sterling
Gentran:Server. Print the document to ensure that the document was translated
correctly and that the printout looks the way you want it to look.
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Chapter 3. Creating Print Forms for ANSI X12

Modifying the Maximum Use of the PO REF Segment
The REF segment contains Reference Numbers (for example, a contract number)
used in the EDI data. The standard allows the REF segment to be used up to
twelve times in one purchase order. In this tutorial, you expect the REF segment
only once from your trading partner, so you change the maximum number of
times this segment can be used to one.

About this task

Use this procedure to change the maximum use of the REF segment.

Procedure
1. Right-click the REF segment and select Properties.

The EDI Segment Properties dialog is displayed.
2. Select the Looping tab.
3. In the Max Usage box, enter 1 to indicate that this segment can be used only

once.
4. Click OK to exit the EDI Segment Properties dialog.

Inserting a New N4 Group
The N4 segment (in the N1 group) contains the Geographic Location of the entity
or individual named in the N1 segment.

About this task

If the form were generated now (displaying the layout of the fields in the form on
the right side of the Forms main window), the fields associated with the N4
segment would be located on the same frame as the fields associated with the N1
segment. (In a print form, each group and repeating segment has a corresponding
frame that contains all the groups, segments, and elements at that level.) The name
would be printed, then the city, state (or province), and postal code would be
printed, and then the street address would be printed. This print sequence would
not format the address in a standard address format.

To ensure that the city, state (or province), and postal code are printed after the
street address, and to maintain the integrity of the purchase order, you must create
an N4 group with a minimum use of zero and a maximum use of one. Then, cut
the N4 segment and paste it as a subordinate to the group you just created.
Making the N4 segment subordinate to the N4 group enables you to retain the N3
segment’s maximum use of two and to use the standard address format. The fields
associated with the N4 segment (city, state, and postal code) are displayed on a
separate frame, which is printed after the street address.

Use this procedure to add a new N4 group.
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Procedure
1. Select the N3 segment, which is the segment after which you want to insert

the group.
2. Select Edit > Insert > Group.

The Group Properties dialog is displayed.
3. In the Name box, enter NEW_N4 as the segment loop identification code.
4. In the Description box, enter NEW N4 to provide a brief explanation of the

loop.
5. Click OK to create the group.
6. Select the N4 segment.
7. Click Cut on the Main Toolbar.
8. Click Yes at the prompt.
9. Select the NEW_N4 group, which is the group for which you want to paste

the N4 segment as a subordinate.
10. Click Paste on the Main Toolbar to paste the N4 segment.
11. At the prompt, accept the default to paste the Clipboard contents as a child

(subordinate) of the group and click OK to exit the dialog.

Modifying the Maximum Use of the PID Group
If the form were generated now, the fields associated with the PID group (in the
PO1 group) would be displayed on a separate frame than the PO1 fields. The PID
and PO1 fields all relate to the same set of purchase order items, so all those fields
need to be displayed on the same frame. You change the maximum use of the PID
group from one thousand to one and set the Promote flag on the group. When you
generate the form later in this tutorial, the PID fields are displayed on the same
frame as the PO1 fields.

About this task

Use this procedure to change the maximum use of the PID group.

Procedure
1. Right-click the PID group and select Properties.
2. Select the Looping tab.
3. In the Max Usage box, enter 1 to indicate that this group can be used only

once.
4. Select the Print tab.
5. Click the Promote group to parent frame check box to display the fields in the

PID group on the same frame as the fields in the parent group (PO1 group).

Note: If you change the maximum use of this group but do not select Promote
group to parent frame, the fields in this group are not displayed on the same
frame in the Layout Window as the fields in the parent group.

6. Click OK to promote the group and exit the Group Properties dialog.
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Promoting the DTM:2 Segment
If the form were generated now, the date in the DTM:2 segment (in the PO1 group)
for the line item information would be printed on a separate frame than the rest of
the line item fields. You want the date to be placed on the same frame as the rest
of the line item information, so you need to promote the DTM:2 segment.

About this task

Your trading partner sends you two sets of dates: the requested date and the ship
date (in this order). The DTM:2 segment must occur twice in the form to
accommodate both sets of dates from your trading partner. To customize the
DTM:2 segment while preserving the integrity of the EDI structure, you must
promote the DTM:2 segment, then change the maximum use of the original DTM:2
segment to one so that it is no longer a repeating segment.

Use this procedure to promote the DTM:2 segment.

Procedure
1. Right-click the DTM:2 segment and select Promote to extract one iteration of

the DTM:2 segment and place it directly above the DTM:2 segment that you
selected to promote.
The new iteration of the DTM:2 segment is named DTM:4.

2. Right-click the DTM:4 segment and select Properties.
3. On the Looping tab, enter 0 in the Min Usage box to make this segment

conditional.
4. Click OK to exit the EDI Segment Properties dialog.
5. Right-click the DTM:2 segment and select Properties.
6. On the Looping tab, enter 1 in the Max Usage box to allow this segment to be

used only once.
7. Click OK to exit the EDI Segment Properties dialog.

Creating a CTT Group
The CTT segment is a mandatory segment that can display Transaction Totals for
the purchase order. If the form were generated now, the total number of line items
would be printed with the BEG fields at the beginning of the printout (because the
fields in the CTT segment are displayed on the same frame as the fields in the BEG
segment).

About this task

For the CTT segment to print the total number of line items at the end of the
printout and maintain the integrity of the purchase order, you must create a CTT
group with a minimum use and a maximum use of one, then cut the CTT segment
and paste it as a subordinate to the group you just created. By moving the CTT
segment to a new CTT group that you create, the total number of line items are
displayed on a frame that is separate from the header (BEG) information.

Use this procedure to create a CTT group.
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Procedure
1. Select the CTT segment.
2. Select Edit > Insert > Group.

The Group Properties dialog is displayed.
3. In the Name box, enter CTT_Group as the segment loop identification code.
4. In the Description box, enter CTT Group as the segment loop identification

code.
5. On the Looping tab, enter 1 in the Min Usage box to make this group

mandatory.
6. Click OK to create the group.
7. Select the CTT segment.
8. Click Cut on the Main Toolbar.
9. Select the CTT group, which is the group for which you want to paste the

CTT segment as a subordinate.
10. Click Paste on the Main Toolbar to paste the CTT segment.
11. Accept the default to paste the Clipboard contents as a child (subordinate) of

the group. Click OK to exit the dialog.
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Chapter 4. Modifying Form Components for ANSI X12

Setting up the Document Name for the Print Form
About this task

We recommend that you set up a Document Name for each form. The document
name makes the identification of a document created by the form easier in Sterling
Gentran:Server. Setting up the document name enables you to differentiate
between documents in the document browsers. If you set up the document name
in the Forms Integration subsystem, the Name field of the document browsers that
contain this document in Sterling Gentran:Server contains the data from that
element. You can choose any element as the document name, but we strongly
recommend that you select an element that occurs only once in the document and
has a data type of string. For an ANSI X12 850 purchase order, the document name
usually is the Purchase Order Number. For an EDIFACT 92.1 purchase order, the
document name usually is the Document/Message Number. For a TRADACOMS
ANA001 ORDERS release 9 purchase order, the document name usually is the
Customer’s Order Number.

Use this procedure to set up the document name.

Procedure
1. Double-click one of the following elements:

v BEG03 (ANSI X12)
v BGM05 (EDIFACT)
v ORD ORNO ORN0 (TRADACOMS)
We recommend that you select this element because it is a non-recurring,
mandatory element.
The Element Properties dialog is displayed.

2. Select the Standard Rule tab.
3. Select the Update from the standard rule list.
4. Click Yes at the prompt.
5. From the Select the table (or group) to update list, select Document record.
6. From the Column (or field) to update list, select Document Name to indicate

that you are updating the Name field in the document browsers with the
contents of the element.

7. Click OK to set up the document name.

The BEG Segment

Customizing the BEG01 Element
The BEG segment contains the Beginning Segment for the purchase order. This
segment uses four mandatory elements: Transaction Set Purpose Code, Purchase
Order Type Code, Purchase Order Number, and Purchase Order Date. Each of
these elements contains information that is pertinent to the entire purchase order.
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About this task

The BEG01 element (Transaction Set Purpose Code) is a mandatory element for the
ANSI X12 850 purchase order. You do not need to print the code on the printout,
so you prevent (hide) the Transaction Set Purpose Code field from being printed.

Use this procedure to prevent the Transaction Set Purpose Code field from being
printed.

Procedure
1. Double-click the BEG01 element.

The Element Properties dialog is displayed.
2. Select the Print tab.
3. Clear the Include in print check box to turn the option off.
4. Click OK to exit the dialog.

Customizing the BEG02 Element
The BEG02 element (Purchase Order Type Code) also is a mandatory element for
the ANSI X12 850 purchase order. This element contains the two-character code
from your partner’s EDI data representing the type of purchase order (for example,
new order or order change) for this document. You want the more meaningful
description of the code to be printed, instead of the code itself. Therefore, you hide
the Purchase Order Type Code field, but use the code from that element (BEG02)
to look up the code description in the Purchase Order Type Code table and print
that description in another field that you create. The description of the code is
displayed in the new field on the printout.

About this task

For this tutorial, you and your trading partner have agreed that they send you
these two types of purchase orders:
v New orders (Purchase Order Type Code "NE")
v Purchase order changes (Purchase Order Type Code "CP")

The description of the EDI code in the BEG02 element is important, even though
you do not need to print the code itself. For example, the EDI code value "NE" is
not descriptive enough for users reading a printout of the purchase order. The
description of code "NE" ("New Order") is meaningful, however.

Before you can print the description of the EDI code value, you must create a new
element in the BEG segment to store and print the description. The new BEG
element is the element that displays the description of the Purchase Order Type
Code. You use the Copy and Paste functions to move EDI information in the form.
Copied form components retain all the information of the original form
components.

Complete the following steps to copy and paste the BEG02 element.

Procedure
1. Select the BEG02 element.
2. Click Copy on the Main Toolbar.
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3. Select the BEG08 element, which is the last element in the BEG segment. The
BEG08 element is the element after which you want the BEG02 element to be
pasted.

4. Click Paste on the Main Toolbar to paste the BEG02 element.
A new element (BEG09) is created. The BEG09 element is an exact copy of the
BEG02 element.

Changing the BEG09 Element and Field Properties
The system names the new element created from copying the BEG02 element
0092:2. You rename the new element to identify its purpose, which is to print the
description of the code from the BEG02 element.

About this task

You remove the Mandatory status from the BEG09 element to make it a conditional
element (this element is used only if there is EDI data available for it), and increase
its length to accommodate the longer description.

Also, you need to change the field label corresponding to the newly-created BEG09
element to reflect the contents of the field (the description of the Purchase Order
Type Code). Also, you increase the display length of the field to accommodate the
longer description.

Use this procedure to change the element name and length, make the element
conditional, and change the field label and field length for the BEG09 element.

Procedure
1. Double-click the BEG09 element.
2. In the Name box, enter 0092_DESC to give the element a more descriptive

identifier.
3. Select the Validation tab.
4. Click the Mandatory check box to make the element conditional.
5. Enter 0 in the Min box and 30 in the Max box to define the range of characters

allowed for this element.
6. Click the Print tab.
7. In the Label box, enter Order Type: to replace the existing text.
8. In the Maximum number of characters to print box, enter 30 to allow a

thirty-character description to be displayed on the printout.
9. Click OK to save the new label and exit the dialog.

Hiding the BEG02 Field and Loading a Code List Table from
the Standard

Now that you have created an exact copy of the BEG02 element to retain all of the
EDI data and formatting associated with that element, you can hide the first
Purchase Order Type Code field.

About this task

When you use code list tables, you load a code list table from the standard to tell
the system which code list table to use in looking up EDI code values. You can
load the specific code values you expect to receive in the EDI data, or you can load
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the entire code list table. For this tutorial, you know that your trading partner
sends you only two types of purchase orders:
v New orders (Purchase Order Type Code "NE")
v Purchase order changes (Purchase Order Type Code "CP")

You do not need to load the entire code list table, so you load only codes "NE" and
"CP" from the Purchase Order Code List table.)

Use this procedure to hide the Purchase Order Type Code field and load the code
list table from the standard.

Procedure
1. Double-click the BEG02 element. You need to use a code list table for this

element.
2. On the Print tab, clear the Include in print check box to turn the option off.
3. On the Standard Rule tab, click the Use Code option from the "Please select a

standard rule to use" list. Click Yes at the prompt.
4. Click Edit to access the Edit Code List dialog.

The Table ID box contains 0092, the name of the element for which this code
list table is used. The Desc box contains PURCHASE ORDER TYPE CODE,
the description of the element for which this code list table is used.

5. Click Load to access the Load Code List dialog. The Codes In Standard list
contains the entire code list table. you are prompted to select an ODBC data
source name. Select the appropriate DSN and click OK to access the Load
Code List dialog.

6. From the "Codes In Standard" list, highlight code CP and click Add to move it
to the Codes Selected list. Then, highlight code NE and click Add.

7. Click OK to load the code list table and exit the Load Code List dialog.
8. Click Close to exit the Edit Code List dialog.
9. From the Store Field list, select 0092_DESC PURCHASE ORDER TYPE

CODE to store the description in the BEG09 element you created.
10. Click OK to exit the dialog.

Customizing the BEG03 Element
The BEG03 element is a mandatory element that contains the Purchase Order
Number. This element is defined by the standard to be a string of twenty-two
alphanumeric characters. Your trading partner’s purchase order number is always
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a ten-character alphanumeric string, so you change the element and field lengths to
accommodate the shorter purchase order number. In addition, you rename the field
label.

About this task

Use this procedure to change the field and element lengths, as well as the field
label, for the Purchase Order Number field.

Procedure
1. Double-click the BEG03 element.
2. On the Validation tab, enter 10 in the Max box to allow a ten-character string

in this element.
3. Select the Print tab. .
4. In the Label box, enter Order Number: to replace the existing text.
5. In the Maximum number of characters to be printed box, enter 10 to allow a

ten-character purchase order number to be displayed on the printout.
6. Click OK to exit the dialog.

Customizing the BEG05 Element
The BEG05 element is a mandatory element in the header (BEG) segment of the
purchase order that contains the Purchase Order Date. The EDI data from your
trading partner is formatted as YYMMDD, but you want to format the date as
MM/DD/YY on the printout. In addition, you rename the field label.

About this task

Use this procedure to change the date format and the field label for the Purchase
Order Date field.

Procedure
1. Double-click the BEG05 element.
2. On the Validation tab, enter 8 in the Max box to allow the entire date

(including the / separators) to be contained in this element.
3. From the Form Format list, select MM/DD/YY to designate the format for the

date on the printout.
4. Verify that YYMMDD is selected in the File Format list to designate the format

for the date in the EDI data.
5. Select the Print tab.
6. In the Label box, enter Order Date: to replace the existing text.
7. In the Maximum number of characters box, enter 8 to allow the entire date

(including the / separators) to be contained in this element.
8. Click OK to exit the dialog.
9. Click Generate Layout on the Main Toolbar to refresh the display of the print

form.
The purchase order frame now should look like this:
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Customizing the NTE Segment
Your trading partner sends you messages or notes after the purchase order header
information, so the NTE segment should be present to receive each message. The
standard allows the NTE segment to be used up to one hundred times in one
purchase order.

About this task

The NTE02 element is a mandatory element that contains the exact message that
should be printed. Because the message is self-explanatory, you do not need to
print the label for this field. The only customizing that is necessary for the NTE02
element is to remove the field label from the form.

Use this procedure to hide the Free Form Message field label.

Procedure
1. Double-click the NTE02 element.
2. On the Print tab, delete the text in the Label box.
3. Click OK to exit the dialog.
4. Click Generate Layout on the Main Toolbar to refresh the display of the print

form.

The REF Segment

Customizing the PO REF01 Element
The REF segment contains Reference Numbers used in the EDI data. In this
tutorial, you know that the only reference number your partner sends you in the
REF segment is a contract number that your trading partner uses for their records.
Although the standard allows the REF segment to be used up to twelve times in
one purchase order, you expect the REF segment only once from your trading
partner. You already changed the maximum use of this segment to one.

About this task

The REF01 element (Reference Number Qualifier) is a mandatory element for the
REF segment. The REF01 element contains the two-character code from your
partner’s EDI data to indicate what type of reference number follows. For this
tutorial, you know that your trading partner sends you only one type of reference
number—the contract number ("CN"). The system does not enable you to
deactivate this element, because it is a mandatory element. However, since you
expect only one code in this element, you do not need to print the code on the
report. Therefore, you hide the Reference Number Qualifier field.

Use this procedure to hide the Reference Number Qualifier field.
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Procedure
1. Double-click the REF01 element.
2. On the Print tab, clear the Include in print check box to turn the option off.
3. Click OK to exit the dialog.

Customizing the PO REF02 Element
The REF02 element is a mandatory element that contains the Reference Number.
This element is defined by the standard to be a string of thirty alphanumeric
characters. In this tutorial, you know that your trading partner’s reference number
(the contract number) is always a twelve-character alphanumeric string, so you
change the field and element lengths to accommodate the reference number that is
shorter than the standard allows. In addition, you rename the field label.

About this task

Use this procedure to change the field and element lengths, and to change the field
label, for the Reference Number field.

Procedure
1. Double-click the REF02 element.
2. On the Validation tab, enter 12 in the Max boxto allow a twelve-character

string in this element.
3. Select the Print tab.
4. In the Label box, enter Contract No. (note the period in the label) to replace the

existing text.
5. In the Maximum number of characters box, enter 12 to allow twelve characters

to be displayed on the printout.
6. Click OK to exit the dialog.
7. Click Generate Layout on the Main Toolbar to refresh the display of the print

form.

The ITD Segment
The ITD segment is a conditional segment that specifies the Terms of
Sale/Deferred Terms of Sale for the purchase order. In this tutorial, you already
activated the ITD01 and ITD12 elements for the Terms Type Code and Description,
respectively. The standard specifies that the ITD segment can be used up to five
times in one purchase order. Since this is a conditional segment, if the ITD segment
is not used at all in a purchase order (data is not present), the fields are not
printed.

The ITD12 element contains the terms of the purchase order. The description of the
code in the ITD01 element explains the data in the ITD12 element, so you hide the
field label for the ITD12 element.

The ITD01 element contains the Terms Type Code, a two-character code that
identifies the terms under which this purchase order is valid. The code itself is not
meaningful for a printout, so you hide the ITD01 element and print the description
of the code in a new element that you create.

To print the description of an EDI code value, you must copy the ITD01 element to
a new element in the ITD segment, then use the new ITD element to print the
description of the Terms Type Code.
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Copying the ITD01 Element
About this task

Use this procedure to copy and paste the ITD01 element.

Procedure
1. Select the ITD01 element.
2. Click Copy on the Main Toolbar.
3. Select the ITD15 element, which is the last element in the ITD segment. The

ITD15 element is the element after which you want the copied element to be
pasted.

4. Click Paste on the Main Toolbar to paste the new element. A new element
(ITD16) is created, which is an exact copy of the ITD01 element.

Changing the ITD16 Element and Field Properties
The system names the new element created from copying the ITD01 element
0336:3. You rename the new element to identify its purpose, which is to print the
description of the code from the ITD01 element. Also, you increase the element
and field lengths to accommodate the longer description.

About this task

Use this procedure to change the element name and length and change the field
label and length for the ITD16 element.

Procedure
1. Double-click the ITD16 element.
2. In the Name box, enter 0336_DESC to give the name a more descriptive

identifier than its current name.
3. On the Validation tab, enter 0 in the Min box and 30 in the Max box to define

the range of characters for this element.
4. Select the Print tab.
5. In the Label box, delete the existing text. The description of the terms type code

is self-explanatory and does not require a label.
6. In the Maximum number of characters box, enter 30 to allow thirty characters

to be displayed on the printout.
7. Click OK to exit the dialog.

Hiding the ITD01 Field and Loading the Code List Table from
the Standard

Now that you have created an exact copy of the ITD01 element to retain all of the
EDI data and formatting associated with that element, you can hide the first Terms
Type Code field.

About this task

For this tutorial, you know that your trading partner sends you purchase orders
with these two term types:
v Previously agreed upon (Terms Type Code "14")
v Payment due upon (Terms Type Code "23")
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You do not need to load the entire code list table, so you load only codes "14" and
"23" from the Terms Type Code list table.

Use this procedure to hide the first Terms Type Code field and load the code list
table from the standard.

Procedure
1. Double-click the ITD01 element. You need to use a code list table for this

element.
2. On the Print tab, clear the Include in print check box to turn the option off.
3. On the Standard Rule tab, click the Use Code option and click Yes at the

prompt.
4. Click Edit to access the Edit Code List dialog.

Note: The Table ID box contains 0336, the name of the element for which this
code list table is used. The Desc box contains TERMS TYPE CODE, the
description of the element for which this code list table is used.

5. Click Load to access the Load Code List dialog.
You are prompted to select an ODBC data source name.

6. Select the appropriate DSN and click OK to access the Load Code List dialog.
The Codes In Standard list contains the entire code list table.

7. From the Codes In Standard list, highlight code 14 and click Add to move it
to the Codes Selected list. Then, highlight code 23 and click Add.

8. Click OK to load the code list table and exit the Load Code List dialog.
9. Click Close to exit the Edit Code List dialog.

10. From the Store Field list, select 0336_DESC TERMS TYPE CODE to store the
code in the ITD16 element you created.

11. Click OK to exit the dialog.

Customizing the ITD12 Element
The ITD12 element contains the exact terms of the purchase order. The terms are
explained by the description of the Terms Type Code, so there is no need to print
the label associated with the message. Therefore, you hide the field label for the
ITD12 element on the printout.

About this task

Use this procedure to hide the Description field label.

Procedure
1. Double-click the ITD12 element.
2. On the Print tab, delete the text in the Label box.
3. Click OK to exit the dialog.
4. Click Generate Layout on the Main Toolbar to refresh the display of the print

form.
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The N1 Group
The standard allows the N1 group to be used up to two hundred times. In the N1
group, you already activated the N1, N3, and N4 segments to provide the name
and address of an entity or individual.

Your trading partner uses three types of addresses:
v Bill to name and address
v Ship to name and address
v Buying party name and address

You already inserted an N4 group and moved the N4 segment to be subordinate to
the N4 group (so that the city, state or province code, and postal code are printed
after the address information). The fields for the N1, N3, and N4 segments are
displayed on three frames, like the following. (Your frames may be larger than the
ones shown below.)

After customization

After you customize the N1, N3, and N4 segments, the fields still are displayed on
three frames. The frames are printed in order, so that the name is printed first;
then the address (one to four lines of address information); then the city, state, and
postal code. The address is formatted the way you expect an address to be
formatted. After you customize and format the N1 group, the address fields (on
three frames) should look like these:

The N1 Segment
The N1 segment identifies the Name of the entity or individual. When the N1
segment is used, the N101 element is mandatory. The N101 element contains the
two-character Entity Identifier Code.

You want the more meaningful description of the code to be printed on the
printout, instead of the code itself.
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The N102 element is a conditional element that identifies the name of the entity or
individual. You hide the field label for this field, since the the name is
self-explanatory.

For this tutorial, you know that your trading partner sends you these types of
names and addresses:
v Bill to name and address (Entity Identifier Code "BT")
v Ship to name and address (Entity Identifier Code "ST")
v Buying party name and address (Entity Identifier Code "BY")

Copying the N101 Element
About this task

Use this procedure to copy and paste the N101 element.

Procedure
1. Select the N101 element.
2. Click Copy on the Main Toolbar.
3. Select the N106 element, which is the last element in the N1 segment. The N106

element is the element after which you want the N101 element to be pasted.
4. Click Paste on the Main Toolbar to paste the new element.

A new element (N107) is created, which is an exact copy of the N101 element.

Changing the N107 Element and Field Properties
The system names the new element created from copying the N101 element 0098:3.
You rename the new element to identify its purpose, which is to print the
description of the code from the N101 element. You also remove the Mandatory
status from the N107 element to make it a conditional element (the element is used
only if there is EDI data available for it) and increase the element and field lengths
to accommodate the code description.

About this task

Use this procedure to change the element name and length, make the element
conditional instead of mandatory, and change the field label and field length for
the N107 element.

Procedure
1. Double-click the N107 element.
2. In the Name box, enter 0098_DESC to give the element a more descriptive

identifier.
3. Select the Validation tab.
4. Clear the Mandatory check box to make the element conditional.
5. Enter 0 in the Min box and 30 in the Max box.
6. Select the Print tab.
7. In the Label box, delete the existing text.
8. In the Maximum number of characters box, enter 30.
9. Click OK to exit the dialog.
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Hiding the N101 Field and Loading the Code List Table from
the Standard

Now that you have created an exact copy of the N101 element in order to retain all
of the EDI data and formatting associated with that element, you can hide the first
Entity Identifier Code field.

About this task

For this tutorial, you know that your trading partner sends you the following
types of names and addresses:
v Bill to name and address (Entity Identifier Code "BT")
v Ship to name and address (Entity Identifier Code "ST")
v Buying party name and address (Entity Identifier Code "BY"

You do not need to load the entire code list table, so you load only codes BT, ST,
and BY from the Entity Identifier Code table.

Use this procedure to hide the first Entity Identifier Code field and load the code
list table from the standard.

Procedure
1. Double-click the N101 element. You need to use a code list table for this

element.
2. On the Print tab, clear the Include this field in the print check box.
3. On the Standard Rule tab, click the Use Code option and click Yes at the

prompt.
4. Click Edit to access the Edit Code List dialog.

The Table ID box contains 0098, the name of the element for which this code
list table is used. The Desc box contains ENTITY IDENTIFIER CODE, the
description of the element for which this code list table is used.

5. Click Load.
You are prompted to select an ODBC data source name.

6. Select the appropriate DSN and click OK to access the Load Code List dialog.
The Codes In Standard list contains the entire code list table.

7. From the Codes In Standard list, highlight code BT and click Add to move it
to the Codes Selected list. Highlight code BY and click Add. Highlight code
ST and click Add.

8. Click OK to load the code list table and exit the Load Code List dialog.
9. Click Close to exit the Edit Code List dialog.

10. From the Store Field list, select 0098_DESC ENTITY IDENTIFIER CODE to
store the code in the N107 element you created.

11. Click OK to exit the Element Properties dialog.

Customizing the N102 Element
The N102 element contains the exact name that should be printed. The name is
explained by the description of the Entity Identifier Code, so you do not need to
print the label associated with the name. The only customizing that is necessary for
the N102 element is to hide the field label on the printout.
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About this task

Use this procedure to hide the Name field label.

Procedure
1. Double-click the N102 element.
2. On the Print tab, delete the text in the Label box.
3. Click OK to exit the dialog.

Customizing the N3 Segment
The N3 segment contains the Address of the entity or individual named in the N1
segment. If the N3 segment is used, the N301 element is mandatory. The N301
element contains address information, which identifies the street name, suite
number, or any other address information that your trading partner sends you.
This element does not contain the city, state/province, or postal code; that data is
contained in the N4 segment. You already activated the N302 element, which is a
conditional element that contains an additional line of address information (if it is
received).

About this task

The N301 and N302 elements contain the exact address information that should be
printed. The address information corresponds to the name that is printed from the
N101 element. Therefore, there is no need to print the labels associated with the
address information, so you hide the field labels for the N301 and N302 elements.

Use this procedure to hide the Address Information field label.

Procedure
1. Double-click the N301 element.
2. On the Print tab, delete the text in the Label box.
3. Click OK to exit the dialog.
4. Double-click the N302 element.
5. On the Print tab, delete the text in the Label box.
6. Click OK to exit the dialog.

Customizing the N4 Segment
The N4 segment (in the NEW_N4 group in the N1 group) contains the Geographic
Location of the entity or individual named in the N1 segment. The N4 segment is
not a mandatory segment. The N401 element contains the name of the city, the
N402 element contains the code for the state or province, and the N403 element
contains the postal code.

About this task

There is no need to print the labels associated with the geographic location,
because it is evident on the printout that the name, address, and geographic
location are associated. Therefore, you hide the field labels for the N401, N402, and
N403 elements.

Use this procedure to hide the field labels.
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Procedure
1. To hide the City Name field label, double-click the N401 element.
2. On the Print tab, delete the text in the Label box.
3. Click OK to exit the dialog.
4. To hide the State or Province Code field label, double-click the N402 element.
5. On the Print tab, delete the text in the Label box.
6. Click OK to exit the dialog.
7. To hide the Postal Code field label, double-click the N403 element.
8. On the Print tab, delete the text in the Label box.
9. Click OK to exit the dialog.

10. Click Generate Layout on the Main Toolbar to refresh the display of the print
form.

Results

The N1, N3, and N4 frames now should look like these (your frames may be larger
than the ones shown below:

The PO1 Group
The standard allows the PO1 group to be used up to one hundred thousand times,
containing up to one hundred thousand line items in one purchase order. You
already activated these segments and group in the PO1 group: PO1 segment, PID
group, DTM:4 segment, and DTM:2 segment.
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Before customizing

Before you customize the group, segments, and elements in the PO1 group, the
fields in the form are arranged with one field on a line, like the following:

If the frames were not customized and formatted differently, then each set of fields
would be repeated for each item ordered. A more efficient and traditional way of
listing items on a purchase order is to arrange the related information in columns,
so all the related information for one item is listed on one or two lines. The
column headings are printed only once.

After customizing

The following figure shows how you ultimately want the fields in the PO1 group
to be arranged (after customizing and then formatting the fields).

The PO1 Segment

Customizing the PO101 Element
The PO1 segment (in the PO1 group) contains the Baseline Item Data that
identifies the details of the items on the purchase order. You assign new labels for
each of the fields in the PO1 segment to identify more specifically the information
your partner sends you. You then change the maximum lengths for some of the
fields, and print the description of the Product/Service ID Qualifier.
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About this task

The PO101 element contains the Assigned Identification for one item on the
purchase order. Assigned Identification is a general term; you and your trading
partner have agreed to call this identification a line number. You change the label
for this field to reflect the new field name. You and your trading partner also have
agreed that there are no more than 99,999 line items per purchase order. Since each
line item is numbered sequentially, starting with one, you need a maximum length
of only five digits for this field. You change the maximum length for this field to
five.

Use this procedure to change the element and field lengths, field label, and field
length for the Assigned Identification field.

Procedure
1. Double-click the PO101 element.
2. On the Validation tab, enter 5 in the Max box to allow a five-character string in

this element.
3. Select the Print tab.
4. In the Label box, enter Line to replace the existing text.

Note: The label for the Assigned Identification field ultimately forms the
column heading "Line No." To make the width of the column heading as
narrow as possible, you place "Line" on one line and "No." below. The Label
box does not enable you to enter a label on more than one line, so you enter
"Line" in the Label box, then add "No." by adding static text later in this
tutorial.

5. In the Maximum number of characters box, enter 5 to allow five numeric digits
to be displayed on the printout.

6. Click OK to exit the dialog.

Customizing the PO102 Element
The PO102 element contains the Quantity Ordered for one item on the purchase
order. For brevity on the printout, you rename the field label. The standard allows
up to a nine-digit number in this field. You know that your trading partner orders
no more than 99,999 (a five-digit number) of any one item, so you change the
maximum length to six for this field (for a five-digit number and a place separator)
and change the value in the Screen Format and EDI Format lists to "N0" (for a
number with an implied decimal point and no decimal places).

About this task

Use this procedure to change the element length, field label, and field length for
the Quantity Ordered field.

Procedure
1. Double-click the PO102 element.
2. Select the Validation tab.
3. In the Max box, enter 6 to allow a five-digit number and a place separator in

this element.
4. From the Form Format list, select N0 to allow a number with an implicit

decimal point and no decimal places to be displayed on the printout.
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5. From the File Format list, select N0 to indicate that you expect a number with
an implied decimal point and no decimal places in the EDI data.

6. Select the Print tab.
7. In the Label box, enter Qty to replace the existing text.
8. In the Maximum number of characters box, enter 6 to allow a five-digit number

and a place separator to be displayed on the printout.
9. Click OK to exit the dialog.

Customizing the PO103 Element
The PO103 element contains the Unit or Basis for Measurement Code for each item
on the purchase order. For brevity on the printout, you rename the field label.

About this task

Use this procedure to change the field label of the Unit or Basis for Measurement
Code field.

Procedure
1. Double-click the PO103 element.
2. On the Print tab, enter Unit in the Label box to replace the existing text.
3. Click OK to exit the dialog.

Customizing the PO104 Element
The PO104 element contains the Unit Price for each item on the purchase order.
For this tutorial, you rename the field label.

About this task

The standard designates an EDI format of "R9" for the Unit Price field, meaning
that the price is formatted with an explicit decimal point and up to nine decimal
places. Your trading partner sends you EDI data for the price in "R2" format, and
this is also the format you want to use to display the price on the printout (for
example, "100.00" instead of "100.000000000"). You change the number formats in
the Screen Format and EDI Format fields for this element to reflect the number
formats you use.

The standard defines this element as having a maximum length of fourteen, but
the items you sell to Pet Zone are not priced at more than $9,999.99 each, so this
field needs a maximum length of only eight (four places for the dollars; two places
for the cents; one place for the decimal point; and one place for a plus or minus
sign, if present).

Use this procedure to change the element and field lengths, field label, and
number formats for the Unit Price field.

Procedure
1. Double-click the PO104 element.
2. Select the Validation tab.
3. In the Max box, enter 8 to allow eight numeric digits in this field, including a

plus or minus sign and a decimal point.
4. From the Form Format list, select R2 to allow a number with an explicit

decimal point and four decimal places to be displayed on the printout.
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5. Click Yes at the prompt.
6. From the File Format list, select R2 to indicate that you expect a number with

an implicit decimal point and no decimal places.
7. Click Yes at the prompt.
8. Select the Print tab.
9. In the Label box, enter Price to replace the existing text.

10. In the Maximum number of characters box, enter 8.
11. Click OK to exit the dialog.

Customizing the PO106 Element
The PO106 element contains the Product/Service ID Qualifier for each item on the
purchase order. For this tutorial, Pet Zone sends you one of these two types of
product codes: VN (Vendor) or UP (UPC Code). For brevity on the printout, you
rename the field label.

About this task

Use this procedure to change the field label for the Product/Service ID Qualifier
field.

Procedure
1. Double-click the PO106 element.
2. On the Print tab, enter Code in the Label box.
3. Click OK to exit the Element Properties dialog.

Customizing the PO107 Element
The PO107 element contains the Product/Service ID for one item on the purchase
order. For brevity on the printout, you change the field label to "Prod ID." The
standard allows up to a thirty-character string in this field. Your trading partner
uses product identification numbers that are no longer than ten characters, so you
change the maximum length for this field to ten.

About this task

Use this procedure to change the field and element lengths and the field label for
the Product/Service ID field.

Procedure
1. Double-click the PO107 element.
2. On the Validation tab, enter 10 in the Max box for the maximum number of

characters allowed for this element.
3. Select the Print tab.
4. In the Label box, enter Prod ID to replace the existing text.
5. In the Maximum number of characters box, enter 10 to allow a ten-character

string to be displayed on the printout.
6. Click OK to exit the dialog.
7. Click Generate Layout on the Main Toolbar to refresh the display of the print

form.
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Results

The PO1 frame now should look like this:

Customizing the PID Group
The PID group contains the item description. The standard allows the PID group
to be used up to one thousand times for each line item, but you need the PID
group to be used only once for each line item. You already changed the maximum
use of the PID group to one and promoted the group to the parent frame.

About this task

The PID:201 element (in the PID:2 segment in the PID group) contains the Item
Description Type ("F" for free-form item description, "S" for structured description,
or "X" for semi-structured). This element must be present, because you expect this
data from your trading partner. However, you can hide this field, since the
meaningful information for a print is the description itself, not the type of
description.

The PID:205 element (in the PID:2 segment in the PID group) contains the
Description of the purchase order item. The description is self-explanatory, so there
is no need to print the field label associated with the message.

Use this procedure to customize the PID group.

Procedure
1. To hide the Item Description Type field label, double-click the PID:201 element.
2. On the Print tab, clear the Include fields in the print check box.
3. Click OK to exit the dialog.
4. To hide the Description field label, double-click the PID:205 element.
5. On the Print tab, delete the text in the Label box.
6. Click OK to exit the dialog.
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Results

The PO1 frame now should look like this:

The DTM:4 Segment
The DTM:4 segment (in the PO1 group) is used to print the requested ship date. To
ensure that Sterling Gentran:Server prints the correct date in the Date field, you
must use the key field function. The key field function enables you to specify a
second qualification in selecting a segment (the segment name is the first
qualification). Data must be provided in the order designated through the use of
key fields. For example, for this tutorial, you expect the requested ship date
(DTM:4) first, and then the ship no later date (DTM:2).

Important: For this tutorial, the dates printed in the DTM:4 and DTM:2 segments
can be set up using key fields because you expect the dates in a particular order. If
the dates were sent in a different order, only one date would be printed. If you
were not sure of the order in which your partner sends the dates, you could not
use key fields. You would need to use three DTM segments (using the promote
function), and two of those DTM segments would need to be identical.

For this tutorial, when the Date/Time Qualifier field contains the value "010"
(Requested Ship), then the date is printed in the Date field of the DTM:4 segment.
If the Date/Time Qualifier field contains the value "038" (Ship No Later), then the
date is printed in the Date field of the DTM:2 segment.

Using a Key Field for the DTM:4 Segment
About this task

Use this procedure to use a key field for the DTM:4 segment.

Procedure
1. Right-click the DTM:4 segment and select Properties.
2. Select the Key Field tab.
3. From the Field list, select 0374:9 DATE/TIME QUALIFIER.

62 IBM Sterling Gentran:Server for Windows: Forms Integration Tutorial for Print Forms



4. Verify that the Use constant option is selected.
5. Click Edit to access the Map Constants dialog.
6. Click New to display the Edit Constant dialog.
7. In the ID box, enter Requested Ship to identify the unique literal constant.
8. From the Type list, select String.
9. In the Value box, enter 010 to identify the actual value of the constant.

10. Click OK to exit the Edit Constant dialog.
11. Click Close to exit the Map Constants dialog.
12. From the Use constant list, select 010 to indicate to the system that this date is

the requested ship date.
13. Click OK to exit the dialog.

Customizing the DTM:401 Element
The DTM:401 element (in the DTM:4 segment) contains the Date/Time Qualifier
for the date in the DTM:402 element. For this tutorial, your trading partner sends
you just two types of dates: the requested ship date and the ship no later date (in
that order). You used the key field function for the DTM:4 segment to indicate to
Sterling Gentran:Server that only the requested ship date is printed in the Date
field (DTM:402), so you can prevent the qualifier (DTM:401) from being printed.
The ship no later date is printed in the Date field for the DTM:2 segment.

About this task

Use this procedure to hide the Date/Time Qualifier field.

Procedure
1. Double-click the DTM:401 element.
2. On the Print tab, clear the Include fields in the print check box.
3. Click OK to exit the dialog.

Customizing the DTM:402 Element
The DTM:402 element contains the Date corresponding to the date qualifier in the
DTM:401 element. For this tutorial, the DTM:402 element is used to designate
when the shipment is requested.

About this task

In this section of the tutorial, you rename the label for this field (the new label is
named Requested). You add the words Ship Date later in this tutorial using static
text (static text is text that is always printed when the form is used, and that is not
defined in the field properties of the element) so that Ship Date is displayed on the
line below Requested. Therefore, the full field label is Requested Ship Date.

The EDI data from your trading partner is formatted as YYMMDD, but you format
the date as MM/DD/YY on the printout.

Use this procedure to change the element and field lengths, hide the Date field
label, and set the date format for the date on the printout.
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Procedure
1. Double-click the DTM:402 element.
2. Select the Validation tab.
3. In the Max box, enter 8 to allow the entire date (including the / separators) in

this element.
4. From the "Format of the data in the form" list, select MM/DD/YY to designate

the format for the date on the printout.
5. Verify that YYMMDD is selected in the "Format of the data in the file" list to

designate the format for the date in the EDI data.
6. Select the Print tab.
7. In the Label box, enter Requested to replace the existing text.

Note: The label for the Date field ultimately forms the column heading,
Requested Ship Date. To make the width of the column heading as narrow as
possible, you place "Requested" on one line and "Ship Date" below. The Label
box does not enable you to enter a label on more than one line, so you enter
"Requested" in the Label box, then add "Ship Date" by adding static text later in
this tutorial.

8. In the Maximum number of characters box, enter 8 to allow the entire date
(including the / separators) to be displayed on the printout.

9. Click OK to exit the dialog.

The DTM:2 Segment
The DTM:2 segment (in the PO1 group) is used to print the latest date that the
order can be shipped. To ensure that Sterling Gentran:Server prints the correct date
in the Date field, you must use the key field function. The key field function
enables you to specify a second qualification in selecting a segment. Data must be
provided in the order designated through the use of key fields. For example, for
this tutorial, you expect the requested ship date (DTM:4) first, and then the ship no
later date (DTM:2) second.

Important: For this tutorial, the dates printed in the DTM:4 and DTM:2 segments
can be set up using key fields because you expect the dates in a particular order. If
the dates were sent in a different order, then only one date would be printed. If
you were not sure of the order in which your partner sends the dates, then you
could not use key fields. You would need to use three DTM segments (using the
promote function), and two of those DTM segments would need to be identical.

For this tutorial, if the Date/Time qualifier field contains the value "010"
(Requested Ship), then the date is printed in the Date field of the DTM:4 segment.
If the Date/Time Qualifier field contains the value "038," then the date is printed in
the Date field of the DTM:2 segment.

Using a Key Field for the DTM:2 Segment
About this task

Use this procedure to use a key field for the DTM:2 segment.

Procedure
1. Right-click the DTM:2 segment and select Properties.
2. Select the Key Field tab.
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3. From the Field list, select 0374:6 DATE/TIME QUALIFIER.
4. Verify that the Use constant option is selected.
5. Click Edit to display the Map Constants dialog.
6. Click New to display the Edit Constant dialog.
7. In the ID box, enter Ship No Later to identify the literal constant.
8. From the Type list, select String.
9. In the Value box, enter 038 to identify the actual value of the constant.

10. Click OK to exit the Edit Constant dialog.
11. Click Close to exit the Map Constants dialog.
12. From the Use constant list, select 038 to indicate to the system that this date is

the Ship No Later date.
13. Click OK to exit the dialog.

Customizing the PO DTM:201 Element
The DTM:201 element (in the DTM:2 segment) contains the Date/Time Qualifier
for the date in the DTM:202 element. For this tutorial, your trading partner sends
you just two types of dates: the requested ship date and the ship no later date (in
that order). You used the key field function for the DTM:2 segment to indicate to
Sterling Gentran:Server that the ship no later date is printed in the DTM:202 field
(Date). The DTM:201 element must be present, but you can prevent this field from
being displayed, since the meaningful information for a printout is the date itself.

About this task

Use this procedure to hide the second Date/Time Qualifier field.

Procedure
1. Double-click the DTM:201 element.
2. On the Print tab, clear the Include fields in the print check box.
3. Click OK to exit the dialog.

Customizing the PO DTM:202 Element
The DTM:202 element contains the Date corresponding to the date qualifier in the
DTM:201 element. For this tutorial, the DTM:202 element is used to designate the
latest date that shipments should be shipped.

About this task

In this section of the tutorial, you rename the label for this field (the new label is
named Ship No). You add Later further in this tutorial using static text so that
Later is displayed on the line below Ship No. The full field label is Ship No Later.

The EDI data from your trading partner is formatted as YYMMDD, but you format
the date as MM/DD/YY on the printout.

Use this procedure to change the field and element lengths, hide the Date field
label, and set the date format for the date on the printout.

Procedure
1. Double-click the DTM:202 element.
2. Select the Validation tab.
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3. In the Max box, enter 8 to allow the entire date (including the / separators) in
this element.

4. From the "Format of the data in the form" list, select MM/DD/YY to designate
the format for the date on the printout.

5. Verify that YYMMDD is selected in the "Format of the data of the file" list to
designate the format for the date in the EDI data.

6. Select the Print tab.
7. In the Label box, enter Ship No to replace the existing text.
8. In the "Maximum number of characters" box, enter 8 to allow the entire date

(including the / separators) to be displayed on the printout.
9. Click OK to exit the dialog.

10. Click Generate Layout on the Main Toolbar to refresh the display.

Results

The PO1 frame now should look like this:

What to do next

Now you are ready to format the fields and their labels to make the frame more
consistent and visually attractive.
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Chapter 5. Formatting the Print Form for ANSI X12

About Formatting the Print Form
In the previous section of this tutorial, you customized the print form for a
purchase order that you will use to print the data you receive from Pet Zone. After
successfully customizing the fields and elements of the print form, you are ready
to format the layout of the form.

One form can consist of several frames. Each group and repeating segment has a
corresponding frame that contains all the groups, segments, and elements at that
level. When the form is printed, the frames are printed consecutively, in the order
in which they occur in the form. Each frame is not printed on a separate page.

Resizing the Header Frame
When a printout is produced based on the customized print form, the information
is arranged according to how the frames and the fields contained in them were
arranged when the form was compiled. You should eliminate unnecessary space as
you arrange the fields on each frame.

About this task

Use this procedure to resize the header frame.

Procedure
1. Click one of the following segments segment to display the Beginning Segment

for Purchase Order (header) frame in the Layout Window.
v BEG (for ANSI X12)
v BGM (for EDIFACT)
v ORDHDR (for TRADACOMS)

2. To display more of the form on your screen, click and drag the center bar
between the EDI File Format Window and the Layout Window to the left until
the Layout Window is wide enough to display as much of the form as you
want.

3. To resize the header frame, click and drag the right side of the frame
approximately to the 20 cm. mark on the horizontal ruler (a form with a width
of 20 cm. can be printed on an 8 1/2" x 11" or A4 sheet of paper).

Adding a Title to the Form
You want the form to have a title designating the standard agency, version, type of
document/message, and the trading partner for which this form is used. You add
a title to the print form by adding static text.

About this task

Use this procedure to add and position the title for the form and center it.

© Copyright IBM Corp. 1996, 2012 67



Procedure
1. Select all the fields and field labels on the frame. Drag your selection

approximately two or three centimeters lower on the frame to make room at
the top of the frame for the title.

2. Click Add Text on the Main Toolbar.
A text box is added to the current frame, displayed in the upper left corner of
the frame.

3. In the new selected text box, enter one of the following and click OK.
v ANSI X12 3040 Purchase Order

v EDIFACT 92.1 Purchase Order

v TRADACOMS ANA001 ORDERS Release 9

4. Click Add Text on the Main Toolbar. Enter Pet Zone and click OK.
5. Click and drag the first line of static text so that the text is centered on the first

line of the frame.
6. Click and drag the second line of static text (Pet Zone) so that the text is

centered on the second line of the frame.

Results

The header frame should look similar to the following. (This is an ANSI X12
example; some details may be different for EDIFACT and TRADACOMS.)

Header Fields
By default, each field and its associated label are printed on their own line.
However, it is common for purchase orders and forms to arrange some fields in
columns of information.

The first fields you will rearrange are the header fields. For ANSI X12, these fields
are associated with the BEG and REF segments. For EDIFACT, these fields are
associated with the BGM, DTM, and FTX segments, and the RFF and PAT groups.
For TRADACOMS, these fields are associated with the ORDHDR group and the
CLO, ORD, and DIN segments.

You prevented some of the field labels from being printed (by removing the field
label in the Label box of the Print dialog). For these fields, the fields are displayed
on your print form, but their associated labels are not.

Resizing the Header Fields
When you customized the element properties in the previous section of this
tutorial, you changed the display lengths for some of the fields on the header
frame. The fields that are displayed in the Layout Window currently reflect the
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default display lengths for the fields. To reflect the new sizes of the fields in the
Layout Window, you must select the fields for which you changed the display
lengths, then resize the fields.

About this task

Use this procedure to resize the fields on the header frame.

Procedure
1. Select all the fields on the header frame. (For TRADACOMS, these are the

Latest Delivery Date and Order Date fields.)
2. Select Display > Size to Length. The selected fields are resized to the lengths

specified in the Maximum number of characters box of the Print dialog for each
field.

Moving Header Fields and Labels - ANSI X12
About this task

Use this procedure to move and align the fields and labels on the header frame.

Procedure
1. Select each field individually and drag it closer to its respective field label.

Important: Do not move fields that are not labeled.
2. Drag the Order Date label and field to the right of the Order Number label

and field (at approximately 11.5 cm.).
3. Drag the Order Type label and field below the Order Number label and field.
4. Drag the Contract No. label and field below the Order Date label and field.
5. Select the Order Number and Order Type labels. Then select Display > Align

Controls > Left. The left margins of the Order Type and Order Number labels
are aligned.

6. Select the Order Type and Order Number fields (in that order). Then select
Display > Align Controls > Left.

7. Select the Order Date and Contract No. labels (in that order). Then select
Display > Align Controls > Left.

8. Select the Order Date and Contract No. fields (in that order). Then select
Display > Align Controls > Left.

9. Select the Order Number and Order Date labels and fields. Then select
Display > Align Controls > Left.

10. Select the Order Type and Contract No. labels and fields. Then select Display
> Align Controls > Left.

Results

The header frame now should look like this:
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Arranging the Note Field - ANSI X12
The field that contains any notes or messages for the purchase order is contained
on a separate frame than the header fields. To access this frame, select the NTE
segment.

About this task

You prevented the label for the Free Form Message field from being displayed, so
you see the field in the layout of your print form, but not its associated label.

In arranging the Free Form Message field and its frame, you first move the field,
then you resize the frame to give it the same width as the header frame.

You should move the Free Form Message field so that its left side is aligned with
the left sides of the field labels on the header frame and then resize it.

Procedure
1. Click the NTE segment to display the Note frame in the Layout Window.
2. Drag the Free Form Message field to the upper left corner of the Note frame.
3. Click and drag the bottom of the frame to just below the Free Form Message

field.
4. Click and drag the right side of the frame to the 20 cm. mark on the horizontal

ruler (a form with a width of 20 cm. can be printed on an �8 1/2" x 11" piece of
paper).

Results

The NTE (Note) frame now should look like this:

Arranging the Terms of Sale Fields - ANSI X12
The fields that contain information about the Terms of Sale for the purchase order
are contained on another frame. To access this frame, select the ITD segment.

About this task

You prevented the labels for the Terms Type Code and Description fields from
being displayed, so you see the fields in your print form, but not their associated
labels.

In arranging the Terms of Sale fields and their frame, you first resize, move, and
align the fields, then you resize the frame to give it the same width as the other
frames.

Use this procedure to arrange the Terms of Sale fields.

Procedure
1. Click the ITD segment to display the Terms of Sale frame in the Layout

Window.
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2. Select the Terms Type Code and Description fields and select Display > Size
to Length.

3. Drag the Terms Type Code field to the upper left corner on the frame.
4. Drag the Description field to the right of the Terms Type Code field (on the

same line).
5. Select the Terms Type Code and Description fields and select Display > Align

Controls > Top.
6. Click and drag the bottom of the frame to just below the Description and

Terms Type Code fields.
7. Click and drag the right side of the frame to the 20 cm. mark on the horizontal

ruler (a form with a width of 20 cm. can be printed on an �8 1/2" x 11" piece of
paper).

Results

The ITD (Terms of Sale) frame now should look like this:

Name and Address Fields - ANSI X12
The fields that contain information about the Names and Addresses for the
purchase order are contained on three frames. When you finish formatting all the
associated name and address fields, the information printed in these fields is
arranged in a standard address format (the name on the first line; the street
address on the next four lines; and the city, state, and zip code on the last line). To
access the first frame, select the N1 segment.

After you format the fields in the N1 group, the address fields (on three frames
corresponding to the N1, N3, and N4 segments) should look like these:

You prevented all the labels for the name and address fields from being displayed,
so you see the fields in your print form, but not their associated labels.

In arranging the Name and Address fields and their frames, first you resize the
frames to give them the same width as the header frame, then you move and
resize the fields.

Resizing the N1, N3, and N4 Frames
About this task

Use this procedure to resize the frames.

Procedure
1. Click the N1 segment to display the Name frame in the Layout Window.
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2. Click and drag the right side of the frame to the 20 cm. mark on the horizontal
ruler (a form with a width of 20 cm. can be printed on an �8 1/2" x 11" piece of
paper).

3. Click the N3 segment to display the Address Information frame in the Layout
Window.

4. Click and drag the right side of the frame to the 20 cm. mark on the horizontal
ruler (a form with a width of 20 cm. can be printed on an �8 1/2" x 11" piece of
paper).

5. Click the NEW_N4 group to display the Geographic Location frame in the
Layout Window.

6. Click and drag the right side of the frame to the 20 cm. mark on the horizontal
ruler (a form with a width of 20 cm. can be printed on an �8 1/2" x 11" piece of
paper).

Arranging the N1 Fields
About this task

Use this procedure to arrange the Name fields on the N1 frame.

Procedure
1. Click the N1 segment to display the Name frame in the Layout Window.
2. Select the Entity Identifier Code field (0098_DESC) and drag it to the upper

left corner on the frame.
3. Select the Name field and drag it to right of the Entity Identifier Code field (on

the same line).
4. Select the Entity Identifier Code and Name fields. Then select Display > Align

Controls > Top.
5. To resize the frame, click and drag the bottom of the frame to just below the

Entity Identifier Code and Name fields.

Arranging the N3 Fields
About this task

Use this procedure to move the Address Information fields on the N3 frame.

Procedure
1. Click the N3 segment to display the Address Information frame in the Layout

Window.
2. Select both Address Information fields.
3. Click and drag them so that the left margins of the fields begin at

approximately 8.3 cm. The Address Information fields are aligned with the
Name field on the previous (Name) frame.

4. Select Display > Align Controls > Left.
5. To resize the frame, click and drag the bottom of the frame to just below the

second Address Information field.

Arranging the N4 Fields
About this task

Use this procedure to move the Geographic Location fields on the N4 frame.
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Procedure
1. Click the NEW_N4 group to display the Geographic Location frame in the

Layout Window.
2. Click and drag the City Name field so that the left margin of the field begins at

approximately 8.3 cm. The City Name field is aligned with the Name field on
the Name frame, and with the Address Information fields on the Address
Information frame.

3. Click and drag the State or Province Code field to the right of the City Name
field (on the same line).

4. Click and drag the Postal Code field to the right of the State or Province Code
field (on the same line).

5. Select the City Name, State or Province Code, and Postal Code fields.
6. Select Align Controls from the Display menu, then select Top from the Align

Controls submenu. The tops of the selected items are aligned.
7. To resize the frame, click and drag the bottom of the frame to just below the

City Name, State or Province Code, and Postal Code fields.

Results

The N1, N3, and N4 frames now should look like these:

Line Items Fields
The fields that contain information about each line item for the purchase order are
contained on a separate frame.

To access this frame, select the group.
v For ANSI X12, this is the PO1 group.
v For EDIFACT, this is the LIN group.
v For TRADACOMS, this is OLD group.

You prevented some of the labels from being displayed, so you see the fields in the
layout of your print form, but not all of the associated labels. In case you have
forgotten which unlabeled field contains what data, you can click the field. The
name of the element is highlighted in the EDI File Format Window.

Before you arrange the line items fields and their frame, first you resize the frame
to give it the same width as the other frames. Then, you move and resize the fields
and field labels, as well as add static text to the form.

The following are the fields in the Line Items frame for each standard:
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ANSI X12 EDIFACT TRADACOMS

Line Line Line

Qty Prod ID Prod ID

Price Unit Cons. Units

Prod ID Qty Qty Ord

Requested Requested Price Each

Ship No Ship No (not applicable)

Description Price (not applicable)

Resizing the Line Item Frame and Fields
About this task

Use this procedure to resize the Line Items frame.

Procedure
1. Click the group to display the Line Items frame in the Layout Window.

v PO1 group (for ANSI X12)
v LIN group (for EDIFACT)
v OLD group (for TRADACOMS)

2. Click and drag the right side of the frame to the 20 cm. mark on the horizontal
ruler (a form with a width of 20 cm. can be printed on an �8 1/2" x 11" or A4
sheet of paper).

3. Select the fields listed in the table in “Line Items Fields” on page 73, depending
on your standard, and select Display > Size to Length.
The selected fields are resized to the lengths specified in the Maximum number
of characters field of the Print dialog for each field.

About Column Headings
You can add column headings (using static text) to the frame to change the way
the labels are displayed in the form. Currently, each label in this form takes up one
line of text.

You need all the horizontal space that is available to arrange the line item fields
horizontally. By adding a second line of text to some of the longer labels, more
horizontal space is available on the frame.

For ANSI X12 and EDIFACT, you are adding the following lines of static text to the
form:

Static Text Placement on Form

No. Below the Line field label

Type Below the Code field label

Ord Below the Qty field label

Each Below the Price field label

Ship Date Below the Requested field label

Later Below the Ship No field label
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For TRADACOMS, you want to label the Line field "Line No." You do not want
the label to extend beyond the margins of the field that it labels, so you will place
"Line" on one line on the frame and "No." on the line below.

You add all of the static text (column headings and separating lines), then move
each line of static text into its proper location. When you finish adding the static
text and moving each line of static text to its proper location, the Line Item frame
should look similar to the following. (This is an ANSI X12 example; some details
may be different for EDIFACT and TRADACOMS.)

Adding Column Headings
About this task

Use this procedure to add and position static text.

Procedure
1. Select all the fields and field labels on the frame.
2. Click and drag the them to the bottom of the frame. You are arranging the

fields at the top of the frame, so moving the fields and field labels out of the
way initially gives you room to work with at the top of the frame.

3. For ANSI X12 and EDIFACT: For each of the items listed in below, click Add
Text on the Main Toolbar, enter the text in the text box, and click OK.
v No.
v Type
v Ord
v Each
v Ship Date
v Later
The column headings (static text) you added are displayed in the upper left
corner of the frame.

4. For TRADACOMS: In the new text field, enter No. (note the full stop included
in the text).

Note: This field already has a label named "Line". To complete the
identification of this field, you will add static text with the name "No." After
you add the static text for this field, you will move "No." below "Line" to create
a column heading for the fields containing the line item number.
The text you added is displayed in the upper left corner of the frame.

5. Select the static text you just added and drag it to the bottom of the frame.
Moving it of the way gives you more room at the top of the frame.

About Separating Column Headings and Fields
In this print form, rectangular boxes are used to designate fields. The boxes make
it easy to distinguish fields from labels and static text. On the printout, there are
no rectangular boxes surrounding the data in the fields. The printed field data and
the labels tend to look the same on the printout (same typeface, same size text, no
boldface or italic type). You can make the labels and static text stand out from the
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fields containing the actual data by adding lines separating the labels from the
fields. You add static text to the form to add the separating lines.

For ANSI X12 and EDIFACT, you add the following lines of static text (hyphens) to
the form:

Static Text
Number of
Hyphens Placement on Form

------ Six Below the No. static text

------------ Twelve Below the Prod ID field label

---- Four Below the Type static text

-------- Eight Below the Ord static text

---- Four Below the Unit field label

----------- Eleven Below the Each static text

---------- Ten Below the Ship Date static text

---------- Ten Below the Later static text

For TRADACOMS, you add the following lines of static text (hyphens) to the form:

Static Text
Number of
Hyphens Placement on Form

------- Seven Below the No. static text

------------- Thirteen Below the Prod ID field label

-------- Eight Below the Qty Ord field label

-------- Eight Below the Unit field label

------------- Thirteen Below the Cons. Units field label

------------- Thirteen Below the Price Each field label

When you finish adding the static text and moving each line of static text to its
proper location, the Line Item frame should look similar to the following. (This is
an ANSI X12 example; some details may be different for EDIFACT and
TRADACOMS.)

Adding Lines to Separate Column Headings and Fields
About this task

You add all of the static text, then move each static text to its proper location. Use
this procedure to add and position separating lines in the form.

Procedure
1. You need to add text boxes (8 for ANSI X12 and EDIFACT; 6 for

TRADACOMS) containing hyphens of varying lengths. See About Separating
Column Headings and Fields for details.
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2. For each of these items, click Add Text on the Main Toolbar, enter the
appropriate number of hyphens, and click OK. The column headings you
added are displayed in the upper left corner of the frame.

3. Select all the static text you added and drag it to the bottom of the frame.
Moving the static text out of the way gives you more room at the top of the
frame.

Arranging the Frame
The frame now contains all of the fields, column headings, and separating lines
that are arranged on the form to create columns of information. Now you are
ready to move the fields, labels, static text (column headings), and separating lines
to their proper locations on the frame.

About this task

Use this procedure arrange the items in the frame.

Procedure
1. To arrange the Line No. column, do the following:

v Select the Line label and drag it to the upper left corner on the frame.
v Select the No. static text and drag it below the Line label.
v Select the first separating line and drag it below the No. static text.
v Select the Line field and drag it below the separating line you just moved.

2. To arrange the Prod ID column, do the following:
v Select the Prod ID label and drag it to the right of the No. static text.
v Select the second separating line and drag it below the Prod ID label.
v Select the Prod ID field and drag it below the separating line you just

moved.
3. For ANSI X12 and EDIFACT, to arrange the Code Type column, do the

following:
v Select the Code label and drag it to the right of the Prod ID label (but in

the same row as the Line label).
v Select the Type static text and drag it below the Code label.
v Select the third separating line (4 hyphens) and drag it below the Code

label.
v Select the Code field and drag it below the separating line you just moved.

4. For ANSI X12 and EDIFACT, to arrange the Qty Ord column, do the
following:
v Select the Qty label and drag it to the right of the Code label.
v Select the Ord static text and drag it below the Qty label.
v Select the fourth separating line (8 hyphens) and drag it below the Ord

static text.
v Select the Qty field and drag it below the separating line you just moved.

5. For TRADACOMS, to arrange the Qty Ord column, do the following:
v Select the Qty Ord label and drag it to the right of the Prod ID label.
v Select the third separating line (8 hyphens) and drag it below the Ord static

text.
v Select the Qty Ord field and drag it below the separating line you just

moved.
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6. For ANSI X12 and EDIFACT, to arrange the Unit column, do the following:
v Select the Unit label and drag it to the right of the Ord static text.
v Select the fifth separating line (4 hyphens) and drag it below the Unit label.
v Select the Unit field and drag it below the separating line you just moved.

7. For TRADACOMS, to arrange the Unit column, do the following:
v Select the Unit label and drag it to the right of the Qty Ord label text.
v Select the fourth separating line (8 hyphens) and drag it below the Unit

label.
v Select the Unit field and drag it below the separating line you just moved.

8. For TRADACOMS, to arrange the Cons Units column, do the following:
v Select the Cons. Units label and drag it to the right of the Unit label.
v Select the fifth separating line (thirteen hyphens) and drag it below the

Cons. Units field label.
v Select the Cons. Units field and drag it below the separating line you just

moved.
9. For ANSI X12 and EDIFACT, to arrange the Price Each column, do the

following:
v Select the Price label and drag it to the right of the Unit label (but in the

same row as the Qty label).
v Select the Each static text and drag it below the Price label.
v Select the sixth separating line (11 hyphens) and drag it below the Each

static text.
v Select the Price field and drag it below the separating line you just moved.

10. For TRADACOMS, to arrange the Price Each column, do the following:
v Select the Price Each label and drag it to the right of the Cons. Unit label.
v Select the sixth separating line (13 hyphens) and drag it below the Price

Each static text.
v Select the Price Each field and drag it below the separating line you just

moved.
11. For ANSI X12 and EDIFACT, to arrange the Requested Ship Date column, do

the following:
v Select the Requested label and drag it to the right of the Price label.
v Select the Ship Date static text and drag it below the Requested label.
v Select the seventh separating line (10 hyphens) and drag it below the Ship

Date static text.
v Select the Requested field and drag it below the separating line you just

moved.
12. For ANSI X12 and EDIFACT, to arrange the Ship No Later column, do the

following:
v Select the Ship No label and drag it to the right of the Requested label.
v Select the Later static text and drag it below the Ship No label.
v Select the eighth separating line (10 hyphens) and drag it below the Later

static text.
v Select the Ship No field and drag it below the separating line you just

moved.
13. To move the Description field, click and drag it below the last row of fields.
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For EDIFACT, the Item Description field will not be placed in a column.
Rather, this field will be placed below the other fields on the Line Item (LIN)
frame.
For TRADACOMS, drag the Traded Unit Descr. Line 1 and Traded Unit
Descr. Line 2 fields below the row of fields near the top of the frame.

14. To resize the frame, click and drag the bottom of the frame to just below the
description field(s).

Results

The frame now should look similar to the following. (This is an ANSI X12
example; some details may be different for EDIFACT and TRADACOMS.)

Aligning Rows
One of the remaining tasks in formatting the print form is to align the fields,
labels, and static text. First, you align the items in rows to give the form a
consistent appearance. You align the items in columns.

About this task

Use this procedure to align the fields, field labels, and static text by row
(horizontally).

Procedure
1. Select the following labels and static text and select Display > Align Controls

> Top.
v Line
v Code
v Qty
v Price
v Requested
v Ship No

2. Select the following labels and static text and select Display > Align Controls
> Top.
v No.
v Prod ID
v Type
v Ord
v Unit
v Each
v Ship Date
v Later

3. Select all the separating lines between column headings and fields. Then select
Display > Align Controls > Top.
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4. Select the following fields and select Display > Align Controls > Top.
v Line No.
v Prod ID
v Code Type
v Qty Ord
v Unit
v Price Each
v Requested Ship Date
v Ship No Later

Aligning Columns
Now, you align the fields, field labels, and static text in columns to help give the
form a consistent appearance.

About this task

Use this procedure to align the fields, field labels, and static text in columns.

Procedure
1. Select the Line No. column heading, its separating line, the Line No. field, and

the Description field. Then select Display > Align Controls > Left.
2. Select the Prod ID column heading, its separating line, and the Prod ID field.

Then select Display > Align Controls > Left.
3. For ANSI X12 and EDIFACT: Select the Code Type column heading, its

separating line, and the Code Type field. Then select Display > Align Controls
> Left.

4. Select the Qty Ord column heading, its separating line, and the Qty Ord field.
Then select Display > Align Controls > Left.

5. Select the Unit column heading, its separating line, and the Unit field. Then
select Display > Align Controls > Left.

6. TRADACOMS only: Select the Cons. Units column heading, its separating line,
and the Cons. Units field. Then select Display > Align Controls > Left.

7. Select the Price Each column heading, its separating line, and the Price Each
field. Then select Display > Align Controls > Left.

8. For ANSI X12 and EDIFACT: Select the Requested Ship Date column heading,
its separating line, and the Requested Ship Date field. Then select Display >
Align Controls > Left.

9. For ANSI X12 and EDIFACT: Select the Ship No Later column heading, its
separating line, and the Ship No Later field. Then select Display > Align
Controls > Left.

Results

The frame now should look similar to the following. (This is an ANSI X12
example; some details may be different for EDIFACT and TRADACOMS.)
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The Line Items Frame
You have completed formatting the Line Items frame so that the line item
information is displayed in columns and rows. If you were to register the
translation object now and run EDI data through the translation object, you would
see that the column headings would be repeated for every line item.

The column headings need to be printed only once, so you will copy and paste the
group to create a second group. The formatting in the first group is retained in the
second group. You change the maximum use of the first group to one (so that the
column headings are printed only once). Then, you remove the column headings in
the second group from the area that is printed, leaving only the fields for printing
the information on the printout.
v For ANSI X12, the first group is PO1; the second group is PO1:2.
v For EDIFACT, the first group is LIN; the second group is LIN:2.
v For TRADACOMS, the first group is OLD; the second group is OLD:3

For ANSI X12, you change the maximum use of the PO1:2 group to 99,999. Your
partner can send you up to 100,000 line items, so the total maximum use of both
PO1 groups does not need to exceed 100,000. The maximum use of the PO1:2
group is changed to 99,999.

For EDIFAT, you change the maximum use of the LIN:2 group to 199999. Your
partner can send you up to 200,000 line items, so the total maximum use of both
LIN groups does not need to exceed 200000. The LIN group retains its maximum
use of one, and the maximum use of the LIN:2 group changes to 199999.

For TRADACOMS, you change the maximum use of the OLD:3 group to 999,998.
Your partner can send you up to 999,999 line items, so the total maximum use of
both OLD groups does not need to exceed 999,999. The maximum use of the OLD
group will be changed to one, and the maximum use of the OLD:3 group will be
changed to 999,998.

Copying the Group
About this task

Use this procedure to copy and paste the group.

Procedure
1. Select one of the following groups and click Copy on the Main Toolbar.

v PO1 (for ANSI X12)
v LIN (for EDIFACT)
v OLD (for TRADACOMS)

2. Select Paste on the Main Toolbar to paste the second group after the first
group.

3. Click the Paste after selected item (at the same level) option to paste the
Clipboard contents after the original group.

4. Click OK to exit the dialog.
For ANSI X12, the pasted PO1 group is renamed PO1:2. For EDIFACT, the
pasted group is named LIN:2. For TRADACOMS, the pasted group is named
OLD:3.

Chapter 5. Formatting the Print Form for ANSI X12 81



Changing the Maximum Use
About this task

Use this procedure to change the maximum use of the PO1 group and PO1:2
group.

Procedure
1. Right-click one of the following groups and select Properties.

v PO1 (for ANSI X12)
v LIN (for EDIFACT)
v OLD (for TRADACOMS)

2. On the Looping tab, enter 1 in the Max Usage box to indicate that this group
can be used only once in each purchase order.

3. Click OK to exit the Group Properties dialog.
4. Right-click one of the following groups and select Properties.

v PO1:2 (for ANSI X12)
v LIN:2 (for EDIFACT)
v OLD:3 (for TRADACOMS)

5. Select the Looping tab.
6. In the Max Usage box, enter one of the following:

v 99999 (for ANSI X12)
v 199999 (for EDIFACT)
v 999998 (for TRADACOMS)

7. Click OK to exit the Group Properties dialog.

Moving the Column Headings below the Print Area
About this task

Use this procedure to move the column headings on the second Line Items frame
below the print area, so the headings are not printed.

Procedure
1. Click Generate Layout on the Main Toolbar to refresh the display.
2. Select one of the following groups:

v PO1:2 (for ANSI X12)
v LIN:2 (for EDIFACT)
v OLD:3 (for TRADACOMS)

3. Select all of the column headings and separating lines on the frame and drag
them below the bottom of the frame so they are not displayed. These items are
still included in the print form, but they are not printed.

4. Select all of the fields on the frame and drag them to the top of the frame.
5. To resize the frame, click and drag the bottom of the frame to just below the

description field(s).

Results

The second frame should look similar to the following. (This is an ANSI X12
example; some details may be different for EDIFACT and TRADACOMS.)
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Resizing the Transaction Total Frame - ANSI X12
The Number of Line Items field (CTT_Group group) for the purchase order is
contained on a separate frame than the rest of the purchase order information
because this field contains summary information that you want to be printed at the
bottom of the translation object.

About this task

You resize the Transaction Total (CTT_Group) frame to give it the same width as
the other frames in the purchase order.

Use this procedure to resize the following steps to resize the Transaction Total
frame.

Procedure
1. Click the CTT_Group group to display the Transaction Total (CTT_Group)

frame in the Layout Window.
2. Click and drag the right side of the frame to the 20 cm. mark on the horizontal

ruler (a form with a width of 20 cm. can be printed on an �8 1/2" x 11" sheet of
paper).

3. Click and drag the bottom of the frame to just below the Number of Line Items
field.

4. Select Save from the File menu.

Results

The CTT_Group frame now should look like this:

What to do next

You have completed your Purchase Order form and you are ready to compile the
form.
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Chapter 6. Creating Print Forms for EDIFACT

Modifying the PO DTM Segment
The DTM segment contains Date/Time/Period header information (in this tutorial,
the order date) used in the EDI data. The standard allows the DTM segment to be
used up to 35 times in one purchase order. In this tutorial, you expect the DTM
segment only once from your trading partner, so you will change the maximum
number of times this segment can be used to one.

About this task

Use this procedure to change the maximum use of the DTM segment.

Procedure
1. Right-click the DTM segment and select Properties.
2. On the Looping tab, enter 1 in the Max Usage box to indicate that this segment

can be used only once.
3. Click OK to exit the Segment Properties dialog.

Modifying the FTX Segment
The FTX segment contains Free Text header details in the EDI data. The standard
allows the FTX segment to be used up to five times in one purchase order. In this
tutorial, you expect the FTX segment only once from your trading partner so you
will change the maximum number of times this segment can be used to one.

About this task

Use this procedure to change the maximum use of the FTX segment.

Procedure
1. Right-click the FTX segment and select Properties.
2. On the Looping tab, enter 1 in the Max Usage box.
3. Click OK to exit the Segment Properties dialog.

Modifying the PO RFF Group
If the form were generated now, the fields associated with the RFF group would be
displayed on a separate frame than the BGM header fields. The standard allows
the RFF group to be used up to 10 times in one purchase order. In this tutorial,
you expect the RFF group only once from your trading partner so you will change
the maximum number of times the RFF group can be used to one. Also, you need
to set the Promote flag on the group so that the RFF fields are placed on the same
frame as the BGM fields. After you generate the form later in this tutorial, the RFF
fields are displayed on the same frame as the BGM fields.

About this task

Use this procedure to change the maximum use of the RFF group and promote the
RFF group to the parent frame.
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Procedure
1. Right-click the RFF group and select Properties.
2. On the Looping tab, enter 1 in the Max Usage box.
3. Select the Print tab.
4. Select the Promote group to parent frame check box to display the fields in the

RFF group on the same frame as the fields in the parent group.
5. Click OK to promote the group and to exit the Group Properties dialog.

Modifying the PO PAT Group
The standard allows the PAT group to be used up to 10 times in one purchase
order. You expect the PAT group only once from your trading partner so you must
change the maximum number of times the PAT group can be used to one. Also,
you need to set the Promote flag on the group so that the PAT fields are placed on
the same frame as the BGM fields. When you generate the form later in this
tutorial, the PAT fields will be displayed on the same frame as the BGM fields.

About this task

Use this procedure to change the maximum use of the PAT group and promote the
PAT group to the parent frame.

Procedure
1. Right-click the PAT group and select Properties.
2. On the Looping tab, enter 1 in the Max Usage box.
3. Select the Print tab.
4. Select the Promote group to parent frame check box to display the fields in the

PAT group on the same frame as the fields in the parent group.
5. Click OK to promote the group and exit the Group Properties dialog.

The LIN Group

Changing the Maximum Use of the PO PIA Segment
The PIA segment in the LIN group contains Line Item details used in the EDI data.
The standard allows the PIA segment to be used up to 25 times for each line item.
In this tutorial, you expect the PIA segment only once per line item from your
trading partner so you will change the maximum number of times this segment
can be used for each line item to one.

About this task

Use this procedure to change the PIA segment’s maximum use.

Procedure
1. Right-click the PIA segment and select Properties.
2. On the Looping tab, enter 1 in the Max Usage box.
3. Click OK to exit the Segment Properties dialog.

Changing the Maximum Use of the PO IMD:2 Segment
The IMD:2 segment (in the LIN group) contains Item Description details used in
the EDI data. The standard allows the IMD:2 segment to be used up to 10 times
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for each line item. You expect the IMD:2 segment only once per line item from
your trading partner so you must change the maximum number of times this
segment can be used for each line item to one.

About this task

Use this procedure to change the maximum use of the IMD:2 segment.

Procedure
1. Right-click the IMD:2 segment and select Properties.
2. On the Looping tab, enter 1 in the Max Usage box.
3. Click OK to exit the Segment Properties dialog.

Changing the Minimum and Maximum Use of the MEA:3
Segment

The MEA:3 segment in the LIN group contains Measurements details used in the
EDI data. The standard allows the MEA:3 segment to be used up to five times for
each line item. In this tutorial, you expect the MEA:3 segment only once per line
item from your trading partner so you will change the maximum number of times
this segment can be used for each line item to one. The standard also allows this
segment to be conditional. You and your trading partner agree that the
measurements contained in the MEA:3 segment are important to the purchase
order, so you will change the minimum use of this segment to one to make it
mandatory.

About this task

Use this procedure to change the minimum use and maximum use of the MEA:3
segment.

Procedure
1. Right-click the MEA:3 segment and select Properties.
2. On the Looping tab, enter 1 in the Min Usage box and 1 in the Max Usage box.
3. Click OK to exit the Segment Properties dialog.

Changing the Minimum and Maximum Use of the QTY:3
Segment

The QTY:3 segment (in the LIN group) contains Quantity details used in the EDI
data. The standard allows the QTY:3 segment to be used up to 10 times for each
line item. In this tutorial, you expect the QTY:3 segment only once per line item
from your trading partner so you will change the maximum number of times this
segment can be used for each line item to one. You and your trading partner agree
that the quantities contained in the QTY:3 segment are important to the purchase
order so you will change the minimum use of this segment to one.

About this task

Use this procedure to change the minimum use and maximum use of the QTY:3
segment.
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Procedure
1. Right-click the QTY:3 segment and select Properties.
2. On the Looping tab, enter 1 in the Min Usage box and 1 in the Max Usage box.
3. Click OK to exit the Segment Properties dialog.

Promoting the DTM:13 Segment
If the form were generated now, the date in the DTM:13 segment in the LIN group
for the line item information would be printed on a separate frame than the rest of
the line item fields. You want the date to be placed on the same frame as the rest
of the line item information so you will promote the DTM:13 segment. Your
trading partner sends you two sets of dates: the required shipment date and the
last delivery date (in that order). The DTM:13 segment must occur twice in the
form to accommodate both sets of dates from your trading partner in the particular
order in which you expect them. To customize the DTM:13 segment while
preserving the integrity of the EDI structure, you need to promote the DTM:13
segment, then change the maximum use of the original DTM:13 segment to one so
that it is no longer a repeating segment.

About this task

Use this procedure to promote the DTM:13 segment.

Procedure
1. Right-click the DTM:13 segment and select Promote.
2. Click Yes at the prompt to extract one iteration of the DTM:13 segment and

place it directly above the DTM:13 segment that you selected to promote.
The new iteration of the DTM:13 segment is named DTM:27.

Making the DTM:27 Segment Conditional
About this task

Use this procedure to make the DTM:27 segment conditional.

Procedure
1. Right-click the DTM:27 segment and select Promote.

The Segment Properties dialog is displayed.
2. On the Looping tab, enter 0 in the Min Usage box to make this segment

conditional.
3. Click OK to exit the Segment Properties dialog.

Changing the Maximum Use of the DTM:13 Segment
About this task

Use this procedure to change the DTM:13 segment’s maximum use.

Procedure
1. Right-click the DTM:13 segment and select Properties.
2. On the Looping tab, enter 1 in the Max Usage box.
3. Click OK to exit the Segment Properties dialog.
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Changing the Maximum Use of the MOA:5 Segment
The MOA:5 segment (in the LIN group) contains Monetary Amount details used in
the EDI data. The standard allows the MOA:5 segment to be used up to five times
for each line item. You expect the MOA:5 segment only once per line item from
your trading partner so you need to change the maximum number of times this
segment can be used for each line item to one.

About this task

Use this procedure to change the maximum use of the MOA:5 segment.

Procedure
1. Right-click the MOA:5 segment and select Properties.
2. On the Looping tab, enter 1 in the Max Usage box.
3. Click OK to exit the Segment Properties dialog.

The CNT group
The CNT segment contains Control Total summary information for the purchase
order. The standard allows the CNT segment to be used up to 10 times in a
purchase order. You want to use CNT segment once per purchase order so you
need to change the minimum and maximum use of the CNT segment to one. If the
form were generated after changing the minimum and maximum use of the CNT
segment, the total number of line items would be printed with the BGM fields at
the beginning of the purchase order because the fields in the CNT segment would
be displayed on the same frame as the fields in the BGM segment.

For the CNT segment to print the total number of line items at the end of the
purchase order and maintain the integrity of the purchase order, you must create a
CNT group with a minimum use and a maximum use of one, then cut the CNT
segment and paste it as a subordinate to the group you just created. After you
move the CNT segment to the new CNT group that you create, the total number of
line items is displayed on its own frame.

Creating a CNT Group
About this task

Use this procedure to create a CNT group.

Procedure
1. Select the CNT segment.
2. Select Edit > Insert > Group.

The Group Properties dialog is displayed.
3. In the Name box, enter CNT_Group as the loop identification code.
4. In the Description box, enter CNT Group to provide a brief explanation of the

loop.
5. On the Looping tab, enter 1 in the Min Usage box to make this group

mandatory.
6. Click OK to create the group.
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Cutting and Pasting the CNT Segment
About this task

Use this procedure to cut and paste the CNT segment.

Procedure
1. Select the CNT segment.
2. Click the Cut icon on the Main Toolbar.
3. Click Yes at the prompt.
4. Select the CNT group, which is the group in which you want to paste the CNT

segment as a subordinate.
5. Click Paste on the Main Toolbar.
6. At the prompt, accept the default to paste the Clipboard contents as a child

(subordinate) of the group and click OK to exit the dialog.

Changing the Maximum Use of the CNT Segment
About this task

Use this procedure to change the maximum use of the CNT segment to one.

Procedure
1. Right-click the CNT segment and select Properties.
2. On the Looping tab, enter 1 in the Max Usage box .
3. Click OK to exit the Segment Properties dialog.
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Chapter 7. Modifying Form Components for EDIFACT

Setting up the Document Name for the Print Form
About this task

We recommend that you set up a Document Name for each form. The document
name makes the identification of a document created by the form easier in Sterling
Gentran:Server. Setting up the document name enables you to differentiate
between documents in the document browsers. If you set up the document name
in the Forms Integration subsystem, the Name field of the document browsers that
contain this document in Sterling Gentran:Server contains the data from that
element. You can choose any element as the document name, but we strongly
recommend that you select an element that occurs only once in the document and
has a data type of string. For an ANSI X12 850 purchase order, the document name
usually is the Purchase Order Number. For an EDIFACT 92.1 purchase order, the
document name usually is the Document/Message Number. For a TRADACOMS
ANA001 ORDERS release 9 purchase order, the document name usually is the
Customer’s Order Number.

Use this procedure to set up the document name.

Procedure
1. Double-click one of the following elements:

v BEG03 (ANSI X12)
v BGM05 (EDIFACT)
v ORD ORNO ORN0 (TRADACOMS)
We recommend that you select this element because it is a non-recurring,
mandatory element.
The Element Properties dialog is displayed.

2. Select the Standard Rule tab.
3. Select the Update from the standard rule list.
4. Click Yes at the prompt.
5. From the Select the table (or group) to update list, select Document record.
6. From the Column (or field) to update list, select Document Name to indicate

that you are updating the Name field in the document browsers with the
contents of the element.

7. Click OK to set up the document name.

The BGM Segment

Customizing the BGM05 Element
The BGM segment is the Beginning of Message segment for the purchase order.
This segment contains information that is pertinent to the entire purchase order.

About this task

The BGM05 element (Document/Message Number) is defined by the standard to
be a string of thirty-five alphanumeric characters. You know that your trading
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partner’s purchase order number will be a 10-character string, so you will change
the element and field lengths to accommodate the shorter purchase order number.
In addition, you will rename the field label.

Use this procedure to change the field and element lengths and rename the field
label for the Document/Message Number field.

Procedure
1. Double-click the BGM05 element.
2. On the Validation tab, enter 10 in the Max box for the maximum number of

characters allowed for this element.
3. Select the Print tab.
4. In the Label box, enter Order Number: to replace the existing text.
5. In the Maximum number of characters to be printed box, enter 10 to display a

10-character purchase order number on the printout.
6. Click OK to exit the dialog.

Customizing the BGM06 Element
The BGM06 element (Message Function, Coded) contains the code from your
partner’s EDI data representing the type of purchase order (for example, new
order) for this message. You want the meaningful description of the code to be
printed on the printout instead of the code itself. You need to prevent the Message
Function, Coded field from being displayed (hide it), but use the code from that
element (BGM06) to look up the code description in the Message Function, Coded
code list table. You then need to print that description in another field that you
create. The description of the code is displayed in the new field on the printout.

About this task

For this tutorial, your trading partner will only send you two types of purchase
orders:
v Request (Message Function Code 13)
v Change (Message Function Code 4)

The description of the EDI code in the BGM06 element is important, though you
do not need to print the code itself. For example, the EDI code value 13 is not
descriptive enough for users reading a printout of the purchase order. The
description of code 13 (Request) is meaningful.

Before you can print the description of the EDI code value, you must create a new
element in the BGM segment to store and print the description. The new BGM
element is the element that displays the description of the Message Function,
Coded. You use the Copy and Paste functions to move EDI information in the
form. Copied form components retain all the information of the original form
components.

Use this procedure to copy and paste the BGM06 element.

Procedure
1. Select the BGM06 element.
2. Click Copy on the Main Toolbar.
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3. Select the BGM07 element, which is the last element in the BGM segment. The
BGM07 element is the element after which you want the BGM06 element to be
pasted.

4. Click Paste on the Main Toolbar to paste the BGM06 element. A new element
(BGM08) is created, which is an exact copy of the BGM06 element.

Changing the BGM08 Element and Field Properties
The system names the new element created from copying the BGM06 element
1225:2. You need to rename the new element to identify its purpose, which is to
print the description of the code from the BGM06 element.

About this task

Note: If a segment or element occurs more than once in a form, it is identified by
its name <ID>. The second and subsequent occurrences are identified by <ID>:n,
where n is the number of the occurrence in the form.

You will increase the element and field lengths of the BGM08 element to
accommodate the longer description. Also, you will rename the field label for the
newly created BGM08 element to reflect the contents of the field (the description of
the Message Function, Coded).

Use this procedure to change the element name and length, and change the field
label and field length for the Message Function, Coded field.

Procedure
1. Double-click the BGM08 element.
2. In the Name box, enter 1225_DESC.
3. On the Validation tab, enter 0 in the Minimum box and 30 in the Maximum

box to define the range of characters allowed for this element.
4. Click the Print tab.
5. In the Label box, enter Order Type:.
6. In the Maximum number of characters to print box, enter 30.
7. Click OK to save the new label and to exit the dialog.

Hiding the BGM06 Field and Loading a Code List Table from
the Standard

Now that you have created an exact copy of the BGM06 element, you can hide the
first Message Function, Coded field.

About this task

When you use code list tables, you load a code list table from the standard to tell
the system which code list table to use in looking up EDI code values. You can
load the specific code values you expect to receive in the EDI data, or you can load
the entire code list table. Your trading partner will send you two types of purchase
orders:
v Request (Message Function Code 13)
v Change (Message Function Code 4)

You do not need to load the entire code list table, so you will load only codes 13
and 4 from the code list table.
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Use this procedure to hide the Message Function, Coded field and load the code
list table from the standard.

Procedure
1. Double-click the BGM06 element, which is the element for which you need to

use a code list table.
2. On the Print tab, clear the Include this field in the print check box to turn

the option off.
3. Select the Standard Rule tab.
4. Select Use Code from the "Please select a standard rule to use" list.
5. Click Yes at the prompt.
6. Click Edit to access the Edit Code List dialog.

The Table ID box contains 1225, the name of the element for which this code
list table is used. The Desc box contains MESSAGE FUNCTION, CODED, the
description of the element for which this code list table is used.

7. Click Load to access the Load Code List dialog. You are prompted to select an
ODBC data source name. Select the appropriate DSN and click OK to access
the Load Code List dialog. The Codes In Standard list contains the entire code
list.

8. From the Codes In Standard list, highlight code 13 and click Add to move it
to the Codes Selected list. Then, highlight code 4 and click Add.

9. Click OK to load the code list table and exit the Load Code List dialog.
10. Click Close to exit the Edit Code List dialog.
11. From the Store Field list, select 1225_DESC MESSAGE FUNCTION, CODED

to store the description in the BGM08 element you created.
12. Click OK to exit the dialog.
13. Click Generate Layout on the Main Toolbar to refresh the display of the print

form.

Results

The header frame now should look like this:
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Customizing the DTM Segment
The DTM segment (Date/Time/Period) is used to print the order date for the
purchase order. The standard allows the DTM segment to be used up to 35 times
in one purchase order. In this tutorial, you will use the DTM segment only once.
You have already changed the maximum use of the DTM segment to obtain just
one instance of the DTM segment and to place the order date on the same frame as
the order number.

About this task

The DTM01 element (Date/Time/Period Qualifier) is a mandatory element for the
EDIFACT 92.1 purchase order (ORDERS). You do not need to print the qualifier on
the printout so you will hide the Date/Time/Period Qualifier field.

The DTM02 element (Date/Time/Period) contains the purchase order date. The
standard allows this field to contain up to a 35-character string, but your trading
partner sends you shorter dates. You need to change the element and field lengths
to accommodate the shorter dates, and then rename the field label.

Use this procedure to customize the DTM segment.

Procedure
1. To hide the Date/Time/Period Qualifier field, double-click the DTM01

element.
2. On the Print tab, clear the Include this field in the print check box to turn

the option off.
3. Click OK to exit the dialog.
4. To customize the Date/Time/Period field, double-click the DTM02 element.
5. On the Validation tab, enter 8 in the Maximum box to allow the entire date

(including the / separators) to be contained in this element.
6. Select the Print tab.
7. In the Label box, enter Order Date: to replace the existing text.
8. In the Maximum number of characters to be printed box, enter 8.
9. Click OK to exit the dialog.

10. Click Generate Layout on the Main Toolbar to refresh the print form display.
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Results

The header frame now should look like this:

Customizing the FTX Segment
Your trading partner sends you messages or notes, so the FTX segment must be
present to receive them. The standard allows the FTX segment to be used up to
five times in one purchase order. In this tutorial, you will use the FTX segment
only once. You have already changed the maximum use of the FTX segment to
obtain just one instance of the FTX segment and to place the note or message on
the same frame as the purchase order number and date.

About this task

The FTX01 element (Text Subject Qualifier) is a mandatory element for the FTX
segment. The FTX01 element contains the three-character qualifier from your
partner’s EDI data to indicate what type of free text follows (in this tutorial, AAI
for General Information). The system does not enable you to deactivate this
element, because it is a mandatory element. Because you expect only one qualifier
(General Information) in this element, you do not need to print the qualifier on the
report. You will hide the Text Subject Qualifier field.

The FTX06 element (Free Text) is mandatory when the FTX segment is used. The
EDI data in the FTX06 element contains the exact message that should be printed.
The message is self-explanatory so you do not need to print the label for this field.
You need to remove the field label from the form. You also know that your partner
sends free text in 60 characters or fewer (70 is the maximum length allowed by the
standard for this field) so you need to change the element and field lengths for the
Free Text field.

Use this procedure to customize the FTX segment.

Procedure
1. To hide the Text Subject Qualifier field, double-click the FTX01 element.
2. On the Print tab, clear the Include this field in the print check box.
3. Click OK to exit the dialog.
4. To customize the Free Text field, double-click the FTX06 element.
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5. On the Validation tab, enter 60 in the Maximum box to allow a 60-character
string in this element.

6. Select the Print tab.
7. In the Label box, delete the existing text.
8. In the Maximum number of characters to be printed box, enter 60.
9. Click OK to exit the dialog.

10. Click Generate Layout on the Main Toolbar to refresh the print form display.

Results

The header frame now should look like this:

Customizing the RFF Group
The RFF segment is a conditional group that specifies the Reference information
for the purchase order. The standard allows this group to be used up to 10 times in
one purchase order. You need to use this group only once in the header of the
purchase order (for the contract number) so you have already changed the
maximum use of this group to one. At the same time, you promoted this group to
the parent frame so that the contract number is displayed on the same frame as the
purchase order number and date.

About this task

The RFF segment (Reference) contains reference information used in the EDI data.
In this tutorial, you know that the only reference number your partner will send
you in the RFF segment is a contract number that your trading partner uses for
their records.

The RFF01 element (Reference Qualifier) is a mandatory element for the RFF
segment. The RFF01 element contains the three-character code from your partner’s
EDI data to indicate what type of reference follows. For this tutorial, you know
that your trading partner sends you only one type of reference—the contract
number. The system does not enable you to deactivate this element, because it is a
mandatory element. Since you expect only one qualifier in this element, you do not
need to print the qualifier on the report. You will hide the Reference Qualifier field.
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The RFF02 element contains the Reference Number. This element is defined by the
standard to be a string of 35 alphanumeric characters. In this tutorial, you know
that your trading partner’s reference number (the contract number) is a
12-character string so you need to change the field and element lengths to
accommodate the reference number that is shorter than the standard expects. In
addition, you need to rename the field label.

Use this procedure to customize the RFF group.

Procedure
1. To hide the Reference Qualifier field, double-click the RFF01 element.
2. Select the Print tab.
3. Clear the Include this field in the print check box.
4. Click OK to exit the dialog.
5. To customize the Reference Number field, double-click the RFF02 element.
6. On the Validation tab, enter 12 in the Maximum box to allow a 12-character

string in this element.
7. Select the Print tab.
8. In the Label box, enter Contract No. to replace the existing text.
9. In the Maximum number of characters to be printed box, enter 12.

10. Click OK to exit the dialog.
11. Click Generate Layout on the Main Toolbar.

Results

The header frame now should look like this:

The NAD Group
The standard allows the NAD group (Name and Address) to be used up to 20
times. In the NAD group, you have already activated the NAD segment to contain
the name and address of an entity or individual. Your trading partner uses the
NAD group to send you these three types of addresses:
v Party to be billed (Party Qualifier AA)
v Buyer (Party Qualifier BY)
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v Ship to (Party Qualifier ST)

The NAD segment identifies the Name and Address of an entity or individual. The
NAD01 element is a mandatory element in the NAD segment and contains the
three-character qualifier identifying the type of party in the NAD segment.

The NAD01 element (Party Qualifier) identifies the type of party in the NAD
segment. For this tutorial, you know that your trading partner sends only these
three types of names/addresses: Party to be billed, Buyer, and Ship to. You want
the meaningful description of the qualifier on the printout instead of the qualifier
itself.

To print the description of the EDI code value, you must copy the NAD01 element
to another element in the NAD segment, then use the new NAD element to print
the description of the Party Qualifier code.

Copying the NAD01 Element
About this task

Use this procedure to copy and paste the NAD01 element.

Procedure
1. Select the NAD01 element.
2. Click Copy on the Main Toolbar.
3. Select the NAD22 element, which is the last element in the NAD segment.
4. Click Paste on the Main Toolbar to paste the new element.

Changing the NAD23 Element and Field Properties
The system names the new element created from copying the NAD01 element
3035:3. You need to rename the new element to identify its purpose, which is to
print the description of the qualifier from the NAD01 element. You need to remove
the Mandatory status from the NAD23 element to make it a conditional element
(meaning that the element will be used only if there is EDI data available for it)
and increase the element and field lengths to accommodate the qualifier’s
description.

About this task

Use this procedure to change the element name and length, make the element
conditional instead of mandatory, and change the field label and field length for
the Party Qualifier field.

Procedure
1. Double-click the NAD23 element.
2. In the Name box, enter 3035_DESC.
3. Select the Validation tab.
4. Clear the Mandatory check box to make the element conditional.

Note: You will not receive an NAD23 element from your trading partner. If
you leave the mandatory status checked, you will receive a compliance error.

5. Enter 0 in the Min box and 18 in the Max box for the range of characters
allowed for this element.
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6. Select the Print tab.
7. In the Label box, delete the existing text.
8. In the Maximum number of characters to be printed box, enter 18.
9. Click OK to exit the dialog.

Hiding the NAD01 Field and Loading the Code List Table from
the Standards

Now that you have created an exact copy of the NAD01 element, you can hide the
first Party Qualifier field.

About this task

For this tutorial, you know that your trading partner will send you the following
types of names and addresses:
v Party to be billed (Party Qualifier AA)
v Buyer (Party Qualifier BY)
v Ship to (Party Qualifier ST)

You do not need to load the entire code list table; you will load only codes AA, BY,
and ST from the code list table.

Use this procedure to hide the first Party Qualifier field and load the codes from
the standards.

Procedure
1. Double-click the NAD01 element, which is the element for which you need to

use a code list table.
2. On the Print tab, clear the Include fields in the print check box.
3. On the Standard Rule tab, select Use Code from the list. Click Yes at the

prompt.
4. Click Edit to access the Edit Code List dialog.

The Table ID box contains 3035, the name of the element for which this code
list table will be used. The Desc box contains PARTY QUALIFIER, the
description of the element for which this code list table will be used.

5. Click Load to access the Load Code List dialog. You are prompted to select an
ODBC data source name. Select the appropriate DSN and click OK to access
the Load Code List dialog. The Codes In Standard list contains the entire code
list.

6. From the Codes In Standard list, highlight code AA and click Add to move it
to the Codes Selected list. Highlight code BY and click Add. Highlight code
ST and click Add.

Tip: This code list table contains many codes. To access code ST quickly, press
the letter s; the first code that begins with the letter s is highlighted. You need
to scroll through only the list of codes beginning with s, instead of the entire
code list, to access code ST.

7. Click OK to load the code list table and exit the Load Code List dialog.
8. Click Close to exit the Edit Code List dialog.
9. From the Store Field list, select 3035_DESC PARTY QUALIFIER to store the

description in the NAD23 element you created.
10. Click OK to exit the dialog.
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Customizing the NAD10 Element
The NAD10 element (Party Name) contains the exact name that should be printed
in the purchase order. The name is explained by the description of the Party
Qualifier so you do not need to print the label associated with the name. The only
customizing that is necessary for the NAD10 element is to remove the field label
on the printout.

About this task

Use this procedure to hide the Party Name field label.

Procedure
1. Double-click the NAD10 element.
2. On the Print tab, delete the text in the Label box. The party name is explained

by the description in the Party Qualifier field (NAD23).
3. Click OK to exit the dialog.

Customizing the NAD16 Element
The NAD16 element contains the Street and Number/P.O. Box, which identifies the
street name and number, suite number, or any other address information that your
trading partner sends you. The NAD16 element contains the exact address
information that should be printed. The address information corresponds to the
name that is printed from the NAD10 element. There is no need to print the label
associated with the address so you need to remove the field label for the NAD16
element.

About this task

Use this procedure to hide the field label for the first Street and Number/P.O. Box
field.

Procedure
1. Double-click the NAD16 element.
2. On the Print tab, delete the text in the Label box.
3. Click OK to exit the dialog.

Customizing the NAD17 Element
The NAD17 element contains the second Street and Number/P.O. Box line, which
(like the NAD16 element) identifies the street name and number, suite number, or
any other address information that your trading partner sends you. The NAD17
element contains the exact address information that should be printed. The address
information corresponds to the name that is printed from the NAD10 element.
There is no need to print the label associated with the address, so you need to
remove the field label for the NAD17 element.

About this task

Use this procedure to remove the field label for the second Street and
Number/P.O. Box field.
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Procedure
1. Double-click the NAD17 element.
2. On the Print tab, delete the text in the Label box.
3. Click OK to exit the dialog.

Customizing the NAD19 Element
The NAD19 element contains the City Name. There is no need to print the field
label associated with this element, because it will be evident on the printout that
all the name and address information are associated. Therefore, you will remove
the field label for the NAD19 element. Also, you must change the element and
field lengths because you do not need the City Name field to be longer than 30
characters.

About this task

Use this procedure to change the element and field lengths and remove the City
Name field label.

Procedure
1. Double-click the NAD19 element.
2. On the Validation tab, enter 30 in the Maximum box to allow a 30-character

string in this element.
3. Select the Print tab.
4. In the Label box, delete the existing text.
5. In the Maximum number of characters to be printed box, enter 30 to display a

30-character city name on the printout.
6. Click OK to exit the dialog.

Customizing the NAD20 Element
The NAD20 element contains the Country Sub-Entity Identification. You do not
need to print the field label associated with this element, because it is evident on
the printout that all the name and address information are associated. You must
remove the field label for the NAD20 element and change the element and field
lengths because your partner sends a Country Sub-Entity Identification that is
abbreviated to no more than two characters.

About this task

Use this procedure to change the element and field lengths and remove the
Country Sub-Entity Identification field label.

Procedure
1. Double-click the NAD20 element.
2. On the Validation tab, enter 2 in the Maximum box to allow a two-character

string in this element.
3. Select the Print tab.
4. In the Label box, delete the existing text.
5. In the "Maximum number of characters to be printed" box, enter 2.
6. Click OK to exit the dialog.
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Customizing the PO NAD21 Element
The NAD21 element contains the Postcode Identification. You do not need to print
the field label associated with this element, because it is evident on the printout
that all the name and address information are associated. You need to remove the
field label for the NAD21 element.

About this task

Use this procedure to remove the Postcode Identification field label.

Procedure
1. Double-click the NAD21 element.
2. On the Print tab, delete the text in the Label box.
3. Click OK to exit the dialog.
4. Click Generate Layout on the Main Toolbar to refresh the print form display.

Results

The Name and Address (NAD) frame now should look like this:

The PAT Group
The PAT group is a conditional group that specifies the Payment Terms for the
purchase order. The standard allows this group to be used up to 10 times in one
purchase order. You need to use this group only once in the header of the purchase
order so you changed the maximum use of this group to one. At the same time,
you promoted this group to the parent frame so that the payment terms are
displayed on the same frame as the purchase order number and date (the header
frame).

The PAT segment is a conditional segment in the PAT group that specifies the
Payment Terms Basis for the purchase order.You have already activated the PAT05
element for the Terms of Payment. The mandatory elements PAT01 (Payment
Terms Type Qualifier) and PAT02 (Terms of Payment Identification) also are
activated.

The PAT01 element is a mandatory element that contains the Payment Terms Type
Qualifier, a three-character code that identifies the terms under which this purchase
order is valid. You need to hide the PAT01 element and print the more meaningful
description of the code in a new element that you create.

You know that your trading partner only sends you purchase orders with these
terms:
v Previously Agreed Upon (Payment Terms Type Qualifier 18)
v Instant (Payment Terms Type Qualifier 10)
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To print the description of an EDI code value, you must copy the PAT01 element to
a new element in the PAT segment, then use the new PAT element to print the
description of the Payment Terms Type Qualifier.

Copying the PAT01 Element
About this task

Use this procedure to copy and paste the PAT01 element.

Procedure
1. Select the PAT01 element.
2. Click Copy on the Main Toolbar.
3. Select the PAT06 element, which is the last element in the C110 composite in

the PAT segment.
4. Click Paste on the Main Toolbar to paste the new element. A new element

(PAT07) is created, which is an exact copy of the PAT01 element.

Changing the PAT07 Element and Field Properties
The system names the new element created from copying the PAT07 element
4279:2. You need to rename the new element to identify its purpose, which is to
print the description of the code from the PAT01 element. Also, you need to
increase the element and field lengths to accommodate the longer description.

About this task

Use this procedure to change the element name and length and to change the field
label and length for the Payment Terms Type Qualifier field.

Procedure
1. Double-click the PAT07 element.
2. In the Name box, enter 4279_DESC to give the name a more descriptive

identifier than its current name.
3. Select the Validation tab.
4. Clear the Mandatory check box to make the element conditional.
5. Enter 0 in the Minimum box and 30 in the Maximum box.
6. Select the Print tab.
7. In the Label box, delete the existing text.
8. In the Maximum number of characters to be printed box, enter 30.
9. Click OK to exit the dialog.

Hiding the PAT01 Field and Loading the Code List Table from
the Standards

Now that you have created an exact copy of the PAT01 element, you can hide the
first Payment Terms Type Qualifier field.

About this task

You know that your trading partner only sends purchase orders with these two
term types:
v Previously agreed upon (Payment Terms Type Qualifier 18)
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v Instant (Payment Terms Type Qualifier 10)

You do not need to load the entire code list table so load only codes 18 and 10
from the code list table.

Use this procedure to hide the first Terms Type Code field and load the codes from
the standards.

Procedure
1. Double-click the PAT01 element, which is the element for which you need to

use a code list table.
2. On the Print tab, clear the Include this field in the print check box.
3. On Standard Rule tab, select Use Code option. Click Yes at the prompt.
4. Click Edit to access the Edit Code List dialog.

Note: The Table ID box contains 4279, the name of the element for which this
code list table is used. The Desc box contains PAYMENT TERMS TYPE
QUALIFIER, the description of the element for which this code list table is
used.

5. Click Load to access the Load Code List dialog.
You are prompted to select an ODBC data source name.

6. Select the appropriate DSN and click OK to access the Load Code List dialog.
The Codes In Standard list contains the entire code list.

7. From the Codes In Standard list, highlight code 10 and click Add to move it
to the Codes Selected list. Then, highlight code 18 and click Add.

8. Click OK to load the code list table and exit the Load Code List dialog.
9. Click Close to exit the Edit Code List dialog.

10. From the Store Field list, select 4279_DESC PAYMENT TERMS TYPE
QUALIFIER to store the code in the PAT07 element you created.

11. Click OK to exit the dialog.

Customizing the PAT02 Element
The PAT02 element (Terms of Payment Identification) is a mandatory element for
the PAT segment. You do not need to print the identification on the printout so
you will hide the Terms of Payment Identification field.

About this task

Use this procedure to hide the Terms of Payment Identification field.

Procedure
1. Double-click the PAT02 element.
2. On the Print tab, clear the Include fields in the print check box.
3. Click OK to exit the dialog.

Customizing the PAT05 Element
The PAT05 element contains the exact terms of payment for the purchase order.
The terms are explained by the description of the Payment Terms Type Qualifier so
there is no need to print the label associated with the terms of payment. You need
remove the field label for the PAT05 element on the printout.
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About this task

Use this procedure to remove the Terms of Payment field label.

Procedure
1. Double-click the PAT05 element.
2. On the Print tab, delete the text in the Label box.
3. Click OK to exit the dialog.
4. Click Generate Layout on the Main Toolbar to refresh the print form display.

Results

The header frame now should look like this:

The LIN Group
The standard allows the LIN group to be used up to 200,000 times, containing up
to 200,000 line items in one purchase order. You have already activated these
segments in the LIN group: LIN, PIA, IMD:2, MEA:3, QTY:3, DTM:13, and MOA:5.
Also, you have already promoted the DTM:13 segment in the LIN group to create
the DTM:27 segment.

Before Customization

Before you customize the segments and elements in the LIN group, the fields in
the form are arranged with one field on a line, like the following:
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If the frame were not customized and formatted differently, each set of fields
would be repeated for each item ordered. A more efficient and traditional way of
listing items on a purchase order is to arrange the related information in columns
so all the related information for one item is listed on one or two lines. The
column headings are printed only once.

After Customization

The following figure shows how you ultimately want the fields in the LIN group
to be arranged (after customizing and formatting the fields).

Customizing the LIN01 Element
The LIN segment (in the LIN group) contains the Line Item details for the items on
the purchase order. Information in the LIN segment pertains to each line item on
the purchase order and not to the entire purchase order.

About this task

The LIN01 element contains the Line Item Number for one item on the purchase
order. You need to rename the field label to reflect the new label that you and your
trading partner have agreed to use. You and your trading partner have agreed that
the line items per purchase order will not exceed 99,999. Since each line item is
numbered sequentially, starting with one, you need a maximum length of only five
digits for this field. Therefore, you need to change the maximum length for this
field.

Use this procedure to change the element and field lengths and rename the field
label for the Line Item Number field.
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Procedure
1. Double-click the LIN01 element.
2. On the Validation tab, enter 5 in the Maximum box.
3. Select the Print tab.
4. In the Label box, enter Line to replace the existing text.

Note: The label for the Line Item Number field ultimately will form the
column heading Line No. To make the width of the column heading as narrow
as possible, you will place Line on one line and No. below. The Label field does
not enable you to enter a label on more than one line, so you will enter Line in
the Label box, then add No. by adding static text later in this tutorial. (Static
text is text that is always printed or displayed when the form is used, and that
is not defined in the field properties of the element.)

5. In the Maximum number of characters to be printed box, enter 5.
6. Click OK to exit the dialog.

Customizing the PIA Segment
The PIA segment in the LIN group contains the Additional Product ID details for
the items on the purchase order. Information in the PIA segment pertains to each
line item on the purchase order and not to the entire purchase order. The standard
allows the PIA segment to be used up to 25 times for each line item, but you need
the PIA segment to be used only once for each line item. You have already
changed the maximum use of the PIA segment to one.

About this task

The PIA01 element is a mandatory element that contains the Product ID Function
Qualifier for each item on the purchase order. For brevity on the printout, you will
rename the field label.

The PIA02 element contains the Item Number for one item on the purchase order.
You need to rename the field label to more accurately identify this field for you
and your trading partner. The standard allows up to a 35-character string in this
field. Your trading partner uses product identification numbers that are no longer
than 10 characters so you need to change the maximum length for this field to ten.

Use this procedure to customize the PIA segment.

Procedure
1. To customize the Product ID Function Qualifier field, double-click the PIA01

element.
2. On the Print tab, enter Code in the Label box to replace the existing text.

Note: The label for the Product ID Function Qualifier field ultimately will form
the column heading Code Type. To make the width of the column heading as
narrow as possible, you will place Code on one line and Type below. The Label
field does not enable you to enter a label on more than one line, so you will
enter Code in the Label box, then add Type by adding static text later in this
tutorial.

3. Click OK to exit the dialog.
4. To customize the Item Number field, double-click the PIA02 element.
5. On the Validation tab, enter 10 in the Maximum box to allow a 10-character

string for the product identification number in this element.
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6. Select the Print tab.
7. In the Label box, enter Prod ID to replace the existing text.
8. In the Maximum number of characters to be printed box, enter 10.
9. Click OK to exit the dialog.

Customizing the IMD:206 Element
The IMD:2 segment (in the LIN group) contains the Item Description for the items
on the purchase order. Information in the IMD:2 segment pertains to each line item
on the purchase order and not to the entire purchase order. The standard allows
the IMD:2 segment to be used up to 10 times for each line item, but you need the
IMD:2 segment to be used only once for each line item. You have already changed
the maximum use of the IMD:2 segment to one.

About this task

The IMD:206 element contains the Item Description for the purchase order item.
The description is self-explanatory so there is no need to print the field label
associated with the description.

Use this procedure to remove the Item Description field label.

Procedure
1. Double-click the IMD:206 element.
2. Select the Print tab.
3. In the Label box, delete the existing field label.
4. Click OK to exit the dialog.

Customizing the MEA:3 Segment
The MEA:3 segment (in the LIN group) contains the Measurements for the items
on the purchase order. Information in the MEA:3 segment pertains to each line
item on the purchase order and not to the entire purchase order. The standard
allows the MEA:3 segment to be used up to five times for each line item, but you
need the MEA:3 segment to be used only once for each line item. You have already
changed the maximum use of the MEA:3 segment to one.

About this task

The MEA:301 element is a mandatory element that contains the Measurement
Application Qualifier for each item on the purchase order. This element must be
present in the purchase order, but you do not need this qualifier to be printed.

The MEA:305 element is a mandatory element that contains the Measure Unit
Qualifier for each item on the purchase order. This element must be present in the
purchase order. You do not need this qualifier to be printed on the printout so you
need to prevent this field from being displayed on the printout.

The MEA:306 element contains the Measurement Value for each item on the
purchase order. For brevity, you will rename the field label. The standard allows
up to an 18-digit number in this field. You expect a number no longer than two
digits from your trading partner so you need to change the maximum length for
this field accordingly. Also, the screen format and EDI format of the data currently
use the number format R9, which indicates a number with an explicit decimal
point and up to nine decimal places. You do not expect any decimal places from

Chapter 7. Modifying Form Components for EDIFACT 109



your partner’s data, so you need to change the screen format and EDI format to
R0, which indicates a number with an explicit decimal point and no decimal
places.

Use this procedure to customize the MEA:3 segment.

Procedure
1. To customize the Measurement Application Qualifier field, double-click the

MEA:301 element.
2. On the Print tab, clear the Include field in the print check box.
3. Click OK to exit the dialog.
4. To customize the Measure Unit Qualifier field, double-click the MEA:305

element.
5. On the Print tab, clear the Include field in the print check box.
6. Click OK to exit the Display Properties dialog.
7. To customize the Measurement Value field, double-click the MEA:306 element.
8. Select the Validation tab.
9. In the Maximum box, enter 2 to allow a two-digit number in this element.

10. From the Format of the data in the form list, select R0 to allow a number with
an explicit decimal point and no decimal places to be displayed on the
printout.

11. Click Yes at the prompt.
12. From the Format of the data of the file list, select R0 to indicate that you

expect a number with an explicit decimal point and no decimal places.
13. Click Yes at the prompt.
14. Select the Print tab.
15. In the Label box, enter Unit to replace the existing text.
16. In the Maximum number of characters to be printed box, enter 2.
17. Click OK to exit the dialog.

Customizing the QTY:3 Segment
The QTY:3 segment in the LIN group contains the Quantity details for the items on
the purchase order. Information in the QTY:3 segment pertains to each line item on
the purchase order and not to the entire purchase order. The standard allows the
QTY:3 segment to be used up to 10 times for each line item but you need the
QTY:3 segment to be used only once for each line item. You have already changed
the maximum use of the QTY:3 segment to one.

About this task

The QTY:301 element is a mandatory element that contains the Quantity Qualifier
for each item on the purchase order. This element must be present in the purchase
order, but you do not need this qualifier to be printed so you need to prevent this
field from being displayed on the printout.

The QTY:302 element contains the Quantity for one item on the purchase order.
You need to abbreviate the field label on the printout. The standard allows up to a
15-digit number in this field. You know that your trading partner will order no
more than 99,999 (a five-digit number) of any one item so you need to change the
maximum length to six for this field (to accommodate a five-digit number and a
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place separator) and change the value in the Screen Format and EDI Format lists to
N0, which indicates a number with an implied decimal point and no decimal
places.

Use this procedure to customize the QTY:3 segment.

Procedure
1. To customize the Quantity Qualifier field, double-click the QTY:301 element.
2. On the Print tab, clear the Include fields in the the print check box.
3. Click OK to exit the dialog.
4. To customize the Quantity field, double-click the QTY:302 element.
5. Select the Validation tab.
6. In the Maximum box, enter 6 to allow a five-digit number with a place

separator in this element.
7. From the Format of the data in the form list, select N0 to allow a number with

an implicit decimal point and no decimal places to be displayed on the
printout.

8. From the Format of the data of the file list, select N0 to indicate that you
expect a number with an implicit decimal point and no decimal places.

9. Select the Print tab.
10. In the Label box, enter Qty.
11. In the Maximum number of characters to be printed box, enter 6.
12. Click OK to exit the dialog.

Customizing the DTM:27 Segment
The DTM:27 segment (in the LIN group) is used to print the required shipment
date. To ensure that Sterling Gentran:Server prints the correct date in the
Date/Time/Period field, you must use the key field function. The key field
function enables you to specify a second qualification in selecting a segment (the
segment name is the first qualification). Data must be provided in the order
designated through the use of key fields. For example, for this tutorial, you expect
the required shipment date (DTM:27) first, and then the last delivery date
(DTM:13).

About this task

Note: The dates printed in the DTM:27 and DTM:13 segments can be set up using
key fields because you expect the dates in a particular order. If the dates were sent
in a different order, only one date would be printed. If you were not sure of the
order in which your partner will send the dates, you could not use key fields. You
would need to use three DTM segments (using the promote function), and two of
those DTM segments would need to be identical.

When the Date/Time/Period Qualifier field contains the value 10 (required
shipment date), the date is printed in the Date/Time/Period field of the DTM:27
segment. If the Date/Time/Period Qualifier field contains the value 128 (last
delivery date), then the date is printed in the Date/Time/Period field of the
DTM:13 segment.

The DTM:2701 element (in the DTM:27 segment) contains the Date/Time/Period
Qualifier for the date in the DTM:2702 element. Your trading partner sends two
types of dates: the required shipment date and the last delivery date (in that
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order). You used the key field function for the DTM:27 segment to indicate to
Sterling Gentran:Server that only the required shipment date are printed in the
Date/Time/Period field (DTM:2702) so you can prevent the qualifier (DTM:2701)
from being printed. The last delivery date is printed in the Date/Time/Period field
for the DTM:13 segment.

The DTM:2702 element contains the Date/Time/Period corresponding to the date
qualifier in the DTM:2701 element. The DTM:2702 element is used to designate
when the shipment is required.

In this section of the tutorial, you need to rename the label for this field (the new
label is named Requested). You need to add the words Ship Date using static text.
Static text is text that is always printed when the form is used. It is not defined in
the field properties of the element so that Ship Date is displayed on the line below
Requested. The full field label is Requested Ship Date.

Use this procedure to customize the DTM:27 segment.

Procedure
1. Right-click the DTM:27 segment and select Properties.
2. Select the Key Field tab.
3. From the Field list, select 2005:3 DATE/TIME/PERIOD QUALIFIER.
4. Click Edit to access the Map Constants dialog.
5. Click New to display the Edit Constant dialog.
6. In the ID box, enter Shipment date/time, req to identify the unique literal

constant.
7. From the Type list, select String.
8. In the Value box, enter 10 to identify the actual value of the constant.
9. Click OK to exit the Edit Constant dialog.

10. Click Close to exit the Map Constants dialog.
11. From the Use constant list, select 10 to indicate to the system that this date is

the required shipment date.
12. Click OK to exit the dialog.
13. To customize the Date/Time/Period Qualifier field, double-click the

DTM:2701 element.
14. On the Print tab, clear the Include field in the print check box.
15. Click OK to exit the dialog.
16. To customize the Date/Time/Period field, double-click the DTM:2702 element.
17. On the Validation tab, enter 8 in the Maximum box to allow the entire date

(including the / separator) in this element.
18. Select the Print tab.
19. In the Label box, enter Requested to replace the existing text.

Note: You will enter Ship Date on a separate line later in this tutorial.
20. In the Maximum number of characters to be printed box, enter 8.
21. Click OK to exit the dialog.

Customizing the DTM:13 Segment
The DTM:13 segment (in the LIN group) is used to print the last delivery date (the
latest date the order may be delivered). To ensure that Sterling Gentran:Server
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prints the correct date in the Date/Time/Period field, you must use the key field
function. The key field function enables you to specify a second qualification in
selecting a segment. The segment name is the first qualification. Data must be
provided in the order designated through the use of key fields. For example, for
this tutorial, you expect the required shipment date (DTM:27) first, and then the
last delivery date (DTM:13).

About this task

For this tutorial, if the Date/Time/Period Qualifier field contains the value 10
(required shipment date), then the date is printed in the Date/Time/Period field of
the DTM:27 segment. If the Date/Time/Period Qualifier field contains the value
128 (last delivery date), then the date is printed in the Date/Time/Period field of
the DTM:13 segment.

The DTM:1301 element (in the DTM:13 segment) contains the Date/Time/Period
Qualifier for the date in the DTM:1302 element. Your trading partner sends you
two types of dates: the required shipment date and the last delivery date (in that
order). You used the key field function for the DTM:13 segment to indicate to
Sterling Gentran:Server that the last delivery date is printed in the
Date/Time/Period field (DTM:1302). The DTM:1301 element must be present, but
you can prevent this field from being displayed, since the meaningful information
for a printout is the date itself.

The DTM:1302 element contains the Date/Time/Period corresponding to the date
qualifier in the DTM:1301 element.The DTM:1302 element is used to designate the
last delivery date that shipments can be shipped.

You need to rename the label for this field (the new label will be named Ship No).
You need to add Later further in this tutorial using static text so that Later is
displayed on the line below Ship No. The full field label will be Ship No Later.

Use this procedure to customize the DTM:13 segment.

Procedure
1. Right-click the DTM:13 segment and select Properties.
2. Select the Key Field tab.
3. From the Field list, select 2005 DATE/TIME/PERIOD QUALIFIER.
4. Verify that the Use constant option is selected.
5. Click Edit to display the Map Constants dialog.
6. Click New to display the Edit Constant dialog.
7. In the ID box, enter Delivery date/time, last.
8. From the Type list, select String.
9. In the Value box, enter 128 to identify the actual value of the constant.

10. Click OK to exit the Edit Constant dialog.
11. Click Close to exit the Map Constants dialog.
12. From the Use constant list, select 128 to indicate to the system that this date is

the last delivery date.
13. Click OK to exit the Key Field dialog.
14. To hide the second Date/Time/Period Qualifier field, double-click the

DTM:1301 element.
15. On the Print tab, clear the Include fields in the print check box.
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16. Click OK to exit the dialog.
17. To customize the second Date/Time/Period field, double-click the DTM:1302

element.
18. On the Validation tab, enter 8 in the Maximum box to allow the entire date

(including the / separator) in this element.
19. Select the Print tab.
20. In the Label box, enter Ship No to replace the existing text.

Note: You will enter Ship No on a separate line later in this tutorial.
21. In the Maximum number of characters to be printed box, enter 8.
22. Click OK to exit the dialog.

Customizing the MOA:5 Segment
The MOA:5 segment contains the Monetary Amount for the items on the purchase
order. Information in the MOA:5 segment pertains to each line item on the
purchase order, and not to the entire purchase order. The standard allows the
MOA:5 segment to be used up to five times for each line item but you need the
MOA:5 segment to be used only once for each line item. You have already changed
the maximum use of the MOA:5 segment to one.

Before you begin

The MOA:501 element is a mandatory element that contains the Monetary Amount
Type Qualifier for the purchase order. This element must be present in the
purchase order when the MOA:5 segment is activated. You do not need this
qualifier to be printed on the printout. You must prevent this field from being
displayed on the printout.

The MOA:502 element contains the Monetary Amount for the purchase order. You
need to rename the field label on the printout. The standard allows up to 18 digits
in this field. You know that your trading partner orders items totaling no more
than $999,999 (a six-digit number), so you need to change the maximum length to
eight for this field (to accommodate a six-digit number, a place separator, and a
plus or minus sign) and change the value in the Screen Format and EDI Format
lists to R2, which indicates a number with an explicit decimal point and two
decimal places.

Use this procedure to hide the .

About this task

After customization

Procedure
1. To hide the Monetary Amount Type Qualifier field, double-click the MOA:501

element.
2. On the Print tab, clear the Include fields in the print check box.
3. Click OK to exit the dialog.
4. To customize the Monetary Amount field, double-click the MOA:502 element.
5. On the Validation tab, enter 8 in the Maximum box to allow the entire date

(including the / separator) in this element.
6. From the Format of the data in the form list, select R2.
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7. From the Format of the data in the file list, select R2 to indicate that you
expect a number with an explicit decimal point and up to two decimal places.

8. Select the Print tab.
9. In the Label box, enter Price.

10. In the Maximum number of characters to be printed box, enter 8.
11. Click OK to exit the dialog.
12. Click Generate Layout on the Main Toolbar to refresh the print form display.

Results

The Line Item (LIN) frame now should look like this:

Customizing the PO UNS Segment
The UNS segment is a mandatory segment that contains the Section Control
summary information for the purchase order. This segment identifies summary
information that is pertinent to the entire purchase order.

About this task

The UNS01 element is a mandatory element that contains the Section Identification
for the purchase order. This element must be present in the purchase order, but
you do not need this field to be printed on the printout.

Use this procedure to hide the Section Identification field.

Procedure
1. Double-click the UNS01 element.
2. On the Print tab, clear the Include fields in the print check box.
3. Click OK to exit the dialog.
4. Click Generate Layout on the Main Toolbar.
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Results

The header frame now should look like this:

Customizing the CNT Segment
The CNT segment (in the CNT group) contains the Control Total summary
information for the purchase order. This segment identifies summary information
that is pertinent to the entire purchase order. You expect to use this segment only
once, so you have already changed the maximum use of the CNT segment to one.

About this task

The CNT01 element is a mandatory element that contains the Control Qualifier for
the purchase order. This element must be present in the purchase order when the
CNT segment is used.You do not need this qualifier to be printed so you need to
prevent this field from being displayed on the printout.

The CNT02 element contains the Control Value (the total number of line items) for
the purchase order. You need to rename the field label on the printout to more
clearly identify the contents of the field. The standard allows up to an 18-digit
number in this field. You know that your trading partner will order no more than
99,999 (a five-digit number) items so you will change the maximum length to six
for this field. You also need to change the value in the Screen Format and EDI
Format lists to N0, which indicates a number with an implicit decimal point and
no decimal places.

Use this procedure to customize the CNT segment.

Procedure
1. To hide the Control Qualifier field, double-click the CNT01 element.
2. On the Print tab, clear the Include this field in the print check box.
3. Click OK to exit the dialog.
4. To customize the Control Value field, double-click the CNT02 element.
5. Select the Validation tab.
6. In the Maximum box, enter 6 for the maximum number of digits allowed.
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7. From the Format of the data in the form list, select N0.
8. From the Format of the data in the file list, select N0.
9. Select the Print tab.

10. In the Label box, enter Number of Line Items.
11. In the Maximum number of characters to be printed box, enter 6 to allow five

digits and a place separator on the printout.
12. Click OK to exit the dialog.
13. Click Generate Layout on the Main Toolbar.

The Control Total (CNT) frame now should look like this:

14. Click Save from the File menu to save the form.
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Chapter 8. Formatting the Print Form for EDIFACT

About Formatting the Print Form
In the previous section of this tutorial, you customized the print form for a
purchase order that you will use to print the data you receive from Pet Zone. After
successfully customizing the fields and elements of the print form, you are ready
to format the layout of the form.

One form can consist of several frames. Each group and repeating segment has a
corresponding frame that contains all the groups, segments, and elements at that
level. When the form is printed, the frames are printed consecutively, in the order
in which they occur in the form. Each frame is not printed on a separate page.

Resizing the Header Frame
When a printout is produced based on the customized print form, the information
is arranged according to how the frames and the fields contained in them were
arranged when the form was compiled. You should eliminate unnecessary space as
you arrange the fields on each frame.

About this task

Use this procedure to resize the header frame.

Procedure
1. Click one of the following segments segment to display the Beginning Segment

for Purchase Order (header) frame in the Layout Window.
v BEG (for ANSI X12)
v BGM (for EDIFACT)
v ORDHDR (for TRADACOMS)

2. To display more of the form on your screen, click and drag the center bar
between the EDI File Format Window and the Layout Window to the left until
the Layout Window is wide enough to display as much of the form as you
want.

3. To resize the header frame, click and drag the right side of the frame
approximately to the 20 cm. mark on the horizontal ruler (a form with a width
of 20 cm. can be printed on an 8 1/2" x 11" or A4 sheet of paper).

Adding a Title to the Form
You want the form to have a title designating the standard agency, version, type of
document/message, and the trading partner for which this form is used. You add
a title to the print form by adding static text.

About this task

Use this procedure to add and position the title for the form and center it.
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Procedure
1. Select all the fields and field labels on the frame. Drag your selection

approximately two or three centimeters lower on the frame to make room at
the top of the frame for the title.

2. Click Add Text on the Main Toolbar.
A text box is added to the current frame, displayed in the upper left corner of
the frame.

3. In the new selected text box, enter one of the following and click OK.
v ANSI X12 3040 Purchase Order

v EDIFACT 92.1 Purchase Order

v TRADACOMS ANA001 ORDERS Release 9

4. Click Add Text on the Main Toolbar. Enter Pet Zone and click OK.
5. Click and drag the first line of static text so that the text is centered on the first

line of the frame.
6. Click and drag the second line of static text (Pet Zone) so that the text is

centered on the second line of the frame.

Results

The header frame should look similar to the following. (This is an ANSI X12
example; some details may be different for EDIFACT and TRADACOMS.)

Header Fields
By default, each field and its associated label are printed on their own line.
However, it is common for purchase orders and forms to arrange some fields in
columns of information.

The first fields you will rearrange are the header fields. For ANSI X12, these fields
are associated with the BEG and REF segments. For EDIFACT, these fields are
associated with the BGM, DTM, and FTX segments, and the RFF and PAT groups.
For TRADACOMS, these fields are associated with the ORDHDR group and the
CLO, ORD, and DIN segments.

You prevented some of the field labels from being printed (by removing the field
label in the Label box of the Print dialog). For these fields, the fields are displayed
on your print form, but their associated labels are not.

Resizing the Header Fields
When you customized the element properties in the previous section of this
tutorial, you changed the display lengths for some of the fields on the header
frame. The fields that are displayed in the Layout Window currently reflect the
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default display lengths for the fields. To reflect the new sizes of the fields in the
Layout Window, you must select the fields for which you changed the display
lengths, then resize the fields.

About this task

Use this procedure to resize the fields on the header frame.

Procedure
1. Select all the fields on the header frame. (For TRADACOMS, these are the

Latest Delivery Date and Order Date fields.)
2. Select Display > Size to Length. The selected fields are resized to the lengths

specified in the Maximum number of characters box of the Print dialog for each
field.

Moving Header Fields and Labels - EDIFACT
About this task

Use this procedure to move and align the fields and field labels on the header
frame.

Procedure
1. Select each field individually and drag it closer to its respective field label.

Important: Do not move fields that are not labeled.
2. Drag the Order Date label and field to the right of the Order Number label

and field (at approximately 11.5 cm. on the horizontal ruler).
3. Drag the Order Type label and field below the Order Number label and field.
4. Drag the Contract No. label and field below the Order Date label and field.
5. Drag the Free Text field below the Order Type label and field.
6. Drag the Payment Terms Type Qualifier field below the Free Text field.
7. Drag the Terms of Payment field to the right of the Payment Terms Type

Qualifier field.
8. Select the following items and select Display > Align Controls > Left.

v Order Number field label
v Order Type field label
v Free Text field
v Payment Terms Type Qualifier field

9. Select the Order Type and Order Number fields (in that order) and select
Display > Align Controls > Left.

10. Select the Order Date and Contract No. field labels and select Display >
Align Controls > Left.

11. Select the Order Date and Contract No. fields (in that order) and select
Display > Align Controls > Left.

12. Select the Order Number and Order Date labels and fields and select Display
> Align Controls > Top.

13. Select the Order Type and Contract No. labels and fields and select Display >
Align Controls > Top.

14. Select the Payment Terms Type Qualifier and Terms of Payment fields and
select Display > Align Controls > Top.
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Results

The header frame now should look like this:
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Chapter 9. Creating Print Forms for TRADACOMS

Promoting the ORDHDR Group to the Parent Frame
The Promote function extracts one iteration (instance) of a group or repeating
segment. Promote is a specialized function that preserves the integrity of the EDI
structure.

About this task

By default, the fields corresponding to each group and repeating segment are
displayed on a separate frame from the rest of the fields in the message. When you
promote a group to the parent frame, the fields corresponding to the group are
displayed on the frame to which the group is subordinate. If you do not promote a
group to the parent frame, the fields corresponding to the group are displayed on
their own frame.

Use this procedure to promote the ORDHDR group to the parent frame.

Procedure
1. Right-click the ORDHDR group and select Properties.
2. Select the Print tab.
3. Click the Promote group to parent frame check box to display the fields in this

group on the same frame as the fields in the parent group.
4. Click OK to exit the Group Properties dialog.

The OTR Group
The OTR segment contains Order Trailer summary information for the purchase
order. If the form were generated now (displaying the layout of the fields in the
form on the right side of the Forms main window), the total number of line items
would be printed along with the ORDHDR fields at the beginning of the purchase
order (because the fields in the OTR segment would be displayed on the same
frame as the fields in the ORDHDR group).

To print the total number of line items at the end of the printout and maintain the
integrity of the purchase order, you must create an OTR group with a minimum
use and a maximum use of one, then cut the OTR segment and paste it as a
subordinate to the group you just created. By moving the OTR segment to the new
OTR group that you create, the total number of line items will be displayed on its
own frame, separate from the header (ORDHDR) information.

Creating an OTR Group
About this task

Use this procedure to create an OTR group.

Procedure
1. Select the OTR segment.
2. Select Edit > Insert > Group.
3. In the Name field, enter OTR_Group as the segment loop identification code.

© Copyright IBM Corp. 1996, 2012 123



4. In the Desc field, enter OTR Group to provide a brief explanation of the loop.
5. On the Looping tab, enter 1 In the Min Usage field to make this group

mandatory.
6. Click OK to create the group. Sterling Gentran:Server prompts you that the

frame caption for the group will default to the name of the group.
7. Click OK to accept the message.

Cutting and Pasting the OTR Segment
About this task

Use this procedure to cut and paste the OTR segment.

Procedure
1. Verify that the OTR segment is selected.
2. Click Cut on the Main Toolbar.
3. Select the OTR group, which is the group for which you want to paste the OTR

segment as a subordinate.
4. Click Paste on the Main Toolbar to paste the OTR segment.
5. Accept the default to paste the Clipboard contents as a child (subordinate) of

the group. Click OK to exit the dialog.
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Chapter 10. Modifying Form Components for TRADACOMS

Setting up the Document Name for the Print Form
About this task

We recommend that you set up a Document Name for each form. The document
name makes the identification of a document created by the form easier in Sterling
Gentran:Server. Setting up the document name enables you to differentiate
between documents in the document browsers. If you set up the document name
in the Forms Integration subsystem, the Name field of the document browsers that
contain this document in Sterling Gentran:Server contains the data from that
element. You can choose any element as the document name, but we strongly
recommend that you select an element that occurs only once in the document and
has a data type of string. For an ANSI X12 850 purchase order, the document name
usually is the Purchase Order Number. For an EDIFACT 92.1 purchase order, the
document name usually is the Document/Message Number. For a TRADACOMS
ANA001 ORDERS release 9 purchase order, the document name usually is the
Customer’s Order Number.

Use this procedure to set up the document name.

Procedure
1. Double-click one of the following elements:

v BEG03 (ANSI X12)
v BGM05 (EDIFACT)
v ORD ORNO ORN0 (TRADACOMS)
We recommend that you select this element because it is a non-recurring,
mandatory element.
The Element Properties dialog is displayed.

2. Select the Standard Rule tab.
3. Select the Update from the standard rule list.
4. Click Yes at the prompt.
5. From the Select the table (or group) to update list, select Document record.
6. From the Column (or field) to update list, select Document Name to indicate

that you are updating the Name field in the document browsers with the
contents of the element.

7. Click OK to set up the document name.

The ORDHDR Group
The ORDHDR group (Order File Header) is used to print the header details
pertaining to the ORDERS message. You already promoted this group to the parent
frame (the ORDERS file).

Customizing the TYP Segment
The TYP segment (Transaction Type Details) contains the transaction code for this
message.
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About this task

The TYP CD02 element (Transaction Code) is a mandatory element that contains
the code for the type of orders that follow (such as new orders or cancelled
orders). You do not need to print the code on the printout, so you will hide the
Transaction Code field.

Use this procedure to prevent the Transaction Code field from being printed.

Procedure
1. Double-click the TYP CD02 element.
2. On the Print tab, clear the Include in print check box to turn the option off.
3. Click OK to exit the dialog.

Customizing the SDT Segment
The SDT segment (Supplier Details) contains details about the supplier. In this
tutorial, the supplier is your company, MWT Manufacturing Co.

About this task

The SDT SIDN SID0 element (Supplier’s ANA Location Code) contains the code
assigned by the Article Numbering Association for the supplier’s location. Your
trading partner will send you this code, but you do not need the code to be
printed on the printout. Therefore, you will hide this field.

The SDT SNAM element (Supplier’s Name) contains the name of the supplier (in
this tutorial, you are the supplier). Your trading partner will send you this name,
but you do not need the name to be printed on the printout. (All purchase orders
you receive from customers should have your company designated as the
supplier.) Therefore, you will hide this field.

Use this procedure to customize the SDT segment.

Procedure
1. To hide the Supplier’s ANA Location Code field, double-click the SDT SIDN

SID0 element.
2. On the Print tab, clear the Include in print check box to turn the option off.
3. Click OK to exit the dialog.
4. To hide the Supplier’s Name field, double-click the SDT SNAM element.
5. On the Print tab, clear the Include in print check box to turn the option off.
6. Click OK to exit the dialog.

Customizing the CDT Segment
The CDT segment (Customer Details) contains details about the customer (your
trading partner, Pet Zone). In this tutorial, the CDT segment contains details
relating to the Pet Zone corporate office.

About this task

The CDT CIDN CID0 element (Customer’s ANA Identity/Loc) contains the code
assigned by the Article Numbering Association for the customer’s location. Your
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trading partner will send you this code, but you do not need the code to be on the
printout. Therefore, you will hide this field.

The CDT CNAM element contains the Customer’s Name. For brevity, you will
change the field label to Customer.

The elements CDT CADD CAD0, CDT CADD CAD1, CDT CADD CAD2, and
CDT CADD CAD3 contain four lines of the customer’s address. The CDT CADD
CAD4 element contains the post code of the customer’s address. The address will
correspond to the name in the CDT CNAM element, so you do not need to print a
label for the address fields.

Use this procedure to customize the CDT segment.

Procedure
1. To hide the Customer’s ANA Identity/Loc field, do the following:

v Double-click the CDT CIDN CID0 element.
v On the Print tab, clear the Include in print check box to turn the option off.
v Click OK to exit the dialog.

2. To change the field label for the Customer’s Name field, do the following:
v Double-click the CDT CNAM element.
v On the Print tab, enter Customer: in the Label field to replace the existing

text.
v Click OK to exit the dialog.

3. To remove the field label for the Customer’s Address Line 1 field, do the
following:
v Double-click the CDT CADD CAD0 element.
v On the Print tab, delete the existing text in the Label field.
v Click OK to exit the dialog.

4. To remove the field label for the Customer’s Address Line 2 field, do the
following:
v Double-click the CDT CADD CAD1 element.
v On the Print tab, delete the existing text in the Label field.
v Click OK to exit the dialog.

5. To remove the field label for the Customer’s Address Line 3 field, do the
following:
v Double-click the CDT CADD CAD2 element.
v On the Print tab, delete the existing text in the Label field.
v Click OK to exit the dialog.

6. To remove the field label for the Customer’s Address Line 4 field, do the
following:
v Double-click the CDT CADD CAD3 element.
v On the Print tab, delete the existing text in the Label field.
v Click OK to exit the dialog.

7. To remove the field label for the Customer’s Post Code field, do the following:
v Double-click the CDT CADD CAD4 element.
v On the Print tab, delete the existing text in the Label field.
v Click OK to exit the dialog.
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Customizing the FIL Segment
The FIL segment (File Details) contains details about the ORDHDR message. These
elements must be present in the ORDHDR message, but you do not need to print
them on a printout.

About this task

The FIL FLGN element (File Generation Number) contains the sequential number
assigned to this message by your trading partner. Your trading partner will send
you this number, but you do not need the number to be printed on the printout.
Therefore, you will hide this field.

The FIL FLVN element (File Version Number) contains the number corresponding
to this version of the message. The first version of the message is always version
one, and subsequent copies of the message are incremented by one. Your trading
partner will send you this number, but you do not need the number to be printed
on the printout. Therefore, you will hide this field.

The FIL FLDT element (File Creation Date) contains the date on which the message
was created. Your trading partner will send you this date, but you do not need the
date to be printed on the printout. Therefore, you will hide this field.

Use this procedure to customize the FIL segment.

Procedure
1. To hide the File Generation Number field, double-click the FIL FLGN element.
2. On the Print tab, clear the Include in print check box to turn the option off.
3. Click OK to exit the dialog.
4. To hide the File Version Number field, double-click the FIL FLVN element.
5. On the Print tab, clear the Include in print check box to turn the option off.
6. Click OK to exit the dialog.
7. To hide the File Creation Date field, double-click the FIL FLDT element.
8. On the Print tab, clear the Include in print check box to turn the option off.
9. Click OK to exit the dialog.

10. Click Generate Layout on the Main Toolbar to refresh the display of the print
form.
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Results

The print form now should look like this:

Customizing the CLO Segment
The CLO segment (Customer’s Location) contains details about the specific
customer location pertaining to this purchase order. In this tutorial, the CLO
segment contains details relating to the specific Pet Zone store to which the order
should be sent. Earlier in this tutorial, you customized the CDT segment, which
contains details relating to the Pet Zone corporate office.

About this task

The CLO CLOC CLO0 element (Customer’s ANA Location Code) contains the
code assigned by the Article Numbering Association for the customer’s location.
Your trading partner will send you this code, but you do not need the code to be
on the printout. Therefore, you will hide this field.

The CLO CNAM element contains the Customer’s Name (for the specific location
to which the order should be sent). For brevity, you will change the field label to
Location.

The elements CLO CADD CAD0, CLO CADD CAD1, CLO CADD CAD2, and
CLO CADD CAD3 contain four lines of the customer’s address. The CLO CADD
CAD4 element contains the post code of the customer’s address. The address will
correspond to the name in the CLO CNAM element, so you do not need to print a
label for the address fields.

Use this procedure to customize the CLO segment.

Procedure
1. To hide the Customer’s ANA Location Code field, do the following:

v Double-click the CLO CLOC CLO0 element.
v On the Print tab, clear the Include in print check box to turn the option off.
v Click OK to exit the dialog.

2. To change the field label for the Customer’s Name field, do the following:
v Double-click the CLO CNAM element.
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v On the Print tab, enter Location: in the Label field to replace the existing
text.

v Click OK to exit the dialog.
3. To remove the field label for the Customer’s Address Line 1 field, do the

following:
v Double-click the CLO CADD CAD0 element.
v On the Print tab, delete the text in the Label field.
v Click OK to exit the dialog.

4. To remove the field label for the Customer’s Address Line 2 field, do the
following:
v Double-click the CLO CADD CAD1 element.
v On the Print tab, delete the text in the Label field.
v Click OK to exit the dialog.

5. To remove the field label for the Customer’s Address Line 3 field, do the
following:
v Double-click the CLO CADD CAD2 element.
v On the Print tab, delete the text in the Label field.
v Click OK to exit the dialog.

6. To remove the field label for the Customer’s Address Line 4 field, do the
following:
v Double-click the CLO CADD CAD3 element.
v On the Print tab, delete the text in the Label field.
v Click OK to exit the dialog.

7. To remove the field label for the Customer’s Post Code field, do the following:
v Double-click the CLO CADD CAD4 element.
v On the Print tab, delete the text in the Label field.
v Click OK to exit the dialog.

8. Click Generate Layout on the Main Toolbar to refresh the display of the print
form.

Results

The section of the print form that contains the fields in the CLO segment now
should look like this (you may need to scroll down the form to see these fields):
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The ORD Segment

Customizing the ORD ORNO ORN0 Element
The ORD segment (Order References) contains reference information pertaining to
this purchase order, such as the purchase order number, the date the order was
placed, and the purchase order code.

About this task

The ORD ORNO ORN0 element (Customer’s Order Number) contains the
purchase order number assigned by the customer. You already used a standard
rule for this element to assign the document name. For brevity, you will change the
field label to Order Number.

Use this procedure to change the field label for the Customer’s Order Number
field.

Procedure
1. Double-click the ORD ORNO ORN0 element.
2. On the Print tab, enter Order Number: in the Label field to replace the existing

text.
3. Click OK to exit the dialog.

Customizing the ORD ORNO ORN2 Element
The ORD ORNO ORN2 element (Date Order Placed by Customer) contains the
date on which the customer placed the purchase order. You will change the screen
format for the purchase order date to DD/MM/YY. Also, this element is defined
by the standard to be a six-digit date. In this tutorial, the purchase order date will
be printed as an eight-digit date, so you will change the element and field lengths
to accommodate the longer date. For brevity, you will change the field label to
Order Date.

About this task

Use this procedure to change the screen format, change the element and field
lengths, and rename the field label for the Date Order Placed by Customer field.

Procedure
1. Double-click the ORD ORNO ORN2 element.
2. Select the Validation tab.
3. In the Max field, enter 8 to allow the entire date (including the / separators) to

be contained in this element.
4. From the Form Format drop-down list box, select DD/MM/YY to designate the

format for the date on the printout.
5. Select the Print tab.
6. In the Label field, enter Order Date: to replace the existing text.
7. In the Maximum number of characters field, enter 8 to allow the entire date,

including separators (/), to be displayed.
8. Click OK to exit the dialog.
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Copying the ORD ORNO CD07 Element
The ORD ORNO CD07 element (Order Code) contains the code representing the
type of purchase order (e.g. new order, cancelled order) for this message. You want
the more meaningful description of the code to be printed on the printout, instead
of the code itself. Therefore, you will hide the Order Code field, but use the code
from that element (ORD ORNO CD07) to look up the code description in Code
Values List 7 and print that description in another field that you create. The
description of the code will be displayed in the new field on the printout. You will
rename the new field and change the element and field lengths to accommodate
the text from the description of the code.

About this task

The description of the EDI code in the ORD ORNO CD07 element is important,
even though you do not need to print the code itself. For example, the EDI code
value "N" is not descriptive enough for users reading a printout of the purchase
order. The description of code "N" ("New Order") is meaningful, however.

Before you can print the description of the EDI code value, you must create a new
element in the ORNO segment to store and print the description. The new ORNO
element is the element that will print the description of the Order Code. You will
use the Copy and Paste functions to copy EDI information in the form. Copied
form components retain all the information of the original form components.

Use this procedure to copy and paste the ORD ORNO CD07 element.

Procedure
1. Select the ORD ORNO CD07 element.
2. Click Copy on the Main Toolbar.
3. Select the ORNO SCRF composite, which is the last form component in the

ORNO segment. The ORNO SCRF composite is the form component after
which you want the copy of the ORD ORNO CD07 element to be pasted.

4. Click Paste on the Main Toolbar to paste the ORD ORNO CD07 element.
5. Select Paste after selected item (at the same level) to paste the Clipboard

contents after the ORNO SCRF composite.
A new element (ORD CD07:2) is created. The ORD CD07:2 element is an exact
copy of the ORD ORNO CD07 element.

6. Click OK to exit the dialog.

Changing the ORD CD07:2 Element and Field Properties
The system names the new element created from copying the ORD ORNO CD07
element ORD CD07:2. You will rename the new element to identify its purpose,
which is to print the description of the code from the ORD ORNO CD07 element.

About this task

Note: If a segment or element occurs more than once in a form, it is identified by
its name <ID>. The second and subsequent occurrences are identified by <ID>:n,
where "n" is the number of the occurrence in the form.
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You will rename the element name and field label corresponding to the
newly-created ORD CD07:2 element to reflect the contents of the field (the
description of the Order Code). You will also increase the field and element lengths
to accommodate the longer description.

Use this procedure to change the rename the element name and field label, and
change the field and element lengths, for the ORD CD07:2 element.

Procedure
1. Double-click the ORD CD07:2 element.
2. In the Name field, enter CD07_DESC to give the name a more descriptive

identifier.
3. On the Validation tab, enter 35 in the Max field for the maximum number of

characters allowed for this element.
4. Select the Print tab.
5. In the Label field, enter Order Type: to replace the existing text.
6. In the Maximum number of characters field, enter 35 to allow a

thirty-five-character description to be displayed on the printout.
7. Click OK to save the new label and exit the dialog.

Hiding the ORD ORNO CD07 Field and Loading a Code List
Table from the Standards

Now that you have created an exact copy of the ORD ORNO CD07 element in
order to retain all of the EDI data and formatting associated with that element, you
can hide the Order Code field.

About this task

When you use code list tables, you load a code list table from the standard to tell
the system which code list table to use in looking up EDI code values. You can
load the specific code values you expect to receive in the EDI data, or you can load
the entire code list table. For this tutorial, you will load the entire code list table.

Use this procedure to hide the Order Code field and load the code list table from
the standards.

Procedure
1. Double-click the ORD ORNO CD07 element. You need to use a code list table

for this element.
2. On the Print tab, clear the Include in print check box to turn the option off

and click OK.
3. Select the Use Standard Rule tab.
4. Click Use Code from the drop-down list.
5. Click Edit to access the Edit Code List dialog.

The Table ID field contains "CD07," the name of the element for which this
code list table will be used. The Desc field contains "ORDER CODE," the
description of the element for which this code list table will be used.

6. Click Load to access the Load Code List dialog. You will be prompted to
select an ODBC data source name. Select the appropriate DSN and click OK
to access the Load Code List dialog. The Codes In Standard list box contains
the entire code list table.
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7. Click Add All to move all of the codes in the code list table to the Codes
Selected list box.

Note: Adding all the codes in the list (by using Add All) creates a much
larger form than if you use only selected codes. However, it is necessary for
your users to have all the codes available from which to choose.

8. Click OK to load the code list table and exit the Load Code List dialog.
9. Click Close to exit the Edit Code List dialog.

10. From the Store Field drop-down list box, select CD07_DESC ORDER CODE
to store the description in the ORD CD07_DESC element you created.

11. Click OK to exit the Element Properties dialog.
12. Click Generate Layout on the Main Toolbar to refresh the display of the print

form.

Results

The section of the print form that contains the fields in the ORD segment now
should look like this (you may need to scroll down the form to see these fields:

Customizing the DIN Segment
The DIN segment (Delivery Instructions) is a conditional segment that contains
details about the delivery of the ordered items. For this tutorial, the only delivery
instructions you and your trading partner require is the last date on which the
items may be delivered.

About this task

The DIN LDAT element (Latest Delivery Date) contains the last date on which the
ordered items may be delivered. You will change the screen format for the last
delivery date to DD/MM/YY. Also, this element is defined by the standard to be a
six-digit date. In this tutorial, the last delivery date will be printed as an eight-digit
date, so you will change the element and field lengths to accommodate the longer
date. In addition, you will add a colon (:) to the field label to make the label
consistent with the other field labels on the same frame.

Use this procedure to change the screen format, change the field and element
lengths, and add a colon (:) to the field label for the Latest Delivery Date field.
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Procedure
1. Double-click the DIN LDAT element.
2. On the Validation tab, enter 8 in the Max field to allow the entire date

(including the / separators) in this element.
3. From the Form Format drop-down list box, select DD/MM/YY to designate the

format for the date on the printout.
4. Select the Print tab.
5. In the Label field, enter : after the text in the field label (for consistency).
6. In the Maximum number of characters field, enter 8 to allow the entire date

(including the / separators) to be displayed.
7. Click OK to exit the dialog.
8. Click Generate Layout on the Main Toolbar to refresh the display of the print

form.

Results

The section of the print form that contains the field in the DIN segment now
should look like this:

The OLD Group
The OLD group contains details about each line item in the purchase order.

The fields in the OLD group are displayed on a separate frame than the fields you
have customized up to now, because the OLD group has a maximum use of
999,999. The fields on the OLD frame will be printed as many times as necessary
(up to 999,999 occurrences) before the fields on the next frame (OTR group) are
printed.

Within the OLD group, the OLD:2 segment (Order Line Details) contains line item
details for the purchase order.

Customizing the OLD:2 SEQA Element
The OLD:2 SEQA element (First Level Sequence Number) contains the line number
for each item on the purchase order. Your trading partner will send you the value
"1" for the first line item, and will increment each subsequent line item by one. You
and your trading partner have agreed that they will order no more than 99999 line
items per purchase order. Because each line item will be numbered sequentially,
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starting with one, you will need a maximum length of only five digits for this
field. Therefore, you will change the element and field lengths to five. Also, for
brevity, you will rename the field label.

About this task

Use this procedure to change the field and element lengths and rename the field
label for the First Level Sequence Number field.

Procedure
1. Double-click the OLD:2 SEQA element.
2. On the Validation tab, enter 5 in the Max field to allow a five-digit number in

this element.
3. Select the Print tab.
4. In the Label field, enter Line to replace the existing text.

Note: The label for the First Level Sequence Number field ultimately will form
the column heading "Line No." To make the width of the column heading as
narrow as possible, you will place "Line" on one line and "No." below. The
Label field does not enable you to enter a label on more than one line, so you
will enter "Line" in the Label field, then add "No." by adding static text later in
this tutorial.

5. In the Maximum number of characters field, enter 5 to allow five numeric
digits to be displayed on the printout.

6. Click OK to exit the dialog.

Customizing the OLD:2 SPRO SPR1 Element
The OLD:2 SPRO SPR1 element (Supplier’s Code for the Traded Unit) contains the
supplier’s internal reference identifying the ordered item. In this tutorial, MWT
Manufacturing Co. (the supplier) provides a catalogue to its trading partners
(customers). The catalogue lists all the items available for ordering, including the
supplier’s code for each item. Your trading partner will send you the supplier’s
number corresponding to each item ordered.

About this task

In this tutorial, the supplier’s codes do not exceed ten characters, so you will
change the field and element lengths to ten. In addition, for brevity, you will
rename the field label.

Use this procedure to change the field and element lengths and rename the field
label for the Supplier’s Code for the Traded Unit field.

Procedure
1. Double-click the OLD:2 SPRO SPR1 element.
2. On the Validation tab, enter 10 in the Max field to allow a ten-character string

in this element.
3. Select the Print tab.
4. In the Label field, enter Prod ID to replace the existing text.
5. In the Maximum number of characters field, enter 10 to allow ten characters to

be displayed on the printout.
6. Click OK to exit the dialog.
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Customizing the OLD:2 CPRO CPR1 Element
The OLD:2 CPRO CPR1 element (Customer’s Item Code) contains the customer’s
internal reference identifying the ordered item. In this tutorial, your trading
partner will send you the customer’s item code corresponding to each item
ordered. However, you do not need this code to be printed on the printout, so you
will hide this element.

About this task

Use this procedure to hide the Customer’s Item Code field.

Procedure
1. Double-click the OLD:2 CPRO CPR1 element.
2. On the Print tab, clear the Include in print check box to turn the option off.
3. Click OK to exit the dialog.

Customizing the OLD:2 UNOR UNO0 Element
The OLD:2 UNOR UNO0 element (Consumer Units in Traded Unit) contains the
consumer units information. The standard defines the OLD:2 UNOR UNO0
element as a string data type. However, your trading partner will send you a
number-type element in N0 format (formatted with an implicit decimal point and
no decimal places). Therefore, you will change the data type and the screen and
EDI formats to reflect the data your partner will send you.

About this task

Also, you and your partner have decided that none of the items you will trade
contain a number of units greater than ten digits. You will change the field and
element lengths to reflect the smaller number of units. In addition, for brevity, you
will rename the field label.

Use this procedure to change the field and element lengths, the data type, and the
screen and EDI formats, as well as to rename the field label, for the Consumer
Units in Traded Unit field.

Procedure
1. Double-click the OLD:2 UNOR UNO0 element.
2. On the Validation tab, enter 10 in the Max field to allow a ten-digit number in

this element.
3. From the Data Type drop-down list box, select Number to allow a number

data type in this element. Sterling Gentran:Server prompts you that changing
the field’s data type will invalidate its format.

4. Click Yes to proceed with modifying the properties of this element.
5. From the Form Format drop-down list box, select N0 to allow a number with

an implied decimal point and no decimal places to be displayed on the
printout.

6. From the File Format drop-down list box, select N0 to indicate that you expect
a number with an implied decimal point and no decimal places.

7. Select the Print tab.
8. In the Label field, enter Cons. Units to replace the existing text.
9. In the Maximum number of characters field, enter 10 to allow a ten-digit

number to be displayed on the printout.
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10. Click OK to exit the dialog.

Customizing the OLD:2 UNOR CD04 Element
The OLD:2 UNOR CD04 element (Measure Indicator) contains the abbreviation for
the ordering measure (such as kilograms, metres, liters) for the ordered item. For
brevity, you will rename the field label.

About this task

Use this procedure to rename the field label for the Measure Indicator field.

Procedure
1. Double-click the OLD:2 UNOR CD04 element.
2. On the Print tab, enter Unit in the label field to replace the existing text.
3. Click OK to exit the dialog.

Customizing the OLD:2 OQTY OQT0 Element
The OLD:2 OQTY OQT0 element (Number of Traded Units Ordered) contains the
total number of units ordered (quantity) for each line item, in units defined in the
OLD:2 UNOR CD04 element. The standard defines the OLD:2 OQTY OQT0
element as a string data type. However, your trading partner will send you a
number-type element in N0 format (formatted with an implicit decimal point and
no decimal places). Therefore, you will change the data type and the screen and
EDI formats to reflect the data your partner will send you.

About this task

Also, you know that your trading partner will order no more than 999999 (a
six-digit number) of any one item, so you will change the maximum length to six
for this field. You will change the field and element lengths to reflect the smaller
quantities. In addition, for brevity, you will rename the field label.

Use this procedure to change the field and element lengths, the data type, and the
screen and EDI formats, as well as to rename the field label, for the Number of
Traded Units Ordered field.

Procedure
1. Double-click the OLD:2 OQTY OQT0 element.
2. On the Validation tab, enter 6 in the Max field to allow a six-digit number in

this element.
3. From the Data Type drop-down list box, select Number to allow a number

data type in this element. Sterling Gentran:Server prompts you that changing
the field’s data type will invalidate its format.

4. Click Yes to proceed with modifying the properties of this element.
5. From the Form Format drop-down list box, select N0 to allow a number with

an implied decimal point and no decimal places to be displayed on the
printout.

6. From the File Format drop-down list box, select N0 to indicate that you expect
a number with an implied decimal point and no decimal places.

7. Select the Print tab.
8. In the Label field, enter Qty Ord to replace the existing text.
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9. In the Maximum number of characters field, enter 6 to allow a six-digit
number to be displayed on the printout.

10. Click OK to exit the dialog.

Customizing the OLD:2 OUCT OUC0 Element
The OLD:2 OUCT OUC0 element (Cost Price) contains the price per unit ordered.
This price is the net cost in pounds (e.g. after deducting line discounts, etc., but
before the application of VAT) for an item. Your trading partner will send you
prices in N4 format (formatted with an implicit decimal point and four decimal
places), but you want the price to be displayed on the printout in R4 format
(formatted with an explicit decimal point). Therefore, you will change the screen
format to reflect how you want the price to look on the printout.

About this task

Also, you know that the items you sell to Pet Zone are not priced at more than
£9999.99 each, so this field needs a maximum length of only ten (four places for
the pounds; four places for the pence, if present; one place for the decimal point;
and one place for a plus or minus sign, if present). You will change the field and
element lengths to reflect the prices you expect. In addition, you will rename the
field label Price Each.

Use this procedure to change the field and element lengths, change the screen
format, and rename the field label for the Cost Price field.

Procedure
1. Double-click the OLD:2 OUCT OUC0 element.
2. Select the Validation tab.
3. In the Max field, enter 10 to allow ten numeric digits in this field, including a

plus or minus sign and a decimal point.
4. From the Form Format drop-down list box, select R4 to allow a number with

an explicit decimal point and four decimal places to be displayed on the
printout.

5. Select the Print tab.
6. In the Label field, enter Price Each to replace the existing text.
7. In the Maximum number of characters field, enter 10 to allow eight digits on

the printout, including a plus or minus sign and a decimal point.
8. Click OK to exit the dialog.

Customizing the OLD:2 TDES TDE0 Element
The OLD:2 TDES TDE0 element (Traded Unit Descr. Line 1) contains the first line
of the description of the ordered item. The description will be self-explanatory in
the context of the rest of the line item information, so you will remove the label
from this field.

About this task

Use this procedure to remove the field label for the Traded Unit Descr. Line 1 field.

Procedure
1. Double-click the OLD:2 TDES TDEO element.
2. On the Print tab, delete the text in the Label field.
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3. Click OK to exit the dialog.

Customizing the OLD:2 TDES TDE1 Element
The OLD:2 TDES TDE1 element (Traded Unit Descr. Line 2) contains the second
line of the description of the ordered item. The description will be self-explanatory
in the context of the rest of the line item information, so you will remove the label
from this field.

About this task

Use this procedure to remove the field label for the Traded Unit Descr. Line 2 field.

Procedure
1. Double-click the OLD:2 TDES TDE1 element.
2. On the Print tab, delete the text in the Label field.
3. Click OK to exit the dialog.
4. Click Generate Layout on the Main Toolbar to refresh the display.

Results

The OLD frame now should look like this:

Customizing the OTR LORD Element
The OTR LORD element contains the Lines Ordered. You will rename the field
label.

About this task

Use this procedure to rename the field label for the Lines Ordered field.

Procedure
1. Double-click the OTR LORD element.
2. On the Print tab, enter Number of Line Items: in the Label field to replace the

existing text.
3. Click OK to exit the dialog.
4. Click Generate Layout on the Main Toolbar to refresh the display of the print

form.
5. The OTR frame now should look like this:
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Results

What to do next

Now you are ready to format the fields and their labels to make the fields on the
purchase order more consistent and visually attractive.
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Chapter 11. Formatting the Print Form for TRADACOMS

About Formatting the Print Form
In the previous section of this tutorial, you customized the print form for a
purchase order that you will use to print the data you receive from Pet Zone. After
successfully customizing the fields and elements of the print form, you are ready
to format the layout of the form.

One form can consist of several frames. Each group and repeating segment has a
corresponding frame that contains all the groups, segments, and elements at that
level. When the form is printed, the frames are printed consecutively, in the order
in which they occur in the form. Each frame is not printed on a separate page.

Resizing the Header Frame
When a printout is produced based on the customized print form, the information
is arranged according to how the frames and the fields contained in them were
arranged when the form was compiled. You should eliminate unnecessary space as
you arrange the fields on each frame.

About this task

Use this procedure to resize the header frame.

Procedure
1. Click one of the following segments segment to display the Beginning Segment

for Purchase Order (header) frame in the Layout Window.
v BEG (for ANSI X12)
v BGM (for EDIFACT)
v ORDHDR (for TRADACOMS)

2. To display more of the form on your screen, click and drag the center bar
between the EDI File Format Window and the Layout Window to the left until
the Layout Window is wide enough to display as much of the form as you
want.

3. To resize the header frame, click and drag the right side of the frame
approximately to the 20 cm. mark on the horizontal ruler (a form with a width
of 20 cm. can be printed on an 8 1/2" x 11" or A4 sheet of paper).

Adding a Title to the Form
You want the form to have a title designating the standard agency, version, type of
document/message, and the trading partner for which this form is used. You add
a title to the print form by adding static text.

About this task

Use this procedure to add and position the title for the form and center it.
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Procedure
1. Select all the fields and field labels on the frame. Drag your selection

approximately two or three centimeters lower on the frame to make room at
the top of the frame for the title.

2. Click Add Text on the Main Toolbar.
A text box is added to the current frame, displayed in the upper left corner of
the frame.

3. In the new selected text box, enter one of the following and click OK.
v ANSI X12 3040 Purchase Order

v EDIFACT 92.1 Purchase Order

v TRADACOMS ANA001 ORDERS Release 9

4. Click Add Text on the Main Toolbar. Enter Pet Zone and click OK.
5. Click and drag the first line of static text so that the text is centered on the first

line of the frame.
6. Click and drag the second line of static text (Pet Zone) so that the text is

centered on the second line of the frame.

Results

The header frame should look similar to the following. (This is an ANSI X12
example; some details may be different for EDIFACT and TRADACOMS.)

Header Fields
By default, each field and its associated label are printed on their own line.
However, it is common for purchase orders and forms to arrange some fields in
columns of information.

The first fields you will rearrange are the header fields. For ANSI X12, these fields
are associated with the BEG and REF segments. For EDIFACT, these fields are
associated with the BGM, DTM, and FTX segments, and the RFF and PAT groups.
For TRADACOMS, these fields are associated with the ORDHDR group and the
CLO, ORD, and DIN segments.

You prevented some of the field labels from being printed (by removing the field
label in the Label box of the Print dialog). For these fields, the fields are displayed
on your print form, but their associated labels are not.

Resizing the Header Fields
When you customized the element properties in the previous section of this
tutorial, you changed the display lengths for some of the fields on the header
frame. The fields that are displayed in the Layout Window currently reflect the

144 IBM Sterling Gentran:Server for Windows: Forms Integration Tutorial for Print Forms



default display lengths for the fields. To reflect the new sizes of the fields in the
Layout Window, you must select the fields for which you changed the display
lengths, then resize the fields.

About this task

Use this procedure to resize the fields on the header frame.

Procedure
1. Select all the fields on the header frame. (For TRADACOMS, these are the

Latest Delivery Date and Order Date fields.)
2. Select Display > Size to Length. The selected fields are resized to the lengths

specified in the Maximum number of characters box of the Print dialog for each
field.

Moving Header Fields and Labels - TRADACOMS
About this task

Use this procedure to move and align the fields and field labels on the header
frame.

Procedure
1. Select each field individually and drag it closer to its respective field label.

(Do not move fields that are not labelled.)
2. Select the Order Number label and field and drag them to the upper left

corner on the frame (below the heading).
3. Select the Order Date label and field and drag them to the right of the Order

Number label and field (at approximately 12.5 cm on the horizontal ruler).
4. Select the Order Type label and field and drag them below the Order Number

label and field.
5. Select the Latest Delivery Date field and drag it below the Order Date label

and field.
6. Select the Customer label and field and drag them below the Order Type label

and field.
7. Select the following fields and drag them below the Customer field:

v Customer’s Address Line 1
v Customer’s Address Line 2
v Customer’s Address Line 3
v Customer’s Address Line 4
v Customer’s Post Code

8. Select the Location label and field and drag them below the Customer’s Post
Code field.

9. Select the following fields and drag them below the Location field:
v Customer’s Address Line 1
v Customer’s Address Line 2
v Customer’s Address Line 3
v Customer’s Address Line 4
v Customer’s Post Code

10. Select the following field labels:
v Order Number
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v Order Type
v Customer
v Location
Then select Display > Align Controls > Left.

11. Select the Order Date and Latest Delivery Date field labels. Then select
Display > Align Controls > Left.

12. Select the Order Type and Order Number fields (in that order). Then select
Display > Align Controls > Left.

13. Select the Order Date and Latest Delivery Date fields (in that order). Then
select Display > Align Controls > Left.

14. Select all the Customer and Location fields (Customer’s Address Line 1,
Customer’s Address Line 2, Customer’s Address Line 3, Customer’s Address
Line 4, and Customer’s Post Code). Then select Display > Align Controls >
Left.

15. Click Lock Labels on the Main Toolbar. When you select a field, its
corresponding field label will be selected also.

16. Select the Order Number and Order Date fields. (Their field labels will be
selected, too, because you have the Lock Labels function turned on.) Then
select Display > Align Controls > Top.

17. Select the Order Type and Latest Delivery Date fields.Then select Display >
Align Controls > Top.

18. Select the Customer field. Then select Display > Align Controls > Top.
19. Select the Location label and field. Then select Display > Align Controls >

Top.
20. To resize the frame, click and drag the bottom of the frame to just below the

Customer’s Post Code field for the Location address.
21. Click Lock Labels on the Main Toolbar to turn off the Lock Labels function.

Results

The header frame now should look like this:
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.S.A.

For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law

IBM Japan Ltd.

19-21, Nihonbashi-Hakozakicho, Chuo-ku

Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
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incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation

J46A/G4

555 Bailey Avenue

San Jose, CA 95141-1003

U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.
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This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© IBM 2012. Portions of this code are derived from IBM Corp. Sample Programs. ©
Copyright IBM Corp. 2012.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks

IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “Copyright and
trademark information” at http://www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States,
and/or other countries.

IT Infrastructure Library is a registered trademark of the Central Computer and
Telecommunications Agency which is now part of the Office of Government
Commerce.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States
and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.
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Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

ITIL is a registered trademark, and a registered community trademark of the Office
of Government Commerce, and is registered in the U.S. Patent and Trademark
Office.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Java™ and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.

Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc. in the
United States, other countries, or both and is used under license therefrom.

Linear Tape-Open, LTO, the LTO Logo, Ultrium and the Ultrium Logo are
trademarks of HP, IBM Corp. and Quantum in the U.S. and other countries.

Connect Control Center®, Connect:Direct®, Connect:Enterprise®, Gentran®,
Gentran:Basic®, Gentran:Control®, Gentran:Director®, Gentran:Plus®,
Gentran:Realtime®, Gentran:Server®, Gentran:Viewpoint®, Sterling Commerce™,
Sterling Information Broker®, and Sterling Integrator® are trademarks or registered
trademarks of Sterling Commerce®, Inc., an IBM Company.

Other company, product, and service names may be trademarks or service marks
of others.
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